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Planning Your Installation

Installation Scenarios

Spectrum™ Technology Platform supports a variety of installation scenarios that scale to fit the
needs of your organization.

Standard

The standard scenario is the simplest installation scenario. You install Spectrum™ Technology
Platform on a single server. All activity is handled by this one server, including designing
dataflows, storage of configuration information, running jobs, and handling service requests.

Remote Servers

Remote servers are useful if you have licensed many modules. To use remote servers, you install
Spectrum™ Technology Platform on several different servers, installing different modules on each
server. You then configure the individual services to execute on one of the remote servers. This
approach has the following advantages:

• Improved performance, especially for web service and API calls. For jobs, there may be some
performance improvement, but the time it takes to send data across the network to the remote
server may offset any performance gains.

• Ability to perform database updates on individual modules without interrupting the availability
of other modules. For example, if you need to update a postal database for the Universal
Addressing Module, you could install the update by stopping just the remote server handling
the Universal Addressing Module, allowing other modules to remain available on other remote
servers.
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• Startup time can be reduced. With all modules on one server, it can take a long time for the
server to start up. With modules installed on separate servers, each server will start up more
quickly.

Cluster

In a clustered environment, processing is shared among two or more instances of the server. All
communication with Spectrum™ Technology Platform goes through a load balancer. Consider
clustering if you require failover redundancy and high-volume, high-performance processing.

This approach has the following advantages:
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• Processing is automatically distributed among the nodes in the cluster for optimal performance.
• Configuration settings are automatically synchronized across nodes.
• Uptime can be improved since if a node goes down the other nodes remain available to handle

processing requests.
• Adding a new node is easy.

Cluster with Separated Configuration Database

When you install the Spectrum™ Technology Platform server you are installing two things: server
software and a configuration database. The server handles the execution of jobs and service
requests, reporting, and logging. The configuration database stores data such as users and roles,
data connections, dataflows, and the audit log.

For clusters consisting of only a few nodes, installing the server and configuration database
together on each node provides acceptable performance. However, a cluster that consists of a
large number of nodes may have its performance negatively affected by having a copy of the
configuration database on each node. This is because an increasing number of nodes results in
increased data replication between nodes during synchronization. Performance may also suffer
if users are accessing the configuration database frequently through activities such as editing
dataflows or job schedules. These activities require processing power, resulting in less CPU
capacity available for running jobs and responding to service requests.

If you have an implementation with four or more nodes, you should consider installing the
configuration database to separate servers. This is the most scalable installation scenario
because you can add nodes without necessarily adding another instance of the configuration
database. For example, say you have five nodes and three configuration database servers. You
could add another five nodes, bringing the total number of nodes to 10, while still using just the
three configuration databases to support all 10 nodes.

Installing the configuration database to a separate server has the following advantages:

• More CPU is available to the server for running jobs, process flows, and service requests
because reading and writing to the configuration database is handled by a separate server.

• Reduced network traffic due to reduced configuration data replicated between nodes. For
example, you could have five Spectrum™ Technology Platform servers for handling execution
while having only three repositories. With just three repositories instead of five, data only needs
to replicate between three servers rather than five.

• Most scalable installation scenario.
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System Requirements

Server

Operating Systems

Operating System Notes

Windows Server 2008 R2 None

Windows Server 2012
Windows Server 2012 R2

None

Windows Server 2016 None

Note:  A 64-bit operating system is required. 32-bit operating systems are not supported.
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Disk Space

New Installation Upgrade

• The disk where you are installing Spectrum™

Technology Platform must have 5 GB of free space
to install all modules, less if installing fewer modules.

• The disk where the temp folder is located must
have at least 10 GB of free space for the installation
to extract the files it needs. You may need more
depending on the options you are installing. If
necessary, modify your TEMP environment variable
(Windows) or IATEMPDIR environment variable
(Unix and Linux) to point to a location with enough
space.

• The disk where you are installing Spectrum™

Technology Platform must have free disk space
equal to three times the size of your current
installation. To determine the size of your current
installation, look at the size of the folder where you
installed Spectrum™ Technology Platform.

• If you are adding modules as part of your upgrade,
you will need 3 GB to install all modules, less if
installing fewer modules.

• The disk where the temp folder is located must have
10 GB of free space plus four times the size of your
current installation. For example, if your current
installation is 5 GB, you would need 30 GB of temp
space: (4 x 5 GB) + 10 GB = 30 GB. If necessary,
modify your TEMP environment variable (Windows)
or IATEMPDIR environment variable (Unix and
Linux) to point to a location with enough space.

Note:  If you are installing a module that uses a reference database, such as a postal
database, geocoding database, or data normalization tables, you will need space for this
data. The total disk space varies, depending on which modules and databases you are
installing.

Memory

• Basic memory requirement: 16 GB
• The Enterprise Geocoding Module requires an additional 500 MB memory for the first non-U.S.

geocoder, and 250 MB for each additional non-U.S. geocoder, with these exceptions:

• Germany, Australia, and the U.K. each require 1 GB additional memory
• Japan requires 2 GB additional memory

• The Data Normalization Module and Universal Name Module require additional memory if you
use these name databases:

• Arabic Plus Pack: 5.5 GB
• Asian Plus Pack - Chinese: 32 MB
• Asian Plus Pack - Japanese: 1.6 GB
• Asian Plus Pack - Korean: 8 MB
• Core Names: 1.1 GB

• The Machine Learning Module requires an additional 1 GB memory.

Additional Requirements

• Windows administrator rights are required to install Spectrum™ Technology Platform
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• In order to use the enhanced system tray notification application the server must have .NET
Framework 3.5 SP1 (also known as 3.5.1) or higher. Windows Server 2008 comes with a
limited version of .NET Framework 3.5. You need install the full .NET Framework 3.5.1 on
Windows Server 2008. Later versions of Windows Server come with the required version
of .NET Framework.

Requirements for the Enterprise Big Data Module
For the stages using Hadoop, which are Read from Hive File, Read from Hadoop Sequence,
Write to Hadoop Sequence, and Write to Hive File, and for the activities Run Hadoop
MapReduce Job and Run Hadoop Pig:

• Hadoop version 2.6 and above

For the activities using Spark, which are Submit Spark Job and Spark Sorter:

• Spark 2.0.1 and above.

Network Ports

The Spectrum™ Technology Platform server uses several network ports for communication.
Network port conflicts can result in module components failing to start. One indication that a
component has failed to start is if it does not appear in Management Console. To troubleshoot the
problem, look in the Spectrum™ Technology Platform wrapper log. This log shows which port is
causing the problem. You can find the Spectrum™ Technology Platform wrapper log in:

server\app\repository\logs\wrapper.log

You can change the ports by modifying the properties in this file and restarting the server:

server\app\conf\spectrum-container.properties

Note:  In a clustered environment you must modify the spectrum-
container.properties file on each node in the cluster.

Port Description

5001 This port is used by the Spectrum™ Technology Platform configuration database.

To use a different port in a non-clustered environment, modify this property:

spectrum.repository.server.coordinator.port

To use a different port in a clustered environment:

• Specify the port you want instead of 5001 in
spectrum.repository.server.coordinator.port.

• Specify the seed nodes for the configuration database in
spectrum.repository.server.cluster.seeds.
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Port Description

5701 This port is used by Hazelcast for managing distributed processing between Spectrum™

Technology Platform servers in a cluster.

To use a different port in a non-clustered environment, modify this property:

spectrum.hazelcast.port

To use a different port in a clustered environment:

• Specify the port you want to use instead of 5701 in
spectrum.hazelcast.port.

• Include the Hazelcast port number after each IP address
specified in spectrum.cluster.seeds. For example, if
spectrum.hazelcast.port is set to 5702 and the IP address
of a seed node is 1.2.3.4.5, you would specify 1.2.3.4.5:5702 in
spectrum.cluster.seeds.

6362 This port is used if you enable backups of the Spectrum™ Technology Platform
configuration database. To use a different port, modify this property:

spectrum.backup.http.port

7474 This port is used by the Spectrum™ Technology Platform configuration database. To use
a different port, modify this property:

spectrum.repository.server.connector.http.port

7687 This port is used by the Spectrum™ Technology Platform configuration database. To use
a different port, modify this property:

spectrum.repository.server.connector.bolt.port

8080 The port used for communication between the server and Enterprise Designer and
Management Console. This port is also used by web services. To use a different port,
modify this property:

spectrum.http.port

9200 This port is used by the search index engine used by the Advanced Matching Module. To
use a different port, modify this property:

spectrum.index.http.port

9300 This port is used by the search index engine used by the Advanced Matching Module.

To use a different port in a non-clustered environment, modify this property:

spectrum.index.tcp.port

To use a different port in a clustered environment:

• Specify the port you want to use instead of 9300 in
spectrum.index.tcp.port and after the colon in
spectrum.index.client.addresses.

• Specify the seed nodes for the search index in
spectrum.index.server.cluster.seeds.
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Port Description

10119 This port is used for API calls made to services. To use a different port, modify this
property:

spectrum.socketgateway.port

15431-15432 These ports are used by the Machine Learning Module.

32750 This port is used for JDBC connections model stores which are created in Metadata
Insights. To use a different port, modify this property:

spectrum.metadata.jdbc.port

32751 This port is used for ODBC connections model stores which are created in Metadata
Insights. To use a different port, modify this property:

spectrum.metadata.odbc.port

Enterprise Designer

Enterprise Designer requires the following:

• Operating system requirements:

• Windows 7
• Windows 10

• 86 MB of disk space to install Enterprise Designer without any modules. Each module you
install requires additional disk space.

• Microsoft .NET Framework 4.6 (available from the Spectrum™ Technology Platform Welcome
Page, http://<SpectrumServerName>:8080)

• A monitor with at least 1024 x 768 resolution
• Maximum Windows DPI setting: 150%
• Adobe Reader 7 or later (for viewing and saving reports)

Web Browsers

• Internet Explorer 11
• Google Chrome 56 or later
• Firefox 51 or later
• To use the Data Hub Relationship Analysis Client, a browser with Microsoft Silverlight 5

installed. See www.microsoft.com/getsilverlight. Because Google Chrome no longer
supports Microsoft Silverlight, you will need to access these client tools using Internet Explorer
or Firefox.
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Command Line Tools

Administration Utility

• Operating system requirements:

• Windows 7
• Windows 10

• The Administration Utility requires Java 8 or later. If you are installing the Administration Utility
on the same computer where the Spectrum™ Technology Platform server is installed, Java 8
is already installed since it is included with the server. If you want to install the Administration
Utility on another computer, make sure that the computer has Java 8 or later installed.

Job Executor and Process Flow Executor

The Job Executor and Process Flow Executor command line tools require Java 8 or later.

User Interface Languages

Spectrum™ Technology Platform user interfaces such as Management Console, Enterprise
Designer, and web applications are localized for these languages:

• English
• French
• German
• Japanese
• Spanish

Client SDK

The Client SDK provides API access to Spectrum™ Technology Platform services. To use the
Client SDK your computer must meet the following requirements:

• 1.25 GB disk space
• JDK 1.5 is required to install the Client SDK. Be sure that JDK 1.5 is in the PATH environment

variable. Once installed, the Client SDK supports JDK 1.4 and greater.

Supported Compilers

The Spectrum™ Technology Platform Client SDK is supported with the following compiler and
runtime minimum versions.

Java

Client SDK Package Directory: clientSDK/platforms/java
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Client SDK requires the Java JDK, version 1.4 or higher. This is not installed with the Client SDK.

Windows 32-bit

• JDK: 1.4
• C Compiler: MSVC 6.0 SP3, MSVC 2003, MSVC 2005, MSVC 2008
• C++ Compiler: MSVC 6.0 SP3, MSVC 2003, MSVC 2005, MSVC 2008
• C# .NET: Microsoft .NET Framework 1.1
• Visual Basic: MS Visual Basic 6.0

Windows 64-bit

• JDK: 1.4
• C Compiler: MSVC 2005, MSVC 2008
• C++ Compiler: MSVC 2005, MSVC 2008

HP-UX RISC

• JDK: 1.4
• C Compiler: cc: HP92453-01 A.11.01.21 HP C (Bundled) Compiler
• C++ Compiler: aCC: HP aC++ B3910B A.03.30 HP aC++ B3910B A.03.27

The clientSDK 32-bit lib is linked to the following libraries:

• libpthread.1
• librt.2
• libnsl.1
• libxti.2

The clientSDK 64-bit lib is linked to the following libraries:

• libpthread.1
• libnsl.1
• librt.2
• libdl.1
• libc.2
• libxti.2
• libdl.1

HP-UX Itanium

• JDK: 1.4
• C Compiler: cc: HP aC++/ANSI C B3910B A.06.05
• C++ Compiler: aCC: HP aC++/ANSI C B3910B A.06.05

The clientSDK 32-bit lib is linked to the following libraries:

• libpthread.so.1
• libnsl.so.1
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• librt.so.1
• libxti.so.1
• libdl.so.1

The clientSDK 64-bit lib is linked to the following libraries:

• libpthread.so.1
• libnsl.so.1
• librt.so.1
• libxti.so.1
• libdl.so.1

Red Hat (32-bit)

• Operating System: Red Hat Linux 2.4.9-e.65smp
• C Compiler: gcc version 2.96 (gcc 4.1 required for the Address Now Module)
• C++ Compiler: g++ version 2.96

The clientSDK lib is linked to the following libraries:

• libstdc++-libc6.2-2.so.3
• libm.so.6
• libc.so.6
• ld-linux.so.2

Red Hat (64-bit)

• Operating System: Red Hat Linux version 2.6.9-34.0.2.ELsmp
• C Compiler: gcc version 3.4.5
• C++ Compiler: g++ version 3.4.5

The clientSDK lib is linked to the following libraries:

• libstdc++.so.6
• libm.so.6
• libgcc_s.so.1
• libpthread.so.0
• libc.so.6
• ld-linux-x86-64.so.2

SuSE

• Operating System: SuSE SLES 8 (powered by UnitedLinux 1.0) (i586)\nKernel 2.4.21-295-smp
(0).

• C Compiler: gcc version 3.2.2
• C++ Compiler: g++ version 3.2.2

The clientSDK lib (32-bit) is linked to the following libraries:
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• libstdc++.so.5
• libm.so.6
• libgcc_s.so.1
• libc.so.6
• ld-linux.so.2

Solaris

• Operating System: Solaris 5.8
• C Compiler: cc: Forte Developer 7 C 5.4 2002/03/09
• C++ Compiler: CC: Forte Developer 7 C++ 5.4 Patch 111715-16 2005/04/28

The clientSDK 32-bit lib is linked to the following libraries:

• libpthread.so.1
• libsocket.so.1
• libnsl.so.1
• librt.so.1
• libc.so.1
• libdl.so.1
• libmp.so.2
• libaio.so.1
• libc_psr.so.1

The clientSDK 64-bit lib is linked to the following libraries:

• libpthread.so.1
• libsocket.so.1
• libnsl.so.1
• librt.so.1
• libc.so.1
• libmp.so.2
• libmd5.so.1
• libscf.so.1
• libaio.so.1
• libdoor.so.1
• libuutil.so.1
• libm.so.2
• libc_psr.so.1
• libmd5_psr.so.1

AIX

• Operating System: AIX version 5.1.0.0
• C Compiler: xlc 6.0 Visual Age C 6.0

Spectrum™ Technology Platform 12.0 Installation Guide 17



Planning Your Installation

• C++ Compiler: xlC 6.0 Visual Age C++ 6.0

The clientSDK 32-bit and 64-bit lib are linked to the following libraries:

• libC.a
• libc_r.a
• libpthread.a
• librtl.a

Location Intelligence Module Support

Database

The Location Intelligence Module supports the following spatial databases for use with the spatial
services, data, and resources:

• Oracle 11gR2, Oracle 12C
• SQL Server 2008 R2, SQL Server 2012, SQL Server 2014
• SAP HANA 9.3
• PostgreSQL 8+ (PostGIS 2.x)
• GeoPackage (Windows and CentOS)

Data Format

The Location Intelligence Module supports the following data formats for use with the spatial
services:

• Generic JDBC (with XY)
• TAB (native, native extended, raster, grid, seamless, DBF)
• ESRI shapefile

Raster Format

The following raster and grid formats (64-bit only) are supported in the Location Intelligence
Module:

Raster formats:

Format File Extension
ADRG .gen

ASRP .gen

BMP .bmp, .wbmp

CADRG .gen

CIB various

ECW (SDK v5) .ecw

GeoTiff .geotif
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GIF .gif

JPEG .jpg/.jpeg

MrSID (SDK v9)

Note:  Supports MG4 (MrSID
Generation 4). On CentOS 7.1,
libpng12.so is required for reading
MrSID rasters.

.sid

NITF .ntf

PNG .png

TIFF

Note:  TIFF files used by the Feature
Service and Mapping Service cannot
exceed 2GB.

.tif

Note:  Solaris or AIX machines, whether installed with 32- or 64- bit JVM, do not support
ECW and MrSID raster formats.

Grid Formats

Format File Extension
Defense Digital Terrain Elevation Data (DTED) .dt0, .dt1, .dt2, .dt3

MapInfo Grid .mig

MRR (Multi-Resolution Raster)

Note:  This support is provided on
Windows 64-bit and the following Linux
environments:

• Oracle Linux 6.5 and 7.1
• CentOS 6.4 and 7.1
• Ubuntu 12.04, 14.04, and 16.04

.mrr

Vertical Mapper Classified Grid .grc

Vertical Mapper Continuous Grid .grd

In order to use rasters and grids as a map layer, there must be an associated .TAB file containing
georeference information about the image, including the bounds, coordinate system, and
registration points.

Utilities

The Location Intelligence Module utilities (Tile Generator, WMTS Tile Generator, and the
Geometry Validator) require at a minimum Java 8. If you are installing these utilities on the same
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computer where the Spectrum™ Technology Platform server is installed, Java 8 will be installed
since it is included with the server. If you want to install the utilities on another computer, make
sure that the computer has Java 8 or later installed.

Samples

The .NET samples require at a minimum Visual Studio 2013 and Microsoft .NET Framework 4.5.

MapInfo Professional Compatibility

The Location Intelligence Module is compatible with MapInfo Professional up to version 16.x. See
Tools > MapInfo Pro in the Spectrum Spatial Getting Started Guide for more information about the
interoperability of the two products.

WebDAV

When communicating to the server over HTTPS to map a drive to the repository, a WebDAV
client is required to use the TLS v1.2 protocol. For client machines running on Windows 7 SP1,
Windows Server 2008 R2 SP1, and Windows Server 2012, you must apply a security patch and
registry update to leverage this protocol. For instructions, see the "Managing Security" chapter in
the Administration section of the Spectrum Spatial Guide.
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Standard Installation

Installing a New Server

Prerequisites:

• Before installing Spectrum™ Technology Platform, be sure to read the release notes. The
release notes contains important compatibility information as well as release-specific installation
notes.

• Apply all the latest updates available for your operating system, especially those that resolve
issues with Java.

• You may encounter installation problems on Windows if the data execution prevention (DEP)
setting is not set correctly. The DEP setting must be set to Turn on DEP for essential
Windows programs and services only. For instructions on how to change your DEP setting,
see the Windows documentation.

To install a new server:

1. Download Spectrum™ Technology Platform using the download instructions contained in your
welcome letter.

2. Extract the downloaded file to a temporary location on the server where you want to install
Spectrum™ Technology Platform.

3. Double-click install.exe.
4. The installer guides you through the installation process. Note the following:

• If you are setting up an environment where the configuration database is installed on a
separate server choose Server only. Otherwise choose Standard installation.

• When prompted, select the modules that you want to install.

• Make sure that Spectrum™ Technology Platform is selected.
• If you are installing the SAP Module you must install these modules: Address Now

Module and Advanced Matching Module. The Enterprise Tax Module is optional. The
Universal Addressing Module is only required if you will be using the SAP module
service SAPValidateAddressWithCandidates.

• If you are installing the Siebel Module you must install these modules: Advanced
Matching Module, Data Normalization Module, and Universal Name Module You may
need to install one or more of these modules depending on the features you have licensed:
Address Now Module, Enterprise Geocoding Module, and Universal Addressing
Module.

• When prompted, enter the HTTP port that you want to use then press Enter. The default is
8080. For a complete listing of ports used by Spectrum™ Technology Platform see Network
Ports on page 11.

5. Unless you are installing a cluster and you cleared the check box to start the server after
installation, the Spectrum™ Technology Platform server starts when the installation is
complete. Wait for the server to start.
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You can see when the server has fully started by opening the log file <Spectrum
Installation Location>\server\app\repository\logs\wrapper.log and
looking for this message:

INFO  [Server] Pitney Bowes Spectrum(TM) Technology Platform
 (Version version build) Started

Important:  Do not attempt to stop the server until after it has fully started for the first time.
Stopping the server before it performs an initial startup can cause your installation to become
unusable.

6. Install your license key. For more information, see Installing a License Key on page 26.
7. Apply all the updates for the platform and any modules you have installed. For a listing of

updates, see the Update Summary on the Pitney Bowes support website.

Upgrading a Server

Prerequisites:

• Before upgrading, be sure to read the release notes for the new version. The release notes
contain important compatibility information, supported upgrade paths, and module-specific data
backup recommendations.

• Apply all the latest updates available for your operating system, especially those that resolve
issues with Java.

This procedure is for upgrading a single Spectrum™ Technology Platform server. Follow this
procedure when upgrading a standard installation or when upgrading a node in a cluster. If you
are upgrading a cluster, be sure to follow the cluster upgrade process. For more information, see
Upgrading a Cluster on page 49.

If you use remote servers, you must upgrade the remote servers and start them before upgrading
the main server. If you upgrade the main server and start it before upgrading and starting the
remote servers, you will need to recreate the remote server connections in Management console
after upgrading.

Note:  It will take about one hour to upgrade an average installation to Spectrum™

Technology Platform 12.0. If your installation has a large number of flows or a long
transaction history, your upgrade process could take four to six hours.

1. Download the updated version of Spectrum™ Technology Platform using the download
instructions contained in the release announcement email.

2. Unzip the downloaded installer to a temporary folder on the server you want to upgrade.
3. Back up the server. For instructions on creating a backup, see the Administration Guide.

Important:  We recommend that you create a backup before upgrading so that you can
recover your flows, security settings, and other settings, if an error occurs during the upgrade
process.
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4. If you use LDAP or Active Directory for Spectrum™ Technology Platform authentication, back
up this file:

server\app\conf\spring\security\spectrum-config-ldap.properties

5. Back up module-specific data for any of these modules if you have them installed.

Module Items to Back Up

Advanced Matching Module, Data Normalization
Module, and Universal Name Module

Back up the contents of these subfolders located
in SpectrumLocation/server/
modules:

• cdqdb
• lucene
• matcher
• parser
• searchindex
• tables

.

Data Hub Module Open the Relationship Analysis Client and click
Manage. Select the model you want to back up
then click Backup.

In addition to backing up your models, back up
these two property files:

• server\modules\hub
\hub.properties

• server\modules\db
\neo4j.properties

Location Intelligence Module Back up your named resources, data, and
configuration files.

6. In Enterprise Designer, go to View > Execution History. If the combined number of records
on the Jobs and Process Flows tabs is more than 10,000, we recommend that you purge and
archive the oldest records before upgrading. This will significantly reduce the amount of time
it will take to upgrade. For example, if you have 6,000 records in your job history and 11,000
records in your process flow history, you would have a total of 17,000 records and we would
recommend that you purge the oldest 7,000 records to get the total down to 10,000. If you
have fewer than 10,000 records in total on the Jobs and Process Flows tabs, you can skip
this step.

If you are upgrading from 9.0 SP3 or 10.0 SP1, delete old history records manually using
Management Console.

If you are upgrading from version 11.0, or 11.0 SP1, follow the procedure below to delete old
history records. This process is faster than manually deleting records in Management Console,
but is only available on versions 11.0 and 11.0 SP1.

a) Open a web browser and go to http://server:port/jmx-console
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Where:

server is the IP address or hostname of your Spectrum™ Technology Platform server.

port is the HTTP port used by Spectrum™ Technology Platform. The default is 8080.
b) Log in using the admin account.
c) Under Domain: com.pb.spectrum.platform.config, click

com.pb.spectrum.platform.config:manager=ArchiveTransactionManager.
d) (Optional) If you want to save an archive of the history that you are going to purge, specify

the path where you want to save the archive in the ArchiveDirectory field, then click set.
Then, set ArchiveEnabled to true and click set.

e) In the ArchiveRetain field, specify how many days of records you want to keep in the
history then click set. For example, if you enter 45 then history records that are 45 days
old or newer would be retained, and records 46 days old and older would be purged. To
determine how many days of records you can retain, look at the job and process flow
history in Enterprise Designer and identify the point in time where the number of records
exceeds 10,000.

f) In the PurgeOperation field, leave the value set to ALL.
g) To run the purge, click Invoke.

You have purged flow and execution history so that you now have a smaller configuration
database to upgrade. This will speed up the upgrade process.

7. Stop the Spectrum™ Technology Platform server. To stop the server, right-click the Spectrum™

Technology Platform icon in the Windows system tray and select Stop Spectrum™.
Alternatively, you can use the Windows Services control panel and stop the Pitney Bowes
Spectrum™ Technology Platform service.

8. Wait for the server to finish the shutdown process before proceeding.

Important:  If you have the Data Hub Module installed, make sure that all models shut down
properly. Models that do not shut down properly will not open successfully after upgrading.

9. If you have the Address Now Module installed, stop the Address Now server by going to the
Windows services control panel and stopping the Address Now Server service.

10.If you have the Global Sentry Module installed, stop the Global Sentry database server by
going to the Windows services control panel and stopping the Global Sentry Database Server
service.

11.Run the Spectrum™ Technology Platform installer to upgrade your system.
12.Apply all the updates for the platform and any modules you have installed. For a listing of

updates, see the Update Summary on the Pitney Bowes support website.
13.If you use LDAP or Active Directory for Spectrum™ Technology Platform authentication, open

this file in a text editor:

server\app\conf\spring\security\spectrum-container-ldap.properties

Set the properties in this file to match those in the copy of this file that you backed up before
upgrading.
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Note:  Any job or subflow stored in the system during a server upgrade is marked as
exposed to provide the same behavior for those jobs and subflows as before the upgrade.
Any job or subflow that is exported prior to the upgrade will not be exposed. Therefore,
when importing these jobs or subflows back into the system, you must manually expose
the imported job or subflow.

Some modules have post-upgrade steps you need to perform.

Data Hub Module Open this file in a text editor: server/modules/
hub/neo4j.properties and set the property
allow_store_upgrade property to true.
The purpose of this property is to protect against
unintentional and irreversible store upgrades. Setting
this property to "true" indicates that you understand the
ramifications of proceeding with an upgrade and have
taken the necessary precautions before proceeding.

Restart the Spectrum™ Technology Platform server.
The server will upgrade each model. Examine the
file server/app/repository/logs/
wrapper.log for errors or warning messages.
Once all models have been upgraded, go back to
the hub.properties file and comment out the
allow_store_upgrade property.

Installing a License Key

The license key provides access to software pursuant to the terms of your license. It is an
encrypted XML file with a file name ending in .key.

Note:  When you upgrade an existing Spectrum™ Technology Platform installation, you
may continue to use your existing license key. You do not need to get a new one.

To install a license key:

1. Locate the email containing your license key that you received from Pitney Bowes.

Important:  You must install the license key within 45 days of receiving it. If you do not you will
need to contact Pitney Bowes for another license key.

2. Copy the .key file to the following directory:

<SpectrumPlatformLocation>\server\app\import

The license key is applied to your system. There is no need to restart your server.

If there was a problem installing the license key, check the log file in:

<SpectrumPlatformLocation>\server\app\repository\logs
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Depending on whether the key was processed successfully or there was an error processing the
key, the processed key goes into one of these folders:

• <SpectrumPlatformLocation>\server\app\import\archive\license-keys
• <SpectrumPlatformLocation>\server\app\import\error\license-keys

Installing the Server with a Silent Installer

The silent install process for the server allows you to pre-configure the server installation process
so that it runs without user intervention. Instead of responding to prompts for information such as
the installation location and which modules to install, you specify these responses in a properties
file which the installer uses instead of user prompts.

1. In the Spectrum™ Technology Platform installer, go to the folder SilentInstaller.
2. Open the file installer.properties in a text editor.
3. Edit installer.properties as necessary to specify the installation settings you want to

use. See the comments in installer.properties for additional information.
4. To run the installer in silent mode, place installer.properties in the same directory

as install.exe. When the installer executes it will detect installer.properties and
automatically run in silent mode.

Alternatively, you can place installer.properties in different directory and give the
absolute path to the property in the command prompt using the -f argument, as follows:

install.exe -f PathOfPropertyFile\installer.properties

Adding Modules

Spectrum™ Technology Platform is designed so that modules can be added as you grow your
system over time. For example, you may have one Spectrum™ Technology Platform module and
then license another module a few months later. The second product may be built on a newer
version of Spectrum™ Technology Platform. This will require you to upgrade your version of
Spectrum™ Technology Platform. In another case, the second product is compatible with the
installed version. In both cases, the install program recognizes if it needs to upgrade Spectrum™

Technology Platform and will do so without prompting. If an upgrade is not required, the installer
will skip the Spectrum™ Technology Platform install steps and install the new module.

The process for adding a module is similar to that of a new installation. In both cases you start
the installation process by running the Spectrum™ Technology Platform installer. Note that
Spectrum™ Technology Platform modules do not have their own installer. Instead, you use the
Spectrum™ Technology Platform installer to add modules.

Spectrum™ Technology Platform 12.0 Installation Guide 27



Standard Installation

1. If the Spectrum™ Technology Platform server is running, stop it. To stop the server, right-click
the Spectrum™ Technology Platform icon in the Windows system tray (shown below) and
select Stop Spectrum™.

2. Launch the Spectrum™ Technology Platform installer by double-clicking Install.exe. The
installer guides you through the installation process. When prompted, select the modules that
you want to install. Your currently installed modules are selected.

3. Install any necessary databases for the new product. For more information on installing
databases, see Spectrum Databases on page 78.

4. After you install the necessary databases (if any), start Spectrum™ Technology Platform
by right-clicking the Spectrum™ Technology Platform icon in the Windows system tray and
selecting Start Spectrum™.

5. Install the license key for the module. For instructions, see Installing a License Key on page
26.

Removing the Server

Before uninstalling any product, back up any files you may need in the future. Uninstalling
Spectrum™ Technology Platform will remove all jobs and settings.

1. If the Spectrum™ Technology Platform server is running, stop it. To stop the server, right-click
the Spectrum™ Technology Platform icon in the Windows system tray (shown below) and
select Stop Spectrum™.

Spectrum™ Technology Platform 12.0 Installation Guide 28



Standard Installation

2. Go to Start > Programs > Pitney Bowes > Spectrum™ Technology Platform > Server and
select Uninstall Pitney Bowes Spectrum™ Technology Platform.

Note:  Some Java files will not be removed because the uninstall process itself uses
them.
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Clustered Architecture

In a clustered environment, processing is shared among two or more instances of the server. All
communication with Spectrum™ Technology Platform goes through a load balancer. Consider
clustering if you require failover redundancy and high-volume, high-performance processing.

There are two ways to run Spectrum™ Technology Platform in a cluster. You can install the
Spectrum™ Technology Platform server and configuration database on each node in the cluster,
or you can separate the server from the configuration database.

Cluster with Server and Configuration Database on Each Node

In this configuration, a complete Spectrum™ Technology Platform server is installed on each
node so that each node has both the server software and the configuration database. The
configuration database stores things like your user names and passwords, connections, flows,
history, and audit log.

This configuration has these advantages:

• Processing is automatically distributed among the nodes in the cluster for optimal performance.
• Configuration settings are automatically synchronized across nodes.
• Uptime can be improved since if a node goes down the other nodes remain available to handle

processing requests.
• Adding a new node is easy.

Cluster with Separated Configuration Database

When you install the Spectrum™ Technology Platform server you are installing two things: server
software and a configuration database. The server handles the execution of jobs and service
requests, reporting, and logging. The configuration database stores data such as users and roles,
data connections, dataflows, and the audit log.
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For clusters consisting of only a few nodes, installing the server and configuration database
together on each node provides acceptable performance. However, a cluster that consists of a
large number of nodes may have its performance negatively affected by having a copy of the
configuration database on each node. This is because an increasing number of nodes results in
increased data replication between nodes during synchronization. Performance may also suffer
if users are accessing the configuration database frequently through activities such as editing
dataflows or job schedules. These activities require processing power, resulting in less CPU
capacity available for running jobs and responding to service requests.

If you have an implementation with four or more nodes, you should consider installing the
configuration database to separate servers. This is the most scalable installation scenario
because you can add nodes without necessarily adding another instance of the configuration
database. For example, say you have five nodes and three configuration database servers. You
could add another five nodes, bringing the total number of nodes to 10, while still using just the
three configuration databases to support all 10 nodes.

Installing the configuration database to a separate server has the following advantages:

• More CPU is available to the server for running jobs, process flows, and service requests
because reading and writing to the configuration database is handled by a separate server.

• Reduced network traffic due to reduced configuration data replicated between nodes. For
example, you could have five Spectrum™ Technology Platform servers for handling execution
while having only three repositories. With just three repositories instead of five, data only needs
to replicate between three servers rather than five.

• Most scalable installation scenario.
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Cluster Components

A cluster is comprised of these components:

Load balancer As requests come into the cluster, the
load balancer identifies the best available
Spectrum™ Technology Platform node to
handle the request. The request is then passed
to a Spectrum™ Technology Platform node.

From the user's perspective, the distributed
architecture is handled automatically behind
the scenes. The user sends a request to the
load balancer's URL and port for Spectrum™

Technology Platform (typically port 80 for a
distributed environment) as if it were a single
Spectrum™ Technology Platform server.

Nodes A node is a Spectrum™ Technology Platform
server. A node can contain a copy of the server
and configuration database, or if you installed
the configuration database to a separate
cluster, each node contains either the server
or the configuration database. Nodes are
continuously synchronized. This enables each
node to share the same settings, such as
license information, dataflows, and database
resources.

To configure the cluster, simply point
Management Console or Enterprise Designer
to the load balancer's URL and port for
Spectrum™ Technology Platform (typically port
80 for a distributed environment).

External resources The definitions for external resources such
as database resources (postal databases
and geocoding databases for example),
JDBC connections, and file servers, reside
in the configuration database. The resources
themselves (databases, files, web services)
can reside anywhere you choose. Database
resources can be installed either on each node
in the cluster or on a shared network location.

Because the database resources themselves
reside outside the cluster, multiple clusters
can share the same database resources.
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You must create the resource definitions in
each cluster using Management Console.
For example if you want multiple clusters to
share the same geocoding database, you
can install the geocoding database on a
server accessible from each cluster, then in
Management Console point each cluster to the
geocoding database.

Installing a Cluster

For instructions on installing a cluster, see the Spectrum™ Technology Platform Installation
Guide.

Clustered Architecture for the Data Hub Module

In a clustered environment, Data Hub Module graph databases are replicated to each Spectrum™

Technology Platform server in the cluster. The server that receives the first request to open a
model is the master. All other servers maintain a replicated mirror of that master. If different
servers receive requests to open different models, the masters for the models are on different
servers. All writes to the database are synchronized with the master. Any server can process read
requests.

We recommend that clusters have a minimum of three servers in order to achieve a level of
fault tolerance. Also, an odd number of servers provide better resiliency per server than an
even-numbered cluster. We make these recommendations because once the model is running,
the system will continue running as long more than half the servers are in communication. For
example, in a cluster of six servers, four must stay in communication; for a cluster of three
servers, two must stay in communication, and for a cluster of two servers, all servers must be in
communication. Both a three-server cluster and a four-server cluster can tolerate a maximum of
one lost server.

All servers in the cluster must be available in order to open or create a model. If any server is
unavailable, the server will wait for all servers to join the cluster. If this number of servers do not
join within the timeout period, the operation fails.

Clustered Architecture for the Global Geocoding Module

In a clustered environment, processing is shared among two or more instances of the server. The
diagram below illustrates the deployment architecture of such a configuration. Load balancing
can be used to support high availability and scaling. The deployment architecture includes a
load balancer, Spectrum™ Technology Platform nodes with Global Geocoding Modules and
Geocoding databases.
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Note:  Each Geocoding database MUST be installed in the same location on all of
the nodes for the cluster to work properly. For example, if the Geocoding database for
“Spectrum Node 1” is installed on C:\data\, then the other Spectrum nodes' Geocoding
database must also reside on C:\data\.

Clustered Architecture for the Location Intelligence Module

In a clustered environment, processing is shared among two or more instances of the server. The
diagram below illustrates the deployment architecture of such a configuration. Load balancing
can be used to support high availability and scaling. The deployment architecture includes a
load balancer, a Spectrum Spatial cluster, a database, and a file share. With this approach it is
possible to scale both horizontally and vertically. You can cluster the Location Intelligence Module
with or without platform clustering.

Note:  Setting up both a Spectrum™ Technology Platform cluster and a Location
Intelligence Module cluster is recommended and has several benefits:

• Security (ACL) synchronization happens automatically for named resources .
• Dataflows, users, and roles created on one node will automatically synchronize to all

nodes.
• All Location Intelligence Module demo pages and utilities (such as Spatial Manager) can

and should point to the load balancer.
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Load Balancer

The load balancer spreads requests between the Spectrum Spatial instances. Any load balancer
that supports load balancing HTTP/HTTPs requests can be used.

Spectrum Spatial Cluster

The cluster is a collection of Spectrum instances with LIM sharing administration, named
resources, geographical metadata content and configuration settings. Additional nodes can
be added to the cluster for resilience or to deliver support for greater loads. Each node can be
scaled vertically through additional hardware resources and/or additional instances should this
be required for hardware with massive resources. Spectrum can be configured to use restricted
numbers of CPUs.

Database

Spectrum stores named resources (maps, layers, tables and styles), geographic metadata and
configuration in a repository. In the default single server installation an embedded database
is used to store these resources on the local server. To create a resilient scalable solution
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this embedded database should be replaced with a resilient independent database. Oracle,
PostGreSQL/PostGIS and Microsoft SQL Server are the supported repository databases.

In the load balanced configuration, Spectrum nodes cache these resources in a local cache and
search index in each node in the cluster. When a Spectrum node receives a request it uses the
local cache and index to find resources. Named resources can be added through any node in the
cluster. Each node keeps its cache current by checking for differences between its local cache
and the central database. This check occurs every 2 seconds by default. Time frequency can be
configured. This architecture ensures the server delivers high performance transactions and the
load on the repository database is kept to a minimum. If a new Spectrum node is added to the
cluster the cache and index are created automatically. Such a scenario can occur to remedy a
node failure or grow the capability of the deployment.

File Share

The file share provides a folder to hold map images generated by Spectrum. When maps are
rendered using the web services the server supports the map images being returned through
URLs or returned as a base 64 encoded image. When a URL is returned the map image is stored
as a file and served on request of the URL. To ensure any Spectrum node can return the map
image a file share is used to store the images.

Requirements

• All servers that host a node must have their system clocks synchronized in order for the cluster
to function. Verify that all systems point to the same time service to synchronize their clocks.

• All nodes in a cluster must be the same version of Spectrum™ Technology Platform so be sure
that the version you install is the same as the existing nodes.

• All nodes in a cluster must have the same modules installed.
• A cluster should have at least three nodes.

Installing a Cluster

Installing a cluster involves setting up one Spectrum™ Technology Platform server at a time.
Each time you add a server you need to point it to an existing server which will act as a seed
node. A seed node is a server that has a copy of the Spectrum configuration data that it can copy
to a new node so that the new node's configuration is synchronized with the other nodes in the
cluster. The following diagrams illustrate this process.

After installing the first node you will in effect have a cluster with only one node:
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When you install the second node it must point to the first node as a seed node. This will enable
the second node to receive a copy of the first node's configuration database, resulting in a cluster
with two nodes with synchronized configuration information.

As you add additional nodes, the new nodes can point to any of the existing nodes as a seed
node. You must also configure the first node to point to at least one other node in the cluster so
that if it is ever brought down it can rejoin the cluster.
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Before you begin, Install a load balancer. You can choose for yourself an appropriate load
balancer. Follow the procedures described in the load balancer's documentation when installing.

Note:  The load balancer must be configured to allow encoded forward slashes. If the
load balancer does not allow encoded forward slashes you may get HTTP 404 errors
while using the cluster. For example, if you are using an Apache load balancer, you
can configure it to allow encoded forward slashes by opening the httpd.conf file and
specifying this property: AllowEncodedSlashes On. For other types of load balancers,
refer to the load balancer's documentation.

Once you have your load balancer installed, follow these steps to install nodes in the cluster.

1. Install Spectrum™ Technology Platform on a server where you want to host a node. For
instructions, see Installing a New Server on page 22.

Important:  The installer will prompt you to start Spectrum™ Technology Platform after
the installation completes. You must disable this option so that the server does not start
automatically when the installation completes.

2. Configure the properties files.
a) Edit the properties in the file server/app/conf/spectrum-container.properties

as described in Cluster Properties on page 42.
b) Save and close the spectrum-container.properties file.
c) Some modules have module-specific settings that you must configure to enable the module

to work in a cluster.
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Module Cluster Configuration Settings

Advanced Matching Module These settings configure clustering for full-text search
indexes. If you do not use full-text search indexes you do
not need to configure these settings.

Open this file in a text editor:

SpectrumFolder\server
\modules\searchindex\es-
container.properties

Configure these properties:

es.index.default_number_of_replicas

Enter the number of
additional copies you want
created for each search
index. This number should
be the number of nodes in
your cluster minus 1. For
example, if your cluster has
five nodes, you would enter
"4" in this property.

es.index.default_number_of_shards

Enter the number of shards
you want your index to
have in the distributed
environment. The more
nodes that are in your
cluster, the higher this
number should be.

Save and close es-container.properties
when you are done editing these properties.

Note:  Search indexes created prior Spectrum™

Technology Platform 10.0 do not support
clustering. To enable clustering for indexes
created prior to the 10.0 release, you
must recreate the search index using
the 10.0 API after modifying the es-
container.properties file.
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Module Cluster Configuration Settings

Data Hub Module Open this file in a text editor:

SpectrumFolder\server\modules\hub
\hub.properties

Configure these properties:

hub.models.path.base

Specifies the folder
where models are
stored. By default, each
model is placed in a
subdirectory under the
SpectrumFolder\server
\modules\hub\db folder.
If you want to store models
in a different location,
uncomment this property
and specify the folder where
you want to store models.

hub.neo4j.database.type

Change the value of this
property to ha. The default
value embedded is for non-
clustered installations.

hub.servers.per.cluster

Uncomment this line. Set
the value of this property to
the number of Spectrum™

Technology Platform servers
in the cluster.

Save and close hub.properties when you are
done editing these properties.

The SpectrumFolder\server\modules
\hub\db\neo4j.properties controls how the
graph databases are configured, using Neo4j Enterprise.
This file is used as a template for each model. If needed,
each model can be configured separately by placing a
copy of this property file into the store directory for that
model.
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Module Cluster Configuration Settings

Machine Learning Module Open this file in a text editor:

SpectrumFolder\server\modules
\machinelearning/java.vmargs

Configure these properties:

-Xmx

Specifies the maximum
memory allocation. We
recommend sizing your
Machine Learning Module
cluster to be approximately
four times the size of your
data and for all nodes to
be allocated the same
amount of memory. To avoid
swapping, be sure the -Xmx
allocation does not exceed
the physical memory on any
node.

3. Start the server. To start the server, right-click the Spectrum™ Technology Platform icon in the
Windows task bar and select Start Server.

4. Repeat this procedure to install additional nodes in the cluster.

Note:  You should install at least three nodes in a cluster.

5. After installing all the nodes, go back to the first node and add the other nodes as seed nodes.
a) On the first node you installed, open the properties file server/app/conf/spectrum-

container.properties.
b) In the property spectrum.cluster.seeds, add the host name or IP address of the other

nodes in the cluster, separating each with a comma.
c) Save and close the spectrum-container.properties file. You do not need to restart

the server.

Cluster Properties

The spectrum-container.properties file contains the properties that configure a
cluster. This table describes how to set the cluster properties for a cluster where the server and
configuration database are installed together on each node, and for nodes in the server cluster
in a separated configuration database installation. If you are setting up a configuration database
cluster, see Cluster Properties for a Configuration Database Cluster on page 65.
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Property Description

spectrum.cluster.enabled Set this to true.

spectrum.cluster.name If this is the first node in the cluster, set this to the
name you want to give to the cluster.

If this is not the first node in the cluster, set this to
the name of the cluster that you want this node to
join. If you are unsure of the cluster name, check
the spectrum.cluster.name property on
another node in the cluster.

spectrum.cluster.address Specify the node's own IP address.

spectrum.cluster.seeds If you are setting up the first node in the cluster, or
if this is the first node you are starting after having
stopped the cluster, specify only the host name or IP
address of this server. This effectively points this node
to itself as a seed node, which is necessary in order for
it to be able to start as the first node in the cluster. Do
not specify 127.0.0.1.

If this is not the first node in the cluster, specify the
host name or IP address of each of the other nodes
in the cluster, including nodes that you have not yet
installed. Separate each seed node with a comma.
When starting up, the node will attempt to access
each seed node in the order listed. If none of the
seed nodes can be reached, the node will not join the
cluster.

Tip:  We recommend that you specify multiple seed
nodes so that if one seed node is down others can
be used to allow nodes to join the cluster. We also
recommend that you specify the same seed nodes in
the same order on all nodes in the cluster.

spectrum.cluster.nodeID Set this to an integer value to use as the ID for this
node. The ID must be an integer and must be unique
among all nodes in the cluster.

Tip:  We recommend that the first node you install
have a node ID of 1, the second one 2, and so on.

spectrum.runtime.hostname Un-comment this property and set this property to the
load balancer host name.

spectrum.runtime.port Un-comment this property and set this property to the
port on which you have configured the load balancer to
listen.
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Property Description

spectrum.repository.addresses Set this to the same IP address specified in
spectrum.cluster.address. The default
value localhost cannot be used in a clustered
environment.

If you are configuring a server node in a server-only
cluster, specify the IP addresses of the nodes in the
configuration database cluster. Separate each with a
comma.

spectrum.security.authentication.token.remoteClientCheck.enabledSet this value to false if nodes in the cluster are
behind different network devices, such as different
VM adapters. Setting this property to false will prevent
"invalid token" errors when using token authentication
for web service requests. For more information, see
Disabling Host Checks in Token Authentication on
page 58.

Installing a Cluster for the Location Intelligence Module

To set up a cluster for the Location Intelligence Module, you must first configure a common
repository (depending on the type of database you have) then configure your system to prepare it
for clustering.

Note:  Setting up both a Spectrum™ Technology Platform cluster and a Location
Intelligence Module cluster is recommended and has several benefits:

• Security (ACL) synchronization happens automatically for named resources .
• Dataflows, users, and roles created on one node will automatically synchronize to all

nodes.
• All Location Intelligence Module demo pages and utilities (such as Spatial Manager) can

and should point to the load balancer.

Related tasks
Installing a Cluster on the Platform on page 37

Setting Up a Common Repository Database

You must configure the Location Intelligence Module to use a common repository database for
the cluster. This ensures that named resources, geographic metadata and configuration settings
are managed across the cluster.

The repository is installed with a set of named resources, geographic metadata and configuration
files. To migrate these resources to the common database repository the resources need to
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be exported from the default internal repository database and reimported into the new shared
repository database.

For bulk export and import of repository content, use the limrepo import and limrepo
export commands in the Administration Utility. These commands give you the option of
preserving permissions (see the Administration section of the Spectrum Spatial Guide for
instructions.)

These steps describe how to set up your repository on a common database, either PostgreSQL,
Oracle, or Microsoft SQL Server:

1. Export all repository resources to a local folder using the limrepo export command in
the Administration Utility (see the Administration section of the Spectrum Spatial Guide for
instructions).

The contents of the installed repository must be exported. This step only needs to be
performed once, as the contents of the repository should be the same at this point for all
instances of Spectrum™ Technology Platform.

2. Stop the Spectrum™ Technology Platform server on all nodes (for instructions, see Stopping
a Cluster on page 57.)

3. On all nodes of Spectrum™ Technology Platform modify the configuration to specify the
common database.
a) Copy the contents of repository.<databaseType>.xml to repository.xml located

under the server/modules/spatial/jackrabbit folder where <databaseType> is
the appropriate type for your database (postgres, oracle, or mssql).

b) In repository.xml:

• Modify the DataSource section with the server host name, port, database, user, and
password.

• Modify the Cluster section to assign a distinct cluster ID, like Node1. Ensure unique IDs
are assigned to every subsequent node in the cluster (for example, Node2, Node3).

• Save the changes to repository.xml.
c) Remove these folders from the /server/modules/spatial/jackrabbit folder:

repository, version, workspaces.
4. If your database has previously contained any repository content, you must remove tables

from it so that a clean repository can be created. These tables need to be removed:

default_binval security_binval

default_bundle security_bundle

default_names security_names

default_refs security_refs

rep_fsentry version_binval
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rep_global_revision version_bundle

rep_journal version_names

rep_local_revisions version_refs

If using Oracle, then also delete version_seq_names_id, security_seq_names_id,
and default_seq_names_id.

5. On the seed node only, import the backed up repository content.
a) Start the Spectrum™ Technology Platform server (for instructions, see Starting a Cluster

on page 56).
b) Import the contents using the limrepo import command, pointing to the seed node.

6. Start the remaining nodes in the cluster (for instructions, see Starting a Cluster on page
56).

Configuring Your System

Once the Spectrum™ Technology Platform is installed and you have configure a common
repository, you need to configure your instance before you can replicate it to another virtual
machine. If you are not using a virtual machine environment, you will need to perform these steps
on each of your Spectrum™ Technology Platform installations.

Configure the Map File Share

To configure the map file share (a shared image folder) to Spectrum™ Technology Platform you
first need a shared map image directory. To create a map file share, see Creating a Map Image
File Share on Unix/Linux on page 47 or Creating a Map Image File Share on Windows on
page 47.

Once a map image directory has been created, configure the map file share:

1. Modify the Mapping Service configuration by pointing to a shared image folder and load
balance server. In the ImageCache change the Directory parameter to a common image
directory, and change the AccessBaseURL parameter to the load balancer machine image
URL.

If you are using a virtual machine environment, remember this IP address, as you must set the
load balancer VM to this IP address.

For Unix/Linus installations:

<ImageCache>
<Directory>/<spatial server root>/server/modules/spatial/images</
Directory> 
<AccessBaseURL>http://<loadbalance_IP_address>/rest/Spatial/
MappingService/internal/imageCache</AccessBaseURL>
 <FileExpire>30</FileExpire>
 <ScanInterval>30</ScanInterval>
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</ImageCache>

For Windows installations:

<ImageCache>
<Directory>\\server\Share\images</Directory> 
<AccessBaseURL>http://<loadbalance_IP_address>/rest/Spatial/
MappingService/internal/imageCache</AccessBaseURL>
 <FileExpire>30</FileExpire>
 <ScanInterval>30</ScanInterval>
</ImageCache>

2. For Unix/Linux installations, you must set up a symbolic link to enable map images to go to the
shared file system.

Create an images subfolder in the mounted share folder, e.g., /mnt/<linux mount>/
images

     
cd /<spatial server root>/server/modules/spatial
rm –Rf images
ln -s /mnt/<linux mount>/images ./images

Creating a Map Image File Share on Unix/Linux

The file share provides a folder to hold map images generated by Spectrum Spatial. Create a
shared folder accessible to all Spectrum nodes. The file share is not required if maps are returned
from the web services as Base64-encoded images.

To create a map image file share on Unix/Linux:

1. Mount a shared folder on each operating system hosting Spectrum. The commands below
mount a drive on a Microsoft Windows Server or network drive supporting CIFS.

mkdir /mnt/<linux mount>
mount -t cifs //<windows host>/<windows share> /mnt/<linux mount>-o
 username=shareuser,password=sharepassword,domain=pbi

2. Set the image share to load at startup in /etc/fstab.

//<windows ip address for share>/share /path_to/mount cifs
 username=server_user,password=secret,_netdev 0 0

Creating a Map Image File Share on Windows

The file share provides a folder to hold map images generated by Spectrum Spatial. Create a
shared folder accessible to all Spectrum nodes. The file share is not required if maps are returned
from the web services as Base64-encoded images.

To create a map image file share on Windows:

1. In Windows Explorer, select the image folder you want to share.
2. Right-click, and then click Share or Share with.
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3. Select the users who will be writing to the image folder. These users must have read/write
privileges.

Modifying OGC Service Configurations for Clustering

To ensure clustering works when you have both a Spectrum™ Technology Platform cluster and
a Location Intelligence Module cluster, changes are required to the OGC services configuration
files using Spatial Manager: From the WFS, WMS, and WMTS settings pages, change the online
resource (service) URL to the IP address and port of the load balancer. See the Spatial Manager
Guide in the Utilities section of the Spectrum Spatial Guide for more information.

Modifying the Java Properties Files in All Nodes

You must change the java property file in all nodes of the cluster. To modify the java properties for
Spectrum™ Technology Platform:

1. Modify the java.properties file, located in <spectrum>/server/modules/spatial/
java.properties, to point to the load balance server.

2. Change the images.webapp.url and all of the service host and port numbers to point to the
load balance server.

Configuring Ports for Multiple Spectrum Instances

If you have multiple Spectrum™ Technology Platform instances on a single machine, you must
change the port numbers.

To change the port numbers for each Spectrum™ Technology Platform instance:

1. Change all ports in <Spectrum root>/server/app/conf/spectrum-
container.properties to new port values that are not in use. The http port reflects the
port number entered in the installer.

2. Update the rmi port in bootstrap.properties in the /<spectrum root>/server/modules/spatial
folder (for example, 11099). The default is 1099.

Shared Spectrum Local Data

If you are using TAB file data on the file system, this data needs to be in a shared location
accessible by all instances of Spectrum in the load balanced environment. It is also important to
note that all named resources in the repository accessing data on the file system should point to
this shared location.

Each VM or machine hosting Spectrum needs to have access to the mounted shared drive.

Note:  Using named resources that point to database tables do not require a shared drive,
as the named resources in the repository do not access the data using a file path; rather
they use a named connection to the data in the database.
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Upgrading a Cluster

Prerequisites:

• Before upgrading, be sure to read the release notes for the new version. The release notes
contain important compatibility information, supported upgrade paths, and module-specific data
backup recommendations.

• Apply all the latest updates available for your operating system, especially those that resolve
issues with Java.

This procedure is for upgrading a cluster where the Spectrum™ Technology Platform server
and configuration database are installed on each node of the cluster. To upgrade a cluster, you
upgrade one node at a time. The first node you upgrade is handled slightly differently than the
other nodes because you must point the node to itself as a seed node since no other nodes will
be running in the cluster when it starts up.

Note that these scenarios have special procedures for upgrading a cluster:

• If you have one cluster for server nodes and another cluster for configuration database nodes,
see Upgrading a Cluster with a Separated Database on page 66.

• If you are upgrading a cluster for the Location Intelligence Module only, see Upgrading a
Cluster with the Location Intelligence Module on page 53. If you are upgrading both
Spectrum and Location Intelligence Module clusters, before shutting down all nodes also see
Upgrading a Cluster with the Location Intelligence Module on page 53 for some required
pre-upgrade steps.

• If you are upgrading a cluster running the Data Hub Module, see Upgrading a Cluster with the
Data Hub Module on page 50.

If these scenarios do not apply to you, follow this procedure to upgrade your cluster:

1. Back up the server. For instructions on creating a backup, see the Administration Guide.

Important:  We recommend that you create a backup before upgrading so that you can
recover your flows, security settings, and other settings, if an error occurs during the upgrade
process.

2. Stop all the nodes in the cluster. For more information, see Stopping a Cluster on page
57.

3. On the last node that you stopped:
a) Open the file server/app/conf/spectrum-container.properties in a text editor.
b) In the spectrum.cluster.seeds property, remove all nodes except for the current node.

Note:  Make a note of the nodes you remove so you can add them back later.

c) Save and close spectrum-container.properties.
d) Upgrade the node. For more information, see Upgrading a Server on page 23.
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Important:  The installer will prompt you to start Spectrum™ Technology Platform after
the installation completes. You must disable this option so that the server does not start
automatically when the installation completes.

e) Open the file spectrum-container.properties in a text editor and configure the
cluster properties. For more information, see Cluster Properties on page 42. Be sure to
leave spectrum.cluster.seeds set to only the current node's IP address or host name.

f) Save and close spectrum-container.properties.
g) Start the server.

4. Upgrade each of the other nodes, one at a time, by following this procedure:

Important:  Follow this procedure only when upgrading nodes other than the first node. See
step 3 for the procedure to upgrade the first node.

Important:  Be sure you have backed up your server before proceeding.

a) Delete this folder:

SpectrumLocation\server\app\repository\store\databases
b) Upgrade the node. For more information, see Upgrading a Server on page 23.

Important:  The installer will prompt you to start Spectrum™ Technology Platform after
the installation completes. You must disable this option so that the server does not start
automatically when the installation completes.

c) Open the file spectrum-container.properties in a text editor and configure the
cluster properties. For more information, see Cluster Properties on page 42. Save and
close the file when you are done.

d) Delete this folder:

SpectrumLocation/repository/data/databases/graph.db

Note:  You must delete this folder before you start the new node. If you do not, the
node will fail to join the cluster.

e) Start the server.
5. After you have upgraded all the nodes, go back to the first node you upgraded, open

spectrum-container.properties, and add the seed nodes you removed from
spectrum.cluster.seeds.

Upgrading a Cluster with the Data Hub Module

Prerequisites:

• Before upgrading, be sure to read the release notes for the new version. The release notes
contain important compatibility information, supported upgrade paths, and module-specific data
backup recommendations.

• Apply all the latest updates available for your operating system, especially those that resolve
issues with Java.

Spectrum™ Technology Platform 12.0 Installation Guide 50



Cluster

In a cluster that runs the Data Hub Module, each node hosts the Spectrum™ Technology Platform
server as well as Data Hub Module models. When upgrading, you need to upgrade your models
in addition to upgrading the Spectrum™ Technology Platform server.

The upgrade process consists of these steps:

1. Back up your models and properties files.
2. On the master server, upgrade Spectrum™ Technology Platform then upgrade your models.
3. On each non-master server, upgrade Spectrum™ Technology Platform then copy the upgraded

models from the master server to the non-master server.

To upgrade a cluster that runs the Data Hub Module, follow this procedure:

1. Back up the server. For instructions on creating a backup, see the Administration Guide.

Important:  We recommend that you create a backup before upgrading so that you can
recover your flows, security settings, and other settings, if an error occurs during the upgrade
process.

2. Open the Relationship Analysis Client and click Manage. Select the model you want to back
up then click Backup.

In addition to backing up your models, back up these two property files:

• server\modules\hub\hub.properties
• server\modules\db\neo4j.properties

3. Identify which node is the serving as the master server for the Data Hub Module.
a) Open a web browser and go to:

http://LoadBalancer:8080/jmx-console/HttpAdaptor/list
b) Scroll down to the neo4j.org domain.

You will see a set of objects for each model. The Role attribute in the HighAvailability
object indicates whether a server is the master for a model.

c) If you have more than one model and each model has a different master, you need to
make one server the master of all the models. To do this, restart the cluster then open the
Relationship Analysis Client using the hostname or IP address of one of the nodes rather
than the load balancer. In the Relationship Analysis Client, open each model by running a
query on each model. This will make the server you are connected to the master for each
model.

4. Stop each non-master node in the cluster, then stop the master server last. Stop nodes one at
a time rather than all at once.

Important:  Make sure that Spectrum™ Technology Platform stops without errors. If a server
does not stop properly, Data Hub Module models on the server will not open successfully
after upgrading. To ensure that Spectrum™ Technology Platform stopped cleanly, examine
the SpectrumDirectory\server\app\repository\logs\wrapper.log file for errors
during shutdown.

5. Upgrade the master server.
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a) If you are upgrading from Spectrum™ Technology Platform 10.0 or later, each model
directory must contain a version.data file. Review all the model.ModelName
subdirectories located under SpectrumDirectory/server/modules/hub/db to
confirm that they contain a version.data file. If any model directory is missing this file,
copy the corresponding version.data file from one of the non-master nodes.

b) Run the Spectrum™ Technology Platform installer to upgrade the master server to the new
version of Spectrum™ Technology Platform.

c) After the upgrade process finishes, the Spectrum™ Technology Platform server starts
automatically. Wait for the server to finish starting completely, then stop the server.

d) Open the file SpectrumFolder\server\modules\hub\hub.properties in an editor
and confirm that the property hub.neo4j.database.type is set to embedded:

hub.neo4j.database.type=embedded

e) Open the file SpectrumFolder\server\modules\hub\db\neo4j.properties in an
editor and set the allow_store_upgrade property to true:

allow_store_upgrade=true

f) Start the Spectrum™ Technology Platform server.
g) Open each model in the Relationship Analysis Client and run a query. Any query is

sufficient.
h) Stop the Spectrum™ Technology Platform server.
i) Open the file SpectrumFolder\server\modules\hub\hub.properties in an editor

and set the property hub.neo4j.database.type to ha:

hub.neo4j.database.type=ha

j) Compare any properties files that you backed up to the installed files and make any
necessary changes. Do not overwrite new files with old files because new files may contain
properties that old files do not.

6. Upgrade the non-master servers.
a) Delete the models in the SpectrumDirectory\server\modules\hub\db directory.

Warning:  Do not delete the models from the master server.
b) On one of the non-master servers, run the Spectrum™ Technology Platform installer to

upgrade it to the new version of Spectrum™ Technology Platform.
c) After the upgrade process finishes, the Spectrum™ Technology Platform server starts

automatically. Wait for the server to finish starting completely, then stop the server.
d) Open the file SpectrumFolder\server\modules\hub\hub.properties in an editor

and set the property hub.neo4j.database.type to ha:

hub.neo4j.database.type=ha

e) Compare any properties files that you backed up to the installed files and make any
necessary changes. Do not overwrite new files with old files because new files may contain
properties that old files do not.
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f) Copy the SpectrumFolder\server\modules\hub\db\model.* directories from the
master server to the non-master server.

g) Repeat these steps for each non-master server in the cluster.
7. Start the cluster.

a) Start the master server, followed by non-master servers.
b) Ensure that each server in the cluster is functioning. Check SpectrumFolder\server

\app\repository\wrapper.log for any errors.
c) While directly connected to the master server (bypassing the load balancer), open each

model, one at a time, and inspect the wrapper.log file for errors.

Upgrading a Cluster with the Location Intelligence
Module

When a common repository database is used for clustering, these additional steps required
before and after the Spectrum™ Technology Platform upgrade process. Before the upgrade, you
must move to a local database setup; after the upgrade, you then change back to the cluster
setup by pointing repository.xml to the external database.

Note:  To preserve access control settings, use the Administration Utility instead of
WebDAV. See the Administration section of the Spectrum Spatial Guide for instructions on
using the Administration Utility. The limrepo commands in the Administration Utility were
available beginning in version 11.0; if you are upgrading from a version prior to 11.0, you
must use WebDAV.

1. Before upgrading Spectrum™ Technology Platform, back up the repository by following these
steps.
a) Select a node from the cluster. This will be the seed node (see Installing a Cluster on

page 37).
b) Back up the repository content using the Administration Utility's limrepo export

command with ACL, pointing to the seed node.
c) Back up the Spectrum\server\modules\spatial\jackrabbit folder to a location

outside the installation folder.
2. Switch the common repository database to a local database (temporarily, just for upgrade

purposes). Apply these steps to all nodes in the cluster.
a) Stop the Spectrum™ Technology Platform server.
b) Delete the jackrabbit folder (Spectrum\server\modules\spatial\jackrabbit) and

create an empty "jackrabbit" folder in the same location.
c) Copy repository.xml into the jackrabbit folder from Spectrum\server\app\tmp

\RepositoryService.war-xxxxxxxx-contents\ webapp\WEB-INF\classes
\org\apache\jackrabbit\core. If you cannot find this file, you can extract it from
RepositoryService.war under Spectrum\server\app\deploy.
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d) Start the Spectrum™ Technology Platform server.
e) Import the repository content (backed up in Step 1b) into the repository using WebDAV (the

limrepo import command will not work with an empty folder).
f) Stop the Spectrum™ Technology Platform server.

3. Follow normal procedures to upgrade Spectrum™ Technology Platform to the new version on
all nodes.

4. For the seed node only, after the Spectrum™ Technology Platform upgrade is complete, back
up the upgraded content by following these steps.
a) Start the Spectrum™ Technology Platform server
b) Download the Administration Utility from the upgraded Spectrum™ Technology Platform

server.
c) Back up the content from the repository using the limrepo export command with ACL.
d) Stop the Spectrum™ Technology Platform server.
e) Back up the upgraded Spectrum\server\modules\spatial\jackrabbit folder to a

location outside the installation folder.
5. Configure the platform cluster as described in Installing a Cluster on page 37.
6. On all nodes of Spectrum™ Technology Platform modify the configuration to specify the

common database.
a) Copy the contents of repository.<databaseType>.xml to repository.xml located

under the server/modules/spatial/jackrabbit folder where <databaseType> is
the appropriate type for your database (postgres, oracle, or mssql).

b) In repository.xml:

• Modify the DataSource section with the server host name, port, database, user, and
password.

• Modify the Cluster section to assign a distinct cluster ID, like Node1. Ensure unique IDs
are assigned to every subsequent node in the cluster (for example, Node2, Node3).

• Save the changes to repository.xml.
c) Remove these folders from the /server/modules/spatial/jackrabbit folder:

repository, version, workspaces.
7. If your database has previously contained any repository content, you must remove tables

from it so that a clean repository can be created. These tables need to be removed:

default_binval security_binval

default_bundle security_bundle

default_names security_names

default_refs security_refs

rep_fsentry version_binval
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rep_global_revision version_bundle

rep_journal version_names

rep_local_revisions version_refs

If using Oracle, then also delete version_seq_names_id, security_seq_names_id,
and default_seq_names_id.

8. On the seed node only, import the backed up repository content.
a) Start the Spectrum™ Technology Platform server (for instructions, see Starting a Cluster

on page 56).
b) Import the contents using the limrepo import command, pointing to the seed node.

9. Start the remaining nodes in the cluster (for instructions, see Starting a Cluster on page
56).

Removing a Node from a Cluster

To remove a node from a cluster, stop the Spectrum™ Technology Platform server.

1. Stop the node you want to remove:

• On Unix or Linux, change the working directory to the Spectrum™ Technology Platform
server's bin directory, source the setup file, then type the following command: ./
server.stop .

• On Windows, right-click the Spectrum™ Technology Platform icon in the system tray and
select Stop Spectrum™.

2. Open the file server/app/conf/spectrum-container.properties in a text editor and
set spectrum.cluster.enabled to false.

3. On each of the other nodes in the cluster, open the spectrum-container.properties file
and remove the node from the spectrum.cluster.seeds property.

For Location Intelligence Module users: If you want to keep the node standalone and able to
run outside the cluster, copy back the original repository.xml file and remove the following
folders from the /server/modules/spatial/jackrabbit directory for each instance of
Spectrum™ Technology Platform: repository, version, workspaces. Restart the server and import
the repository content.

Adding Modules to a Cluster

This procedure describes how to add one or more modules to an existing cluster.
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1. Stop all the Spectrum™ Technology Platform nodes in the cluster. For more information, see
Stopping a Cluster on page 57. If your cluster has a separated configuration database
cluster, you only need to stop the server cluster, not the configuration database cluster.

Warning:  To prevent data loss you must stop the cluster by following the procedure described
in Stopping a Cluster on page 57.

2. On any node in the cluster, install the module or modules you want to add. For more
information, see the Spectrum™ Technology Platform Installation Guide.

3. Open this file in a text editor:

server/app/conf/spectrum-container.properties

4. In the spectrum.cluster.seeds property, remove all host names and IP addresses except
for the one for this server. Save the host names and IP addresses so that you can re-add them
later.

5. Save the file.
6. Start the server.

Note:  Wait for the server to fully start before proceeding.

7. In the file spectrum-container.properties, add the host names and IP addresses that
you had removed.

8. Save the file. You do not need to restart the server.
9. Install the modules on each of the other nodes in the cluster. Start each node after installing

the modules on it, and wait for it to fully start before installing the modules on the next node.
You do not need to modify the spectrum.cluster.seeds property when installing modules
on subsequent nodes.

Starting a Cluster

If all the nodes in a cluster are stopped, you must follow this procedure to start the cluster safely
and avoid data loss.

1. On the last node that was stopped last, remove the seed nodes and start the server.

Warning:  The first node that you start must be the last node that was stopped, and that node
must be a seed node. Starting another node first may result in loss of data such as job history
and configuration settings. If you do not know which node was stopped last, look in each
node's wrapper log for the time stamp of the shutdown message. You can find the wrapper log
in: Spectrum Location\server\app\repository\logs\wrapper.log.

a) Open this file in a text editor:

server/app/conf/spectrum-container.properties
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b) In the spectrum.cluster.seeds property, remove all host names and IP addresses
except for the one for this server. Save the host names and IP addresses so that you can
re-add them later.

c) Save the file.
d) Start the server.
e) Wait for the Spectrum™ Technology Platform server to completely start.

You can tell when the Spectrum™ Technology Platform server has completely started by
looking in the wrapper log: Spectrum Location\server\app\repository\logs
\wrapper.log. This message is displayed when the server is completely started:

Pitney Bowes Spectrum(TM) Technology Platform (Version Version
 Number) Started.

f) In the properties file spectrum-container.properties, in the
spectrum.cluster.seeds property, add the host names or IP addresses that you had
removed, separating each with a comma.

g) Save and close the file. You do not need to restart the server.
2. Start the other nodes in the cluster.

Warning:  Be sure to wait for the first node to start completely before starting additional nodes.
Starting additional nodes before the first one is started may result in loss of data.

Stopping a Cluster

To stop an entire cluster:

1. Identify which nodes are seed nodes. To do this, open the file SpectrumFolder/server/
app/conf/spectrum-container.properties and look at the nodes listed in the
spectrum.cluser.seeds property.

2. Stop each Spectrum™ Technology Platform server in the cluster, making sure that the last
node you stop is a seed node.

• On Unix or Linux, change the working directory to the Spectrum™ Technology Platform
server's bin directory, source the setup file, then type the following command: ./
server.stop .

• On Windows, right-click the Spectrum™ Technology Platform icon in the Windows system
tray and select Stop Spectrum™.

Warning:  To prevent loss of data the last node you stop must be a seed node.
3. Make a note of which node was the last node you stopped. You will need this information when

starting up the cluster.

Warning:  To prevent loss of data when starting the cluster, the first node you start must be the
last node that was stopped, and that node must be a seed node.
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Using Enterprise Designer with a Cluster

1. Launch Enterprise Designer.
2. In the Server name field, enter the server name of the load balancer.
3. In the Port field, enter the port that you have configured the load balancer to listen on.

Note:  Input files, output files and database resources must be on a shared drive, or file
server, or some commonly-accessible location. Otherwise, all files must be loaded on
each server that hosts a Spectrum™ Technology Platform server and must be located in
the same path.

Once you have logged in you can use Enterprise Designer as normal. The actions you take will
apply to all Spectrum™ Technology Platform instances in the cluster where you are logged in.

Disabling Host Checks in Token Authentication

In token authentication, the Spectrum™ Technology Platform server examines the token
presented by the client before responding to the request. The server checks the token to see if it
has expired, if it is encrypted correctly, and if it is from the correct host. For session tokens, the
server also checks the session ID. If any of these checks fail, the token is rejected and the server
does not respond to the request.

In a clustered environment, it is possible that requests may be redirected in a way that makes
the request appear to be coming from a different host than is specified in the token, resulting in
"invalid token" errors. For example, say you have a cluster with two nodes as shown here:

Let's say that the client makes a request and is the request is routed to Node 1. A token is
created and tied to host 2.2.2.2 (the load balancer) since the node views the request as coming
from the load balancer. If the next request from the client is routed to Node 2, the token will still
be tied to host 2.2.2.2 but the request will appear to be coming from the proxy server, 3.3.3.3. In
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this case the node will reject the token because it appears that it is not associated with the host
making the request.

In this situation you must configure the Spectrum™ Technology Platform server to ignore the host
information included in the token. This should only be done if you have an environment where
there are different network devices between the load balancer and the nodes. If all nodes are
behind the same network device, there is no need to disable the host check.

Note:  If you follow this procedure, client tokens will in effect become open tokens since
the host check will be disabled. Session tokens will continue to be tied to a specific session
ID but not a specific host.

1. Open the following properties file on the Spectrum™ Technology Platform server:

SpectrumLocation/server/app/conf/spectrum-container.properties

2. Set the following property to false.

spectrum.security.authentication.token.remoteClientCheck.enabled=false

3. Save and close the properties file.
4. Repeat this process on all the nodes in the cluster.
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Installing a Cluster with a Separated Configuration
Database

This procedure creates two clusters: one for the server nodes and one for configuration database
nodes. The nodes in the server cluster point to the servers in the configuration database cluster
for their configuration data. The nodes in the configuration database cluster replicate their data
between each other.

The following diagram illustrates this installation scenario:

To install a separate database repository, you first install the configuration database on servers
in a cluster, then install the server on nodes in a separate cluster. At least one configuration
database must be running before you can install the server.

1. Place the Spectrum™ Technology Platform installer on the server where you want to install the
configuration database.

2. Double-click installdb.exe.
3. Follow the prompts to install the configuration database.

Important:  When prompted with the option to start Spectrum™ Technology Platform after
the installation, you must disable this option so that the database does not start automatically
when the installation completes.
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4. Edit the file Database/repository/spectrum-container.properties as described in
Cluster Properties for a Configuration Database Cluster on page 65.

5. Save and close spectrum-container.properties.
6. Start the configuration database. To start the configuration database, right-click the

Spectrum™ Technology Platform icon in the Windows system tray and select Start
Spectrum™. Alternatively, you can use the Windows Services control panel to start the
configuration database by starting the Spectrum Database service.

7. Install the configuration database on additional servers as needed to complete the
configuration database cluster.

8. Install the server cluster.

a) Install Spectrum™ Technology Platform on a server where you want to host a node. For
instructions, see Installing a New Server on page 22.

Important:  When installing each server select the Server only option in the
installer and provide the host and port of one or more of the configuration database
servers. You can find the port in the file InstallationLocation\Database
\repository\spectrum-container.properties. The port is specified in the
spectrum.repository.server.connector.bolt.port property.

b) If the Spectrum™ Technology Platform server is running, stop it. To stop the server, right-
click the Spectrum™ Technology Platform icon in the Windows system tray and select Stop
Spectrum™.

c) Edit the properties in the file server/app/conf/spectrum-container.properties
as described in Cluster Properties on page 42.

d) Save and close the spectrum-container.properties file.
e) Some modules have module-specific settings that you must configure to enable the module

to work in a cluster.
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Module Cluster Configuration Settings

Advanced Matching Module These settings configure clustering for full-text search
indexes. If you do not use full-text search indexes you do
not need to configure these settings.

Open this file in a text editor:

SpectrumFolder\server
\modules\searchindex\es-
container.properties

Configure these properties:

es.index.default_number_of_replicas

Enter the number of
additional copies you want
created for each search
index. This number should
be the number of nodes in
your cluster minus 1. For
example, if your cluster has
five nodes, you would enter
"4" in this property.

es.index.default_number_of_shards

Enter the number of shards
you want your index to
have in the distributed
environment. The more
nodes that are in your
cluster, the higher this
number should be.

Save and close es-container.properties
when you are done editing these properties.

Note:  Search indexes created prior Spectrum™

Technology Platform 10.0 do not support
clustering. To enable clustering for indexes
created prior to the 10.0 release, you
must recreate the search index using
the 10.0 API after modifying the es-
container.properties file.
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Module Cluster Configuration Settings

Data Hub Module Open this file in a text editor:

SpectrumFolder\server\modules\hub
\hub.properties

Configure these properties:

hub.models.path.base

Specifies the folder
where models are
stored. By default, each
model is placed in a
subdirectory under the
SpectrumFolder\server
\modules\hub\db folder.
If you want to store models
in a different location,
uncomment this property
and specify the folder where
you want to store models.

hub.neo4j.database.type

Change the value of this
property to ha. The default
value embedded is for non-
clustered installations.

hub.servers.per.cluster

Uncomment this line. Set
the value of this property to
the number of Spectrum™

Technology Platform servers
in the cluster.

Save and close hub.properties when you are
done editing these properties.

The SpectrumFolder\server\modules
\hub\db\neo4j.properties controls how the
graph databases are configured, using Neo4j Enterprise.
This file is used as a template for each model. If needed,
each model can be configured separately by placing a
copy of this property file into the store directory for that
model.
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Module Cluster Configuration Settings

Machine Learning Module Open this file in a text editor:

SpectrumFolder\server\modules
\machinelearning/java.vmargs

Configure these properties:

-Xmx

Specifies the maximum
memory allocation. We
recommend sizing your
Machine Learning Module
cluster to be approximately
four times the size of your
data and for all nodes to
be allocated the same
amount of memory. To avoid
swapping, be sure the -Xmx
allocation does not exceed
the physical memory on any
node.

f) Start the server. To start the server, right-click the Spectrum™ Technology Platform icon in
the Windows task bar and select Start Server.

g) Repeat this procedure to install additional nodes in the server cluster.
9. After installing all the nodes in the server cluster, go back to the first node you installed in the

server cluster and add the other nodes as seed nodes.
a) On the first node you installed, open the properties file server/app/conf/spectrum-

container.properties.
b) In the property spectrum.cluster.seeds, add the host name or IP address of the other

nodes in the cluster, separating each with a comma.
c) Save and close the spectrum-container.properties file. You do not need to restart

the server.

Cluster Properties for a Configuration Database Cluster

A configuration database cluster is a cluster where each node contains the configuration
database only, and not the server. If you are setting up a cluster where the server and
configuration database are installed together on each node, or are setting up a server-only
cluster, see Cluster Properties on page 42.

The settings for a configuration database cluster are located in this properties file:

Database\repository\spectrum-container.properties

This table describes each property:
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Property Description

spectrum.cluster.enabled Set this to true.

spectrum.cluster.name If this is the first node in the cluster, set this to any
name you want to give to the configuration database
cluster. Be sure that the name is unique if you have
multiple clusters.

If you are adding a node to an existing cluster, set this
to the name of the configuration database cluster that
you want this node to join.

spectrum.cluster.address Specify the node's own IP address.

spectrum.cluster.seeds If you are setting up the first node in the cluster, or
if this is the first node you are starting after having
stopped the cluster, specify only the host name or IP
address of this server. This effectively points this node
to itself as a seed node, which is necessary in order for
it to be able to start as the first node in the cluster.

If this is not the first node in the cluster, set this to the
host name or IP address of the Spectrum™ Technology
Platform server whose configuration will be replicated
on this node when it joins the cluster, resulting in
synchronized configuration. You can specify multiple
seed nodes by separating each with a comma. When
starting up, the node will attempt to access each seed
node in the order listed. If none of the seed nodes can
be reached, the node will not join the cluster.

Tip:  We recommend that you specify multiple seed
nodes so that if one seed node is down others can
be used to allow nodes to join the cluster. We also
recommend that you specify the same seed nodes in
the same order on all nodes in the cluster.

spectrum.cluster.nodeID Set this to an integer value to use as the ID for this
node. The ID must be an integer and must be unique
among all nodes in the database cluster. For example,
you could set the node ID for the first node to 1, the
second node's node ID to 2, and the third node's node
ID to 3.

Upgrading a Cluster with a Separated Database

Prerequisites:
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• Before upgrading, be sure to read the release notes for the new version. The release notes
contain important compatibility information, supported upgrade paths, and module-specific data
backup recommendations.

• Apply all the latest updates available for your operating system, especially those that resolve
issues with Java.

This procedure describes how to upgrade Spectrum™ Technology Platform when you have
separated the configuration database from the server. To upgrade an environment that has a
separated configuration database, you first upgrade the configuration database cluster, then the
server cluster.

1. Back up the server. For instructions on creating a backup, see the Administration Guide.

Important:  We recommend that you create a backup before upgrading so that you can
recover your flows, security settings, and other settings, if an error occurs during the upgrade
process.

2. Back up module-specific data for any of these modules if you have them installed.

Module Items to Back Up

Advanced Matching Module, Data Normalization
Module, and Universal Name Module

Back up the contents of these subfolders located
in SpectrumLocation/server/
modules:

• cdqdb
• lucene
• matcher
• parser
• searchindex
• tables

.

Data Hub Module Open the Relationship Analysis Client and click
Manage. Select the model you want to back up
then click Backup.

In addition to backing up your models, back up
these two property files:

• server\modules\hub
\hub.properties

• server\modules\db
\neo4j.properties

Location Intelligence Module Back up your named resources, data, and
configuration files.

3. Stop all the nodes in the server cluster then stop all the nodes in the configuration database
cluster. Make a note of the last node that you stop in the configuration database cluster. You
must start this node first after upgrading. For instructions on stopping a cluster, see Stopping
a Cluster on page 57.
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4. On the last node that you shut down in the configuration database cluster, execute
installdb.exe. The installer upgrades the configuration database.

Warning:  The first node that you upgrade must be the last node that was stopped. This is
because on some operating systems the configuration database will start automatically at the
end of the upgrade process. If the first node that starts is not the last node that was stopped,
data such as job history and configuration settings may be lost. If you do not know which
node was stopped last, look in each node's wrapper log for the time stamp of the shutdown
message. You can find the wrapper log in: Spectrum Location\Database\repository
\logs\wrapper.log.

Important:  When prompted with the option to start Spectrum™ Technology Platform after
the installation, you must disable this option so that the database does not start automatically
when the installation completes.

5. After the upgrade is complete, the configuration database starts up automatically. Verify
that the configuration database is fully started before continuing by opening the log file
SpectrumInstallationLocation\Database\repository\logs\wrapper.log and
looking for the message Started.

Important:  Do not attempt to stop the server until after it has fully started for the first time.
Stopping the server before it performs an initial startup can cause your installation to become
unusable.

6. Stop the configuration database. To stop the configuration database, right-click the Spectrum™

Technology Platform icon in the Windows system tray and select Stop Spectrum™.
Alternatively, you can use the Windows Services control panel to stop the configuration
database by stopping the Spectrum Database service.

7. Configure clustering for the database cluster.
a) Edit the file Database/repository/spectrum-container.properties as described

in Cluster Properties for a Configuration Database Cluster on page 65.
b) Save and close the spectrum-container.properties file.
c) Start the last node that was stopped in the configuration database cluster. To start the

configuration database, right-click the Spectrum™ Technology Platform icon in the Windows
system tray and select Start Spectrum™. Alternatively, you can use the Windows Services
control panel to start the configuration database by starting the Spectrum Database
service.

d) After the upgraded configuration database is fully started, repeat the previous steps to
upgrade each of the remaining servers in the configuration database cluster and start each
of them.

8. Upgrade each node in the server cluster. For more information, see Upgrading a Cluster on
page 49.

Important:  When installing each server select the Server only option in the
installer and provide the host and port of one or more of the configuration database
servers. You can find the port in the file InstallationLocation\Database
\repository\spectrum-container.properties. The port is specified in the
spectrum.repository.server.connector.bolt.port property.
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Note:  Any job or subflow stored in the system during a server upgrade is marked as
exposed to provide the same behavior for those jobs and subflows as before the upgrade.
Any job or subflow that is exported prior to the upgrade will not be exposed. Therefore,
when importing these jobs or subflows back into the system, you must manually expose
the imported job or subflow.

Some modules have post-upgrade steps you need to perform.

Data Hub Module Open this file in a text editor: server/modules/
hub/neo4j.properties and set the property
allow_store_upgrade property to true.
The purpose of this property is to protect against
unintentional and irreversible store upgrades. Setting
this property to "true" indicates that you understand the
ramifications of proceeding with an upgrade and have
taken the necessary precautions before proceeding.

Restart the Spectrum™ Technology Platform server.
The server will upgrade each model. Examine the
file server/app/repository/logs/
wrapper.log for errors or warning messages.
Once all models have been upgraded, go back to
the hub.properties file and comment out the
allow_store_upgrade property.

Upgrading a Cluster with a Separated Database and Data
Hub Module

Prerequisites:

• Before upgrading, be sure to read the release notes for the new version. The release notes
contain important compatibility information, supported upgrade paths, and module-specific data
backup recommendations.

• Apply all the latest updates available for your operating system, especially those that resolve
issues with Java.

This procedure describes how to upgrade Spectrum™ Technology Platform when you have
separated the configuration database from the server and you have the Data Hub Module
installed. The upgrade process consists of these steps:

1. Stop the server cluster.
2. Stop the configuration database cluster.
3. Upgrade the last node that was stopped in the configuration database cluster.
4. Upgrade the other nodes in the configuration database cluster.
5. Upgrade the server acting as the Data Hub Module master in the server cluster.
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6. Upgrade the non-master servers in the server cluster.

To upgrade a cluster with a separated configuration database and the Data Hub Module, follow
this procedure:

1. Back up the server. For instructions on creating a backup, see the Administration Guide.

Important:  We recommend that you create a backup before upgrading so that you can
recover your flows, security settings, and other settings, if an error occurs during the upgrade
process.

2. Open the Relationship Analysis Client and click Manage. Select the model you want to back
up then click Backup.

In addition to backing up your models, back up these two property files:

• server\modules\hub\hub.properties
• server\modules\db\neo4j.properties

3. Identify which node is the serving as the master server for the Data Hub Module.
a) Open a web browser and go to:

http://LoadBalancer:8080/jmx-console/HttpAdaptor/list
b) Scroll down to the neo4j.org domain.

You will see a set of objects for each model. The Role attribute in the HighAvailability
object indicates whether a server is the master for a model.

c) If you have more than one model and each model has a different master, you need to
make one server the master of all the models. To do this, restart the cluster then open the
Relationship Analysis Client using the hostname or IP address of one of the nodes rather
than the load balancer. In the Relationship Analysis Client, open each model by running a
query on each model. This will make the server you are connected to the master for each
model.

4. Stop all the non-master nodes in the server cluster then stop the master server last. Stop
nodes one at a time rather than all at once.

Important:  Make sure that Spectrum™ Technology Platform stops without errors. If a server
does not stop properly, Data Hub Module models on the server will not open successfully
after upgrading. To ensure that Spectrum™ Technology Platform stopped cleanly, examine
the SpectrumDirectory\server\app\repository\logs\wrapper.log file for errors
during shutdown.

5. Stop all the nodes in the configuration database cluster. Make a note of the last node that you
stop in the configuration database cluster. You must start this node first after upgrading.

6. On the last node that you shut down in the configuration database cluster, execute
installdb.exe. The installer upgrades the configuration database.

Warning:  The first node that you upgrade must be the last node that was stopped. This
is because on some operating systems the configuration database will start automatically
at the end of the upgrade process. If the first node that starts is not the last node that was
stopped, data such as job history and configuration settings may be lost. If you do not know
which node was stopped last, look in each node's wrapper log for the time stamp of the
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shutdown message. You can find the wrapper log in: Spectrum Location\server\app
\repository\logs\wrapper.log.

7. After the upgrade process finishes, wait for the server to start, then stop the server.

You can see when the server has started up by opening the log file <Spectrum
Installation Location>\server\app\repository\logs\wrapper.log and
looking for this message:

INFO  [Server] Pitney Bowes Spectrum(TM) Technology Platform
 Database (Version version build) Started

Important:  Do not attempt to stop the server until after it has fully started for the first time.
Stopping the server before it performs an initial startup can cause your installation to become
unusable.

8. Configure clustering for the database cluster.
a) Edit the file server/app/conf/spectrum-container.properties as described in

Cluster Properties for a Configuration Database Cluster on page 65.
b) Save and close the spectrum-container.properties file.
c) Start the last node that was stopped in the configuration database. To start the configuration

database, right-click the Spectrum™ Technology Platform icon in the Windows system tray
and select Start Spectrum™. Alternatively, you can use the Windows Services control panel
to start the configuration database by starting the Spectrum Database service.

Warning:  The first node that you start must be the last node that was stopped, and that
node must be a seed node. Starting another node first may result in loss of data such
as job history and configuration settings. If you do not know which node was stopped
last, look in each node's wrapper log for the time stamp of the shutdown message. You
can find the wrapper log in: Spectrum Location\server\app\repository\logs
\wrapper.log.

d) After the upgraded configuration database is fully started, repeat the previous steps to
upgrade each of the remaining servers in the configuration database cluster and start each
of them.

9. Upgrade the Data Hub Module master server in the server cluster.
a) If you are upgrading from Spectrum™ Technology Platform 10.0 or later, each model

directory must contain a version.data file. Review all the model.ModelName
subdirectories located under SpectrumDirectory/server/modules/hub/db to
confirm that they contain a version.data file. If any model directory is missing this file,
copy the corresponding version.data file from one of the non-master nodes.

b) Run the Spectrum™ Technology Platform installer to upgrade the master server to the new
version of Spectrum™ Technology Platform.

c) After the upgrade process finishes, the Spectrum™ Technology Platform server starts
automatically. Wait for the server to finish starting completely, then stop the server.
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d) Open the file SpectrumFolder\server\modules\hub\hub.properties in an editor
and confirm that the property hub.neo4j.database.type is set to embedded:

hub.neo4j.database.type=embedded

e) Open the file SpectrumFolder\server\modules\hub\db\neo4j.properties in an
editor and set the allow_store_upgrade property to true:

allow_store_upgrade=true

f) Start the Spectrum™ Technology Platform server.
g) Open each model in the Relationship Analysis Client and run a query. Any query is

sufficient.
h) Stop the Spectrum™ Technology Platform server.
i) Open the file SpectrumFolder\server\modules\hub\hub.properties in an editor

and set the property hub.neo4j.database.type to ha:

hub.neo4j.database.type=ha

j) Compare any properties files that you backed up to the installed files and make any
necessary changes. Do not overwrite new files with old files because new files may contain
properties that old files do not.

10.Upgrade the Data Hub Module non-master servers in the server cluster.

Important:  When installing each server select the Server only option in the
installer and provide the host and port of one or more of the configuration database
servers. You can find the port in the file InstallationLocation\Database
\repository\spectrum-container.properties. The port is specified in the
spectrum.repository.server.connector.bolt.port property.

a) Delete the models in the SpectrumDirectory\server\modules\hub\db directory.

Warning:  Do not delete the models from the master server.
b) On one of the non-master servers, run the Spectrum™ Technology Platform installer to

upgrade it to the new version of Spectrum™ Technology Platform.
c) After the upgrade process finishes, the Spectrum™ Technology Platform server starts

automatically. Wait for the server to finish starting completely, then stop the server.
d) Open the file SpectrumFolder\server\modules\hub\hub.properties in an editor

and set the property hub.neo4j.database.type to ha:

hub.neo4j.database.type=ha

e) Compare any properties files that you backed up to the installed files and make any
necessary changes. Do not overwrite new files with old files because new files may contain
properties that old files do not.

f) Copy the SpectrumFolder\server\modules\hub\db\model.* directories from the
master server to the non-master server.

g) Repeat these steps for each non-master server in the cluster.
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11.Start the cluster.
a) Start the master server, followed by non-master servers.
b) Ensure that each server in the cluster is functioning. Check SpectrumFolder\server

\app\repository\wrapper.log for any errors.
c) While directly connected to the master server (bypassing the load balancer), open each

model, one at a time, and inspect the wrapper.log file for errors.

Converting to a Separated Configuration Database

Converting an existing Spectrum™ Technology Platform installation to a separated configuration
database enables you to take advantage of the improved scalability of a separated configuration
database. When you convert to a separated configuration database, your existing installation
is converted from one where the configuration database is part of the server to one where the
configuration database is in a separate cluster.

At a high level, this is the conversion process:

• Stop your existing Spectrum™ Technology Platform server.
• Set up the new configuration database cluster:

• Install the separate configuration database software on a new server.
• Copy your existing configuration database to the new server.
• Configure clustering and start the configuration database cluster.

• Install the server-only cluster and start it up.

Note:  This procedure applies both to converting a single server to a separated
configuration database, and converting a cluster to a separated configuration database.

To convert to a separated configuration database:

1. Back up module-specific data for any of these modules if you have them installed.

Module Items to Back Up

Advanced Matching Module, Data Normalization
Module, and Universal Name Module

Back up the contents of these subfolders located
in SpectrumLocation/server/
modules:

• cdqdb
• lucene
• matcher
• parser
• searchindex
• tables

.
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Module Items to Back Up

Data Hub Module Open the Relationship Analysis Client and click
Manage. Select the model you want to back up
then click Backup.

In addition to backing up your models, back up
these two property files:

• server\modules\hub
\hub.properties

• server\modules\db
\neo4j.properties

Location Intelligence Module Back up your named resources, data, and
configuration files.

2. If the server you are converting is running Spectrum™ Technology Platform 11.0 SP1 or
earlier, you must upgrade to the latest version of Spectrum™ Technology Platform before
converting from a standard installation to a separated configuration database. For more
information, see Upgrading a Server on page 23 (for upgrading a single serer) or Upgrading
a Cluster on page 49 (for upgrading a cluster).

3. Stop the server. If you have a clustered installation, stop the cluster.
4. Install the configuration database to a new server.

a) Place the Spectrum™ Technology Platform installer on the machine where you want to
install the configuration database. This must be a different machine from the one where you
have your existing Spectrum™ Technology Platform server installed.

b) Double-click installdb.exe.
c) Follow the prompts to install the configuration database.

Important:  When prompted with the option to start Spectrum™ Technology Platform
after the installation, you must disable this option so that the database does not start
automatically when the installation completes.

d) Copy the Database\repository\data\databases folder from your existing server to
the server where you installed the separate configuration database. Replace the existing
folder.

e) Configure the cluster properties for the database cluster by editing the file Database
\repository\spectrum-container.properties as described in Cluster Properties
for a Configuration Database Cluster on page 65.

f) Save and close the spectrum-container.properties file.
g) Start the configuration database. To start the configuration database, right-click the

Spectrum™ Technology Platform icon in the Windows system tray and select Start
Spectrum™. Alternatively, you can use the Windows Services control panel to start the
configuration database by starting the Spectrum Database service.

h) Install the configuration database on additional servers as needed to complete the
configuration database cluster.

5. Install the server.
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a) (Optional) If you are upgrading to a new version and you want to use the same machine
to host the upgraded server as hosted the existing server, uninstall the existing server of
Spectrum™ Technology Platform.

b) Install the server cluster. For more information, see Installing a Cluster on page 37.

Important:  When installing each server select the Server only option in the
installer and provide the host and port of one or more of the configuration database
servers. You can find the port in the file InstallationLocation\Database
\repository\spectrum-container.properties. The port is specified in the
spectrum.repository.server.connector.bolt.port property.

Converting from a Separated Configuration Database to
a Standard Installation

If you have a cluster that consists of separate clusters for the server and for the configuration
database, you can convert your installation to a standard installation where the server and
configuration database are installed together on the same server.

1. Back up module-specific data for any of these modules if you have them installed.

Module Items to Back Up

Advanced Matching Module, Data Normalization
Module, and Universal Name Module

Back up the contents of these subfolders located
in SpectrumLocation/server/
modules:

• cdqdb
• lucene
• matcher
• parser
• searchindex
• tables

.

Data Hub Module Open the Relationship Analysis Client and click
Manage. Select the model you want to back up
then click Backup.

In addition to backing up your models, back up
these two property files:

• server\modules\hub
\hub.properties

• server\modules\db
\neo4j.properties
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Module Items to Back Up

Location Intelligence Module Back up your named resources, data, and
configuration files.

2. Stop all the nodes in the server cluster then stop all the nodes in the configuration database
cluster.

3. The configuration database must be of the same version of Spectrum™ Technology Platform
as the server you are converting to. If the configuration database is from an older version,
upgrade the configuration database to the same version of Spectrum™ Technology Platform
as the version you want to use for the standard server. On the last node that you shut down
in the configuration database cluster, execute installdb.exe. The installer upgrades the
configuration database.

Warning:  The node that you upgrade must be the last node that was stopped. This is so
that data such as job history and configuration settings are not lost. If you do not know
which node was shut down last, look in each node's wrapper log for the time stamp of the
shutdown message. You can find the wrapper log in: Spectrum Location\server\app
\repository\logs\wrapper.log.

4. After the upgrade process finishes, wait for the server to start, then stop the server.

You can see when the server has started up by opening the log file
SpectrumInstallationLocation\Database\repository\logs\wrapper.log and
looking for the message Started.

Important:  Do not attempt to stop the server until after it has fully started for the first time.
Stopping the server before it performs an initial startup can cause your installation to become
unusable.

5. Install a new server.  For instructions, see Installing a New Server on page 22.

Note:  When prompted, be sure to select Standard Installation, not Server only.

6. Stop the server.
7. Copy the SpectrumLocation\Database\repository\data\databases folder from the

last configuration database server you stopped to the new server, replacing the existing folder.
8. Start the server.

Adding Modules to a Cluster

This procedure describes how to add one or more modules to an existing cluster.

1. Stop all the Spectrum™ Technology Platform nodes in the cluster. For more information,
see Stopping a Cluster on page 57. If your cluster has a separated configuration database
cluster, you only need to stop the server cluster, not the configuration database cluster.
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Warning:  To prevent data loss you must stop the cluster by following the procedure described
in Stopping a Cluster on page 57.

2. On any node in the cluster, install the module or modules you want to add. For more
information, see the Spectrum™ Technology Platform Installation Guide.

3. Open this file in a text editor:

server/app/conf/spectrum-container.properties

4. In the spectrum.cluster.seeds property, remove all host names and IP addresses except
for the one for this server. Save the host names and IP addresses so that you can re-add them
later.

5. Save the file.
6. Start the server.

Note:  Wait for the server to fully start before proceeding.

7. In the file spectrum-container.properties, add the host names and IP addresses that
you had removed.

8. Save the file. You do not need to restart the server.
9. Install the modules on each of the other nodes in the cluster. Start each node after installing

the modules on it, and wait for it to fully start before installing the modules on the next node.
You do not need to modify the spectrum.cluster.seeds property when installing modules
on subsequent nodes.
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Databases
After you have installed the server you need to install the databases
that support the module(s) you have installed. Databases provide
the information that Spectrum™ Technology Platform modules use to
process data, such as postal address data, name data, or geospatial
data. For example, if you have installed the Enterprise Geocoding
Module, you will need to install databases that contain geospatial data;
if you have installed the Universal Addressing Module, you will need to
install databases that contain postal data.

In this section
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Installing the Address Now Module Database

1. Copy the liclcs.sbi license file provided by Pitney Bowes into the following directory:
<SpectrumPlatformLocation>\server\modules\anow\license.

2. Make sure no applications are running.
3. Stop Spectrum™ Technology Platform. To do this, right-click the Spectrum™ Technology

Platform icon in the Windows task bar and select Stop Server.
4. Insert the database DVD containing the database(s) you want to install.

Note:  You must install the Postal databases if you want to use the Enhanced
databases.

5. Select Start > Programs > Pitney Bowes > Spectrum™ Technology Platform > Modules >
Address Now Module > Address Now Data Loader.

6. The installation wizard guides you through the rest of the process.

Note:  The installation location for the Address Now directory defaults to
<SpectrumPlatformLocation>\server\modules\anow. Do not change this path
or the database will not install correctly.

Note:  When prompted for the location of the Installation Media Directory, be sure to
select the directory on the database DVD that contains the kbase folder.

Note:  You may install databases on a mapped drive, but performance will be affected
since you will be accessing them on a network rather than accessing them locally.

7. When the Data Loader is finished, start the Address Now server by going to Control Panel >
Administrative Tools > Services. Right-click the Address Now Server service and select
Start.

8. After the database installed, start Spectrum™ Technology Platform. To do this, right-click
the Spectrum™ Technology Platform icon in the Windows system tray and select Start
Spectrum™.

Installing the Advanced Matching Module Database

The Advanced Matching Module provides a load utility to install databases. The database files
that you install depend on the databases you have licensed.

Note:  To install the Advanced Matching Module databases on Windows Server 2008 you
need administrator privileges.

1. Make sure no applications are running.
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2. Stop Spectrum™ Technology Platform. To do this, right-click the Spectrum™ Technology
Platform icon in the Windows task bar and select Stop Server.

3. Insert the database DVD or download the database from the technical support web site,
www.g1.com/support.

Note:  If you download the database from the web site, it will be downloaded as a zip
file. Unzip the database before proceeding with the installation.

4. Select Start > Programs > Pitney Bowes > Spectrum™ Technology Platform > Modules >
Universal Name and Advanced Matching Modules > Database Load Utility.

5. Follow the prompts during the rest of the installation process.

Note:  You may install databases on a mapped drive, but performance will be affected
since you will be accessing them on a network rather than accessing them locally.

6. Open the file <SpectrumDirectory>\server\bin\wrapper\wrapper.conf in a text
editor.

7. Increase the Java settings for initial heap size (wrapper.java.initmemory) and maximum
heap size (wrapper.java.maxmemory) to reflect the total amount of memory required for
the Arabic Plus Pack and Asian Plus Pack.

• Arabic Plus Pack: 5.5 GB
• Asian Plus Pack - Chinese: 32 MB
• Asian Plus Pack - Japanese: 1.6 GB
• Asian Plus Pack - Korean: 8 MB
• Core Names: 1.1 GB

8. Save and close wrapper.conf.
9. Start Spectrum™ Technology Platform. To do this, right-click the Spectrum™ Technology

Platform icon in the Windows task bar and select Start Server.

Installing Data Normalization Module Databases

The Data Normalization Module provides a load utility to install databases for the Advanced
Transformer, Open Parser, and Table Lookup components. The database files that you install
depend on the databases you have licensed. Use this list of database tables to determine which
files you should download and install. For more information on the tables contained in each
database, refer to the reference documentation for each component.

Stage Available Databases

Advanced Transformer Data Normalization Module - Base Tables

Spectrum™ Technology Platform 12.0 Installation Guide 80

http://www.g1.com/support


Spectrum Databases

Stage Available Databases

Open Parser • Data Normalization Module - Base Tables
• Core Names Database
• Company Names Database
• Arabic Plus Pack
• Asian Plus Pack

Table Lookup • Data Normalization Module - Base Tables
• Core Names Database
• Arabic Plus Pack
• Asian Plus Pack
• ZREPLACE (Used by the SAP Module for French

address validation)

Note:  To install the Data Normalization Module databases on Windows Server 2008 you
need administrator privileges.

1. Make sure no applications are running.
2. Stop Spectrum™ Technology Platform. To do this, right-click the Spectrum™ Technology

Platform icon in the Windows task bar and select Stop Server.
3. Insert the database DVD or download the database from the technical support web site,

www.g1.com/support.

Note:  If you download the database from the web site, it will be downloaded as a zip
file. Unzip the database before proceeding with the installation.

4. Select Start > Programs > Pitney Bowes > Spectrum™ Technology Platform > Modules >
Data Normalization Module > Database Load Utility.

5. Follow the prompts during the rest of the installation process.

Note:  You may install databases on a mapped drive, but performance will be affected
since you will be accessing them on a network rather than accessing them locally.

6. Start Spectrum™ Technology Platform. To do this, right-click the Spectrum™ Technology
Platform icon in the Windows task bar and select Start Server.

Installing Enterprise Geocoding Module Databases

This module has several databases. You may have one or more of these, depending on the
features you have licensed.
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International Geocoding Databases

International geocoding databases contain the data necessary to perform geocoding and reverse
geocoding for locations outside the U.S. Each country has its own database, and some countries
have optional databases that provide enhanced geocoding.

Note:  If you install multiple databases, install each database to a separate folder.

Note:  To install the Enterprise Geocoding Module databases on Windows Server 2008
you need administrator privileges.

1. Download your licensed SPD files from the Pitney Bowes eStore using the link provided in the
release announcement or welcome email.

2. Unzip the file to a temporary location.
3. Place the .spd files in:

SpectrumLocation/server/app/dataimport

The SPD file is automatically extracted to:

SpectrumLocation/server/app/repository/datastorage

Once the database has been extracted to the datastorage folder, it is installed and you can
define it as a database resource using Management Console or the Administration Utility.

You can modify the Spectrum database installation process if needed:

• You can change the location of the data import directory by altering the platform property in the
<SpectrumLocation>/server/app/conf/dataimportdirectories.properties file.

• You can change the location of the data storage folder by altering the
spectrum.data.manager.storage.directory property in the Data Manager settings section of
the <SpectrumLocation>/server/app/conf/spectrum-container.properties file.

• By default, the SPD files are deleted after the files are extracted. However, you can archive
SPD files by setting the spectrum.data.manager.archive.data property to "true" in the Data
Manager settings section of the <SpectrumLocation>/server/app/conf/spectrum-
container.properties file.

AUS-GNAF

If you installed the Australia Geocoded National Address File (G-NAF), you must specify
the GNAF123 and GNAF456 as separate paths but in the same database resource in the
Management Console.

GNAF123 contains the point-level dictionary. This has the highest precision of geocoding
(characterized by Reliability Level 1, 2, or 3.) GNAF456 contains the remainder of address
information in G-NAF that does not meet high precision geocoding criteria (characterized by
Reliability Level 4, 5, or 6.)
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We recommend that you use both databases to validate the existence of addresses but only use
GNAF123 for parcel-level geocoding. If you do not require parcel-level geocodes you can use
GNAF456 for geocoding.

U.S. Geocoding Databases

The U.S. geocoding databases contain the spatial data necessary to perform address
standardization and geocoding. You must install at least one of these databases.

• Centrus Enhanced Geocoding—This database consists of TIGER data provided by the U.S.
Geological Survey and address data provided by the U.S. Postal Service.

• TomTom Geocoding—This database provides more up-to-date data than the Centrus
Enhanced Geocoding database. It requires an additional license. The data is provided by
TomTom, a third-party provider of spatial data, and postal data from the U.S. Postal Service.

• NAVTEQ Geocoding—This database provides more up-to-date data than the Centrus
Enhanced Geocoding database. It requires an additional license. NAVTEQ data is provided by
NAVTEQ, a third-party provider of spatial data. For more information about these databases,
contact your sales representative.

• ZIP + 4 Centroid—This database provides only address standardization and ZIP + 4 centroid
matching. It does not provide street-level matching.

These databases use proprietary files called GSD files. For ZIP Code centroid matching, the file
us.Z9 contains all the centroid info for all states and normally has a z9 extension.

Each geocoding database has an optional Statewide Intersections Index. The Statewide
Intersection Index is designed to enable fast intersection identification on a statewide basis. For
example, the Statewide Intersection Index will allow the database to search for "1st and Main
St, CO" and return a list of possible matches in Colorado more quickly than searching the entire
geocoding database for each instance of the intersection.

Note:  To install the Enterprise Geocoding Module databases on Windows Server 2008
you need administrator privileges.

1. Make sure no applications are running.
2. Download the database from the Pitney Bowes Software eStore using the link provided in

the release announcement or welcome email. You can also download the database from the
technical support web site, www.g1.com/support.

3. The database is downloaded as a zip file. Unzip the database before proceeding with the
installation.

4. Run DataSets.exe. The installation wizard guides you through the rest of the process.

Note:  You may install databases on a mapped drive, but performance will be affected
since you will be accessing them on a network rather than accessing them locally.

5. After you install the database files, use the Database Resource tool in the Management
Console to define the database as a resource. For more information, see the Administration
Guide.
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Points Databases (U.S. Only)

Points databases contain data for locating the center of a parcel. These databases provides
enhanced geocoding accuracy for internet mapping, property and casualty insurance,
telecommunications, utilities, and others.

• Master Location Data —This database provides the best available address point location for
every mailable and deliverable address in the United States.

• Centrus Points—This database contains the data necessary to locate the center of a parcel or
building. It does not contain assessor's parcel number (APN) or elevation data.

• Centrus Elevation—This database contains the same data as Centrus Points, plus elevation
data.

• Centrus Enhanced Points—This database contains the same data as Centrus Points, plus
APN data.

• Centrus Premium Points—This database contains the same data as Centrus Points, plus both
APN and elevation data.

• TomTom Points Database—The data in this database is provided by TomTom, a third-party
provider of spatial data.

• NAVTEQ Points—This database is provided by NAVTEQ, a third-party data provider. It
contains data used to locate addresses at the center of the actual building footprint or parcel.

Note:  To install the Enterprise Geocoding Module databases on Windows Server 2008
you need administrator privileges.

1. Make sure no applications are running.
2. Insert the database DVD or download the database from the technical support web site,

www.g1.com/support.

Note:  If you download the database from the Pitney Bowes web site, it will be
downloaded as a zip file. Unzip the database before proceeding with the installation.

3. Run Setup.exe. The installation wizard guides you through the rest of the process.

Note:  You may install databases on a mapped drive, but performance will be affected
since you will be accessing them on a network rather than accessing them locally.

4. After you install the database files, use the Database Resource tool in the Management
Console to define the database as a resource. For more information, see Spectrum™

Technology Platform Administration Guide.

Early Warning System (U.S. Only)

The USPS provides free Early Warning System (EWS) data to prevent matching errors due to
the age of the address information in the .gsd files. The USPS creates a new EWS data set each
week that you can download from the USPS website (ribbs.usps.gov).
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To install the Early Warning System (EWS) database rename the database file from OUT to
EWS.txt and place it in the same folder as the primary database.

Installing Enterprise Routing Module Databases

1. Make sure no applications are running.
2. Insert the database DVD or download the database from the technical support web site,

www.g1.com/support.

Note:  If you download the database from the technical support web site, it will be
downloaded as a zip file. Unzip the database before proceeding with the installation.

3. Run dbloader.exe.
4. Follow the prompts during the rest of the installation process.

Note:  You may install databases on a mapped drive, but performance will be affected
since you will be accessing them on a network rather than accessing them locally.

Installing Enterprise Tax Module Databases

Depending on the features you have licensed, you need to install one or more of these
databases.

Database Compatibility

The Enterprise Tax Module version 9.0 SP2 and later uses a different data format than previous
releases. You must download and install the GeoTAX/Enterprise Tax Premium database for
use in this version. The GeoTAX/Enterprise Tax Premium database is not compatible with any
releases prior to version 9.0 SP2.

Downloading Database Files

Note:  Prior to downloading the data files: If you have previously installed database
files, you should back up those files and delete any copies of the  .gdi, .gsd,
gsi, .gsl, .gsu, .gsz, .gsx, .z9, .dir, .las and .los files in the
data install directory.

Downloading from the eStore

Use the link in your welcome email to download the zip file. Extract the files and make note of the
directory where you save the files.
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Downloading from the Technical Support Web Site

Download the database from the technical support web site, www.g1.com/support. The data file
will be downloaded as a .zip file. Extract the files and make note of the directory where you save
the files.

Downloading Florida Format Files

You can obtain the Florida format files from the Florida Department of Revenue. The Florida
Department of Revenue compiles the database based on county.

1. Download the files from the Florida website at: https://pointmatch.state.fl.us/General/
AddressFiles.aspx/.

2. Unzip the downloaded files and transfer them to the server.

Note:  Be sure to FTP your files in binary format.

3. Combine the county files into a single file if you downloaded more than one county. If you
downloaded the entire state list, you have approximately 67 files. You must combine all the
files into one file.
Your file is ready for loading.

Downloading TS-158 Format Files

The Federation of Tax Administrators (FTA) maintains a website with links to all data sources that
use the TS-158 format.

1. Download the files from the Florida website at: https://pointmatch.state.fl.us/General/
AddressFiles.aspx.

2. Unzip the downloaded files and transfer them to the Spectrum™ Technology Platform server.
3. State files are often broken up into individual county files. Combine all state and/or county files

into a single file.
Your file is ready for loading.

Database Options

The following describes the database options presented in the Windows Database Load Utility.

GeoTAX master files
The GeoTAX/Enterprise Tax Premium Database is a required dataset and is the
master file for the Enterprise Tax Module software. The master files identify all
geographic components associated with a street address, such as the latitude/
longitude, census tract, and block group.

Point Data files
Point Data products include Master Location Data (MLD), Centrus Points, Centrus
NAVTEQ Points, and Centrus TomTom Points. The point data provides point-level
geocoding for the most accurate placement of addresses throughout the U.S. The
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Master Location Data database provides the best available address point location
for every mailable and deliverable address in the United States.

User auxiliary file
This is a user-defined file that the Enterprise Tax Module uses to override results
from the master files in street-level matching. If you have data that is more current
than that in the master files, you can enter the new data into the auxiliary file and
use it for your address matching. The Enterprise Tax Module returns matches
made with a code that signifies the answer came from the auxiliary file. You can
also return user-defined data from the auxiliary file with the match. The install
program creates the file G1GTAUX in the specified destination.

GeoTAX auxiliary file
This file contains new addresses that have not yet been added to the master files.
It provides the most up-to-date address data possible. The install program creates
the indexed sequential file G1GTAX2 in the specified destination.

Landmark auxiliary file
This is a user-defined file that allows you to specify customized address
information in your input records. The recommended primary use of this file to
match to your company’s non-address locations such as well heads, transmission
towers or any other descriptive location. The latitude/longitude that is part of the
input needed to build this file allows companies to automatically keep track of
any jurisdictional changes that affect these unique locations. Matching to this
file requires that the input record information match exactly to the Landmark file
contents. This also applies to street records if you choose to enter them in the
Landmark file. For more information, refer to the Enterprise Tax Module Guide.

State-supplied Florida format file
This is a state-supplied file in Florida-native format which is provided by individual
state governments. The Enterprise Tax Module first attempts to match to the state
database. If the Enterprise Tax Module cannot find a state match, it attempts a
match to the GeoTAX Auxiliary file, if loaded, then to the master files.

State-supplied TS-158 format file
This is a state-supplied file in TS-158 (ANSI Transaction Set No. 158) format
which is provided by individual state governments. The Enterprise Tax Module first
attempts to match to the state database. If the Enterprise Tax Module cannot find a
state match, it attempts a match to the GeoTAX Auxiliary file, if loaded, then to the
master files.

Boundary file
Boundary files provide additional data about locations of special tax districts:

• Special Purpose Tax Districts (spd.txb)
• Insurance Premium Tax Districts (ipd.txb)
• Payroll Tax Districts (pay.txb)
• Personal Property Tax Districts (ptd.txb)
• User-defined Boundary file (usr.txb)
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PB Software tax rate file
The Pitney Bowes Software Sales and Use Tax Rate file allows you to use the
Enterprise Tax Module to provide sales and use tax rates for each of the assigned
tax jurisdictions as well as the total rate for the assigned locations. The install
program creates the indexed sequential file GTTAXRT.

Payroll tax correspondence file
Payroll tax cross-reference file allow you to use third-party software to determine
the payroll tax rates. The cross-reference files combine the U.S. Government
Federal Information Processing Standards (FIPS) codes with the proprietary
geocodes used by tax software from third parties. The Payroll System Tax Code
file is a customized file that you build to return the payroll tax codes used by your
payroll system. The install program produces database files called G1GTPTC and
G1GTPTC.vix.

Taxware® cross reference file
This sales tax cross-reference file enables you to use the Enterprise Tax Module
to determine tax jurisdictions for a given address, then use Taxware® software to
determine the sales tax rates for those jurisdictions.

Vertex® cross reference file
This sales tax cross-reference files allows you to use the Enterprise Tax module
to determine tax jurisdictions for a given address, then use Vertex® software to
determine the sales tax rates for those jurisdictions.

PB Software Vertex® cross reference file
This is a Vertex® cross-reference file supplied by Pitney Bowes. The install
program produces a database file GTMSTR2 in the specified destination.

Installing the Database Files

1. Select Start > Programs > Pitney Bowes > Spectrum™ Technology Platform > Modules >
Enterprise Tax Module > Database Load Utility.
The Database Load Utility window launches.

2. Select the database you want to install.

Note:  For Point Data, select the GeoTAX master files option.

3. Follow the instructions provided by the wizard.

Note:  When specifying the destination directory:

• All Enterprise Tax Module databases and cross-reference files must be installed in the
same directory.

• You may install databases on a mapped drive, but performance will be affected since
you will be accessing them on a network rather than accessing them locally.

Spectrum™ Technology Platform 12.0 Installation Guide 88



Spectrum Databases

4. In Management Console, open the Enterprise Tax Module database resource tool and define
a database resource that includes the database you just installed. Be sure to update Assign
GeoTAX Info and Reverse GeoTAX Info Lookup to use the new database resource.

Installing GeoEnrichment Module Databases

1. Download your database(s). The database is downloaded as a .tar.bz2 file.
2. Extract the .tar.bz2 file.

Tip:  A tool that supports extracting the .tar.bz2 and .tar formats is "7-Zip". This open-source
tool can be downloaded from: http://www.7-zip.org/download.html

3. Extract the .tar file.
4. Copy the data to any directory. Note the file name and path.

Note:  You may install databases on a mapped drive, but performance will be affected
since you will be accessing them on a network rather than accessing them locally.

5. After you install the database files, you will need to define the database as a resource.
For more information, see "Adding a GeoEnrichment Module Database Resource" in the
GeoEnrichment Guide on support.pb.com.

Installing Global Addressing Module Databases

This procedure describes how to download and install Global Addressing Module databases
in the Spectrum™ Product Database (SPD) format from the Pitney Bowes eStore or from the
technical support web site, http://www.g1.com/support.

Disk Space

The disk space requirements for extracted and non-extracted SPD bundles are:

• Extracted bundles (all SPD) - 50 GB
• Non-extracted bundles (all SPD) - 20 GB

Memory

The following table provides information on the Global Address Module memory requirements for
each country database.

Table 1: Global Address Validation Memory Requirements (in Megabytes)

Country Database Name Global Address Validation Global Type Ahead Both

Australia (AUS) 700 n/a 1900
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Country Database Name Global Address Validation Global Type Ahead Both

Austria (AUT) 900 700 1900

Belgium (BEL) 900 700 1900

Switzerland (CHE) 700 700 1900

Germany (DEU) 700 700 1900

Denmark (DNK) 2100 700 3400

Spain (ESP) 1300 700 1900

Finland (FIN) 900 700 1900

France (FRA) 2800 700 4100

United Kingdom (GBR) 980 700 1900

Greece (GRC) 700 n/a 1900

Ireland (IRL) 900 700 1900

Italy (ITA) 700 700 1900

Norway (NOR) 700 700 1900

New Zealand (NZL) 700 n/a 1900

To download and install a Global Addressing Module database resource in the Spectrum™

Product Database (SPD) format:

1. Make sure no applications are running.
2. Select and download your licensed SPD files (xxx.spd) from the Pitney Bowes Software

eStore using the link provided in the release announcement or welcome email. You can also
download the database from the technical support web site, http://www.g1.com/support.

3. The database is downloaded as a zip file. Unzip the database before proceeding with the
installation.

4. Install the SPD files:
a) Place the SPD files in <SpectrumLocation>/server/app/dataimport. This is the

default location for SPD files. The Spectrum™ Technology Platform server monitors this
folder and looks for new files in two-second intervals.
You can change the location of the data import directory by altering the
platform property in the <SpectrumLocation>/server/app/conf/
dataimportdirectories.properties file.

b) When the server detects new SPD files, the server automatically extracts the SPD files to
<SpectrumLocation>/server/app/repository/datastorage.
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You can change the location of the data storage folder by altering the
spectrum.data.manager.storage.directory property in the Data Manager
settings section of the <SpectrumLocation>/server/app/conf/spectrum-
container.properties file.

c) By default, the SPD files are deleted after the files are extracted. However, you can archive
SPD files by setting the spectrum.data.manager.archive.data property to "true" in the
Data Manager settings section of the <SpectrumLocation>/server/app/conf/
spectrum-container.properties file.

d) The server will deploy and register the data with the Spectrum™ Technology Platform Data
Manager. At this point the data will become available and you can add it as a data source in
the Spectrum™ Databases section of Management Console.

e) After you install the database files, use either the Database Resource tool in the
Management Console or the Global Addressing Command Line Interface (CLI) database
commands to define the database as a resource. For more information on the CLI database
commands, see the section "Global Addressing Module Databases" in the Administration
Guide.

Installing Global Geocoding Module Databases

This module supports databases for both US and non-US countries.

Non-US Geocoding Databases

Non-US geocoding databases contain the data necessary to perform geocoding and reverse
geocoding for locations outside the U.S.

Note:  If you install multiple databases, install each database to a separate folder.

Note:  To install the Global Geocoding Module databases on Windows Server 2008 you
need administrator privileges.

1. Make sure no applications are running.
2. Download the database from the Pitney Bowes Software eStore using the link provided in

the release announcement or welcome email. You can also download the database from the
technical support web site, www.g1.com/support.

3. The database is downloaded as a zip file. Unzip the database before proceeding with the
installation.

4. Run dbloader.exe.
5. Follow the prompts during the rest of the installation process.

Note:  Do not install geocoding databases on a network drive. Doing so can cause
performance problems.

Spectrum™ Technology Platform 12.0 Installation Guide 91

http://www.g1.com/support


Spectrum Databases

6. After you install the database files, use either the Database Resource tool in the Management
Console or the Global Geocode CLI database commands to define the database as a
resource. For more information, see the Administration Guide.

U.S. Geocoding Databases

The U.S. geocoding databases contain the spatial data necessary to perform address
standardization and geocoding. You must install at least one of these databases.

• TomTom Geocoding—This database provides street segment data by TomTom, a third-party
provider of spatial data, and postal data from the U.S. Postal Service.

• NAVTEQ Geocoding—This database provides street segment data by NAVTEQ, a third-party
provider of spatial data.

These databases use proprietary files called GSD files. For ZIP Code centroid matching, the file
us.Z9 contains all the centroid info for all states and normally has a z9 extension.

Each geocoding database has an optional Statewide Intersections Index. The Statewide
Intersection Index is designed to enable fast intersection identification on a statewide basis. For
example, the Statewide Intersection Index will allow the database to search for "1st and Main
St, CO" and return a list of possible matches in Colorado more quickly than searching the entire
geocoding database for each instance of the intersection.

Note:  To install the Global Geocoding Module databases on Windows Server 2008 you
need administrator privileges.

1. Make sure no applications are running.
2. Download the database from the Pitney Bowes Software eStore using the link provided in

the release announcement or welcome email. You can also download the database from the
technical support web site, www.g1.com/support.

3. The database is downloaded as a zip file. Unzip the database before proceeding with the
installation.

4. Run DataSets.exe. The installation wizard guides you through the rest of the process.

Note:  You may install databases on a mapped drive, but performance will be affected
since you will be accessing them on a network rather than accessing them locally.

5. After you install the database files, use either the Global Geocoding Database Resource tool
in the Management Console or the Global Geocoding CLI database commands to define the
database as a resource. For more information, see the Administration Guide.

Points Databases (U.S. Only)

Points databases contain data for locating the center of a parcel. These databases provides
enhanced geocoding accuracy for internet mapping, property and casualty insurance,
telecommunications, utilities, and others.
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Note:  To use a points database, you must also install a streets database. See U.S.
Geocoding Databases on page 92 for the list of available US streets databases.

• Master Location Data —This database provides the best available address point location for
every mailable and deliverable address in the United States.

• Centrus Points—This database contains the data necessary to locate the center of a parcel or
building. It does not contain assessor's parcel number (APN) or elevation data.

• Centrus Elevation—This database contains the same data as Centrus Points, plus elevation
data.

• Centrus Enhanced Points—This database contains the same data as Centrus Points, plus
APN data.

• Centrus Premium Points—This database contains the same data as Centrus Points, plus both
APN and elevation data.

• TomTom Points—The data in this database is provided by TomTom, a third-party provider of
spatial data.

• NAVTEQ Points—This database is provided by NAVTEQ, a third-party data provider. It
contains data used to locate addresses at the center of the actual building footprint or parcel.

Note:  To install the Global Geocoding Module databases on Windows Server 2008 you
need administrator privileges.

1. Make sure no applications are running.
2. Insert the database DVD or download the database from the technical support web site,

www.g1.com/support.

Note:  If you download the database from the Pitney Bowes web site, it will be
downloaded as a zip file. Unzip the database before proceeding with the installation.

3. Run Setup.exe. The installation wizard guides you through the rest of the process.

Note:  You may install databases on a mapped drive, but performance will be affected
since you will be accessing them on a network rather than accessing them locally.

4. After you install the database files, use either the Global Geocoding Database Resource tool
in the Management Console or the Global Geocoding CLI database commands to define the
database as a resource. For more information, see the Administration Guide.

Installing the Global Sentry Module Database

These databases are required to run Global Sentry in real-time mode:

• ofac.db
• pep.db
• sanctions.db

These files are required to run Global Sentry in batch mode:

• globalsentrydb.addresses-ofac.csv
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• globalsentrydb.fullNames-ofac.csv
• globalsentrydb.ids-ofac.csv
• globalsentrydb.names-ofac.csv
• globalsentrydb.addresses-pep.csv
• globalsentrydb.fullNames-pep.csv
• globalsentrydb.ids-pep.csv
• globalsentrydb.names-pep.csv
• globalsentrydb.addresses-sanctions.csv
• globalsentrydb.fullNames-sanctions.csv
• globalsentrydb.ids-sanctions.csv
• globalsentrydb.names-sanctions.csv

In addition, you must install the Data Normalization Module and Advanced Matching Module
databases to use Global Sentry. For instructions, see Installing Data Normalization Module
Databases on page 80 and Installing the Advanced Matching Module Database on page
79.

Ensure the Global Sentry Database Server is in up and running. In case it is not, use the option in
the utility to start it before you begin data loading.

Note:  You need to perform data loading after every upgrade of Spectrum™ Technology
Platform.

1. Stop Spectrum™ Technology Platform. To do this, right-click the Spectrum™ Technology
Platform icon in the Windows task bar and select Stop Server.

2. Insert the database DVD or download the database from the technical support web site,
www.g1.com/support.

Note:  If you download the database from the Pitney Bowes web site, it will be
downloaded as a zip file. Unzip the database before proceeding with the installation.

3. Select Start > Programs > Pitney Bowes > Spectrum™ Technology Platform > Modules >
Global Sentry Module > Global Sentry Module Database Load Utility.

4. Follow the prompts during the rest of the installation process.

Note:  You may install databases on a mapped drive, but performance will be affected
since you will be accessing them on a network rather than accessing them locally.

5. Start Spectrum™ Technology Platform. To do this, right-click the Spectrum™ Technology
Platform icon in the Windows task bar and select Start Server.

6. After installing the Global Sentry Module database, you must configure a JDBC connection
in the Spectrum™ Technology Platform Management Console. Go to Start > Settings >
Control Panel > Administrative Tools > Services to verify that the Global Sentry Database
is running.

7. Log in to the Management Console and configure the driver and connection properties using
these steps:
a) In a web browser go to this URL:
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http://server:port/managementconsole

Where server is the server name or IP address of your Spectrum™ Technology Platform
server and port is the HTTP port used bySpectrum™ Technology Platform. By default, the
HTTP port is 8080.

b) Enter your user name and password to access the Home page of the Management
Console.

c) On the Main Menu, click Systems > Drivers to open the Drivers page
d) Click Add
e) Type these JDBC properties in the applicable text boxes:

• JDBC driver configuration name: HSQLDB
• JDBC driver class name: org.hsqldb.jdbcDriver
• Connection string template: jdbc:hsqldb:hsql://${host}:${port}/${instance}

f) Add this driver file:
<SpectrumPlatformLocation>/GlobalSentryDatabase/lib/hsqldb.jar

g) To define connection properties, go to Resources > Data Sources.
h) Click Add, and define these connection properties:

• Connection name: Global Sentry
• Database driver: select the HSQLDB JDBC driver that you created in the previous steps.

i) Enter these values in the Connection Properties dialog box:

• user: sa
• password: <there is no password>
• host: localhost or <your server name>
• port: 9001
• instance: globalsentrydb

j) Click Test to verify the connection works.
k) Click OK, then click Save

Installing Location Intelligence Module Databases

1. Place the data on the file system, or install the data into a database.
2. Use Spatial Manager to define Location Intelligence Module database resources (named

connections and tables). For more information, see the "Configuring Database Resources"
chapter of the Spectrum™ Technology Platform Administration Guide on support.pb.com.
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Installing Universal Addressing Module Databases

This procedure describes how to install databases used by Get Candidate Addresses, Get City
State Province, Get Postal Codes, Validate Address, and Validate Address AUS. For instructions
on installing databases used by Validate Address Global, see Installing Validate Address
Global Databases on page 96. For instructions on installing databases used by Validate
Address Loqate, see Installing Validate Address Loqate Databases on page 97.

Note:  To install the Universal Addressing Module databases on Windows Server 2008 you
need administrator privileges.

1. Make sure no applications are running.
2. Download the database from the Pitney Bowes Software eStore using the link provided in

the release announcement or welcome email. You can also download the database from the
technical support web site, www.g1.com/support.

3. The database is downloaded as a zip file. Unzip the database before proceeding with the
installation.

4. Select Start > Programs > Pitney Bowes > Spectrum™ Technology Platform > Modules >
Universal Addressing Module > Database Load Utility.

5. Follow the prompts during the rest of the installation process.

Note:  You may install databases on a mapped drive, but performance will be affected
since you will be accessing them on a network rather than accessing them locally.

6. If you choose to install Residential Delivery Indicator, an optional database that you license
directly from the U.S. Postal Service, you are prompted for the nine-digit RDI table and the
eleven-digit RDI table. These are called rts.hs9 and rts.hs11, respectively, and they are
provided by the U.S. Postal Service.

Installing Validate Address Global Databases

This procedure describes how to install the databases used by the Validate Address Global stage.
For instructions on installing databases used by other Universal Addressing Module stages, see
the Spectrum™ Technology Platform Administration Guide.

1. Download the database from the Pitney Bowes Software eStore using the link provided in
the release announcement or welcome email. You can also download the database from the
technical support web site, www.g1.com/support.

2. The database is downloaded as a zip file. Unzip the database before proceeding with the
installation.

3. Unzip the database file to the location you want. The database zip files are:

• VAGlobal-EMEA.zip—Contains the data for Europe, Middle East, and Africa.
• VAGlobal-APAC.zip—Contains the data for Asia-Pacific.
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• VAGlobal-Americas.zip—Contains the data for the Americas.

Note:  You may install databases on a network share, but performance will be affected
since you will be accessing them on a network rather than accessing them locally.

4. Stop Spectrum™ Technology Platform. To do this, right-click the Spectrum™ Technology
Platform icon in the system tray and select Stop Spectrum™.

5. Install the unlock code:
a) Open the following file in a text editor:

<SpectrumLocation>\server\modules\addressglobal\conf
\unlockcodes.txt

b) Enter your unlock codes, one per line.
c) Save and close the file.

6. Start Spectrum™ Technology Platform. To do this, right-click the Spectrum™ Technology
Platform icon in the system tray and select Start Spectrum™.

Installing Validate Address Loqate Databases

This procedure describes how to install the databases used by the Validate Address Loqate
stage. For instructions on installing databases used by other Universal Addressing Module
stages, see the Spectrum™ Technology Platform Administration Guide.

1. Download the database from the Pitney Bowes Software eStore using the link provided in
the release announcement or welcome email. You can also download the database from the
technical support web site, www.g1.com/support.

2. The database is downloaded as a zip file. Unzip the database before proceeding with the
installation.

3. Unzip the database file(s) to the location you want. If you are installing data from multiple zip
files or discs, be sure to unzip them all to the same location. The database zip files are:

• LQ0/DB_Setup—Contains general database setup files.

Note:  Regardless of which set of data you use, the files in LQ0 must be installed.

• LQ1/APAC_AFR_ME-I—Contains the data for Asia-Pacific, Africa, and Middle East.
• LQ2/Americas-I—Contains the data for the Carribbean, Central America, and South America.
• LQ3/Europe-I—Contains the data for Eastern and parts of Western Europe.
• LQ4/Americas-II—Contains the data for parts of North America.
• LQ5/Europe-II—Contains the data for parts of Western Europe.
• LQ6/Americas-III—Contains the data for parts of North America.
• LQ7/APAC_AFR_ME-II—Contains the data for parts of Asia-Pacific, Africa, and Middle East.
• LQ8/Europe-III—Contains the data for parts of Western Europe.

Note:  You may install databases on a mapped drive, but performance will be affected
since you will be accessing them on a network rather than accessing them locally.
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4. From the location where you extracted the database files, right-click install.bat and select Run
as administrator. This will launch the Loqate Installer.

5. Follow the prompts during the rest of the installation process.

Installing Universal Name Module Databases

The Universal Name Module provides a load utility to install databases. The database files that
you load depend on the databases you have licensed.

Note:  To install the Universal Name Module databases on Windows Server 2008 you
need administrator privileges.

1. Make sure no applications are running.
2. Stop Spectrum™ Technology Platform. To do this, right-click the Spectrum™ Technology

Platform icon in the Windows task bar and select Stop Server.
3. Insert the database DVD or download the database from the technical support web site,

www.g1.com/support.

Note:  If you download the database from the web site, it will be downloaded as a zip
file. Unzip the database before proceeding with the installation.

4. Select Start > Programs > Pitney Bowes > Spectrum™ Technology Platform > Modules >
Universal Name and Advanced Matching Modules > Database Load Utility.

5. Follow the prompts to complete the installation process. The database files are you can install
are:

• Arabic Plus Pack: g1-cdq-cjki-arabic-<date>.jar
• Asian Plus Pack - Chinese: g1-cdq-cjki-chinese-<date>.jar
• Asian Plus Pack - Japanese: g1-cdq-cjki-japanese-<date>.jar
• Asian Plus Pack - Korean: g1-cdq-cjki-korean-<date>.jar
• Core Names Database: g1-cdq-nomino-base-<date>.jar

Note:  You may install databases on a mapped drive, but performance will be affected
since you will be accessing them on a network rather than accessing them locally.

6. To load the complete Core Names Database, you must also install Open Parser and Table
Lookup data from the Data Normalization Module Database Load Utility.
a) Select Start > Programs > Pitney Bowes > Spectrum™ Technology Platform >

Modules > Data Normalization Module > Database Load Utility > Open Parser.
b) Follow the prompts to complete the installation process. The database file you need to

install is:

• cdq-OpenParser-EnhancedNames.tba
c) Select Start > Programs > Pitney Bowes > Spectrum™ Technology Platform >

Modules > Data Normalization Module > Database Load Utility > Table Lookup.
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d) Follow the prompts to complete the installation process. The database file you need to
install is:

• cdq-TableLookup-EnhancedGenderCodes.tba
7. Open the file <SpectrumDirectory>\server\bin\wrapper\wrapper.conf in a text

editor.
8. Increase the Java settings for initial heap size (wrapper.java.initmemory) and maximum

heap size (wrapper.java.maxmemory) to reflect the total amount of memory required for
the Arabic Plus Pack and Asian Plus Pack.

• Arabic Plus Pack: 5.5 GB
• Asian Plus Pack - Chinese: 32 MB
• Asian Plus Pack - Japanese: 1.6 GB
• Asian Plus Pack - Korean: 8 MB
• Core Names: 1.1 GB

9. Save and close wrapper.conf.
10.Start Spectrum™ Technology Platform. To do this, right-click the Spectrum™ Technology

Platform icon in the Windows task bar and select Start Server.

Using the Database Silent Installer

The silent install process allows you to pre-configure the database installation process so that it
runs without user intervention. Instead of responding to prompts from the installation process for
information such as the installation location, you specify these responses in a properties file that
the installer uses instead of user prompts.

Using the Loqate Database Silent Installer

1. In the Spectrum™ Technology Platform server installer (not the database installer), browse to
the SilentInstaller folder.

2. Using a text editor, open the uam_loqate.installer.properties file.
3. Edit the properties file as necessary to specify the installation settings you want to use. See

the comments in the properties file for additional information.
4. To run the installer in silent mode, place the properties file in any directory except the location

where you are going to install the Loqate data and give the absolute path to the property in the
command prompt, as follows:

install.bat %PathOfPropertyFile%\uam_loqate.installer.properties
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Installing the Client Tools

The Spectrum™ Technology Platform client tools are applications that you use to administer your
server and design and run flows. The client tools are:

Enterprise Designer Enterprise Designer is a Windows application
that you use to create, modify, and run flows.

Job Executor Job Executor is a command line tool that you
can use to run a job from a command line or
script. The job must have been previously
created and saved on Spectrum™ Technology
Platform using Enterprise Designer.

Process Flow Executor Process Flow Executor is a command line tool
that you can use to run a process flow from
a command line or script. The process flow
must have been previously created and saved
on Spectrum™ Technology Platform using
Enterprise Designer.

Administration Utility The Administration Utility provides command
line access to administrative functions. You
can use it in a script, allowing you to automate
certain administrative tasks. You can also use it
interactively.

Note:  Before installing, be sure to read the release notes. The release notes contains
important compatibility information as well as release-specific installation notes.

To install the client tools:

1. Open a web browser and go to the Spectrum™ Technology Platform Welcome Page at:

http://<servername>:<port>

For example, if you installed Spectrum™ Technology Platform on a computer named
"myspectrumplatform" and it is using the default HTTP port 8080, you would go to:

http://myspectrumplatform:8080
2. Click Platform Client Tools.
3. Download the client tool you want to install.

Spectrum™ Technology Platform 12.0 Installation Guide 101



Client Tools

Installing Enterprise Designer with a Silent Installer

The silent install process installs Enterprise Designer without user intervention. Instead of
prompting the user for information such as the installation location, the installer uses pre-
configured selections that you specify.

To use the silent installer you must first create an installer properties file by running the client
installer and responding to the prompts. The resulting properties file can then be used to silently
install Enterprise Designer on other computers.

1. Open a web browser and go to the Spectrum™ Technology Platform Welcome Page at:

http://<servername>:<port>

For example, if you installed Spectrum™ Technology Platform on a computer named
"myspectrumplatform" and it is using the default HTTP port 8080, you would go to:

http://myspectrumplatform:8080
2. Click Platform Client Tools.
3. Click Download Installer.
4. Choose to save the file to a location on your computer.

Note:  Save the installer on a Windows computer that does not already have Enterprise
Designer installed. You will need to run the installer in order to specify the options you
want to use in the silent install process.

5. Open a Windows command prompt.
6. In the command prompt, change directories to the directory where you saved the installer.
7. Execute the following command:

Setup.exe -r installer.properties

8. Respond to the installer prompts by selecting the options that you want to use when the
installer runs silently.

For example, if you want the silent installer to install Enterprise Designer to C:\Spectrum
\EnterpriseDesigner, specify C:\Spectrum\EnterpriseDesigner when prompted
for an installation folder.

When the installer finishes running, a properties file named installer.properties is
created in the same folder as the Setup.exe file.

9. Open the file installer.properties in a text editor.
10.Add the following on line 8 of the file:

INSTALLER_UI=silent

Note:  This is case sensitive to be sure to enter it exactly as shown above.
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11.Save and close the properties file.

You have now configured a properties file that will enable you to install Enterprise Designer
silently.

12.To install Enterprise Designer silently, place installer.properties and Setup.exe
in the same folder on the computer where you want to install Enterprise Designer and run
Setup.exe. When the installer executes it will detect installer.properties and
automatically run in silent mode.

Alternatively, you can place installer.properties in different directory and give the
absolute path to the property in the command prompt using the -f argument, as follows:

Setup.exe -f PathOfPropertyFile\installer.properties

Upgrading Enterprise Designer

Upgrading from 11.0 or 11.0 SP1

If you are upgrading to Spectrum™ Technology Platform 12.0 from 11.0 SP1 or 11.0, you do not
need to upgrade Enterprise Designer. However, you should delete this file before logging into
12.0:

C:\Users\UserName\AppData\Roaming\Pitney Bowes\Enterprise Designer
\Settings.xml

Upgrading from a version prior to 11.0

If you are upgrading to Spectrum™ Technology Platform 12.0 from a version prior to 11.0, you
must upgrade Enterprise Designer due to security changes.

Important:  Once you upgrade your server to 12.0 from a version prior to 11.0, you will not be
able to log in to Enterprise Designer until you upgrade it.

To upgrade Enterprise Designer:

1. Uninstall the existing client tools by going to Start > All Programs > Pitney Bowes > Client
Tools > Setup.

2. Make sure that you have .NET 4.6 installed on the client machine. This is a newer version
of .NET than was required in previous releases. Note that Windows 10 comes with this version
of .NET installed by default.

3. Download the client tools installer from the Spectrum™ Technology Platform welcome page,
http://SpectrumServer:Port. The default port is 8080.

4. Run the installer.
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Removing Enterprise Designer

1. Back up any files you may need in the future.
2. Use the Windows Add/Remove Programs control panel to uninstall Enterprise Designer.
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Installing the Client API

The Client API is used to integrate Spectrum™ Technology Platform functionality into your
applications. If you will be creating your own program to call Spectrum™ Technology Platform,
you need to install the Spectrum™ Technology Platform Client API on the system where you will
be developing your application. The Client API allows access to Spectrum™ Technology Platform
through several programming languages, including Java, C++, and web services.

1. Open the folder where you have downloaded the Spectrum™ Technology Platform Client API
installer.

2. Double-click the file sdkinst.exe.
3. The installer guides you through the installation process.

Removing the Client API

Use the Windows Add/Remove Programs control panel to uninstall the Spectrum™

Technology Platform Client API.
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Configuring SAP

Integrating with SAP

To integrate Spectrum™ Technology Platform with SAP, you need to install supporting databases
and dataflows on the Spectrum™ Technology Platform server, and then configure your SAP
system to communicate with Spectrum™ Technology Platform. Once you do this, users of SAP
will have access to address validation and geocoding functionality from within SAP.

1. On the Spectrum™ Technology Platform server, install the databases required to perform
address validation, geocoding, and tax jurisdiction assignment and define database resources
for each database.

You must give the database resources the following names.

Database Required Name for Database Resource

Enterprise Geocoding Module - Canada Database IGEO_CAN

Enterprise Geocoding Module - U.S. Database EGM_US

Enterprise Tax Module Database ETM

Universal Addressing Module - Canada Database Canada

Universal Addressing Module - Loqate Database Loqate

Universal Addressing Module - U.S. Database UAM_US

2. When you install the SAP Module, several dataflow files are automatically installed. Other
dataflow files must be manually copied into Spectrum™ Technology Platform.
a) If you are adding the Address Now Module, Enterprise Tax Module, or Universal

Addressing Module to an existing installation, open Spectrum™ Technology Platform
Enterprise Designer, select View > Server Explorer, and delete this dataflow:
SAPValidateAddressWithCandidates.

b) Go to: SpectrumFolder\server\modules\dataflows\sap.
c) Review the following table then copy the applicable dataflow files to:

SpectrumFolder\server\app\import
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If you are installing this set
of modules

Copy these dataflow files to the import folder

Address Now Module SAPValidateAddressWithCandidates.ANOW.df

Address Now Module
Universal Addressing Module

SAPGenerateCASSReport.df
SAPValidateAddressWithCandidates.ANOW.df
SAPValidateAddressWithCandidates.UAM.df

Address Now Module
Enterprise Geocoding Module

SAPValidateAddressWithCandidates.ANOW_EGM.df

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

SAPValidateAddressWithCandidates.UAM_ANOW_EGM.df

Address Now Module
Enterprise Tax Module
Universal Addressing Module

SAPAssignGeoTAXInfo.df
SAPBatchAssignGeoTAXInfo.df
SAPGenerateCASSReport.df
SAPValidateAddressAndAssignGeoTAXInfo.df
SAPValidateAddressWithCandidates.UAM_ANOW_ETM.df

Address Now Module
Enterprise Geocoding Module
Enterprise Tax Module
Universal Addressing Module

SAPValidateAddressWithCandidates.UAM_ANOW_ETM_EGM.df

Universal Addressing Module
without Loqate

SAPGenerateCASSReport.df
SAPValidateAddressWithCandidate_UAM.df

Universal Addressing Module
without Loqate
Enterprise Tax Module

SAPAssignGeoTAXInfo.df
SAPBatchAssignGeoTAXInfo.df
SAPGenerateCASSReport.df
SAPValidateAddressAndAssignGeoTAXInfo.df
SAPValidateAddressWithCandidates.UAM_ETM.df

Universal Addressing Module
with Loqate

ValidateAddressWithCandidates_UAM_Loqate.df

Universal Addressing Module
with Loqate
Enterprise Geocoding Module

ValidateAddressWithCandidates_UAM_Loqate_EGM.df

Universal Addressing Module
with Loqate
Enterprise Tax Module

ValidateAddressWithCandidates_UAM_Loqate_ETM.df
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If you are installing this set
of modules

Copy these dataflow files to the import folder

Universal Addressing Module
with Loqate
Enterprise Geocoding Module
Enterprise Tax Module

ValidateAddressWithCandidates_UAM_Loqate_EGM_ETM.df

Universal Addressing Module,
Loqate only

ValidateAddressWithCandidates_Loqate.df

Universal Addressing Module,
Loqate only
Enterprise Geocoding Module

ValidateAddressWithCandidates_Loqate_EGM.df

Enterprise Geocoding Module GeocodeUSAddressWithCandidates.df
ValidateAddressWithCandidates_EGM.df

Enterprise Tax Module ValidateAssignGeoTAXInfo.df
ValidateAddressWithCandidates_ETM.df
SAPBatchAssignGeoTAXInfo.df

Note:  If errors occur in Management Console or Enterprise Designer, delete
the contents of <WindowsTemporaryDirectory>\g1Assemblies, where
<WindowsTemporaryDirectory> is one of the following: %TMP%, %TEMP%,
%USERPROFILE%, or the Windows directory. Typically, C:\Documents and Settings
\<USERNAME>\Local Settings\Temp\g1Assemblies. After you delete the contents of
this folder log in again.

3. Import .SAR files.

A .SAR file is a file that contains a third-party add-on package for SAP, such as the
Spectrum™ Technology Platform SAP Module. The .SAR file is located on the Spectrum™

Technology Platform installer in the SAP Objects folder. For information on importing .SAR
files into SAP applications, see your SAP Basis administrator.

4. Activate the BC sets.
a) Log-on to the client where the settings for the Spectrum™ Technology Platform SAP Module

is to be configured.
b) Enter the transaction code SCPR20.

This activates Business Configuration (BC) sets. This will place the default entries on the
Spectrum™ Technology Platform customizing tables.

c) In the BC Set field, enter /HSGRP1/BCSET_BC_BAS_PV.
d) Activate it with the options Overwrite All Data and Default Mode.
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e) Select and activate the remaining BC sets with the activation options set to Overwrite All
Data and Expert Mode.

Note:  Active these BC sets in the order listed.

/HSGRP1/BCSET_BC_BAS_GTX
/HSGRP1/MERGE_SETTINGS
/HSGRP1/BCSET_BUPA_CUSTOM
/HSGRP1/BCSET_BC_BAS_DES
/HSGRP1/BCSET_VENDOR

5. Set up the RFC destination.
a) Enter transaction code SM59.
b) Click Create.
c) In the RFC Destination field, enter a name of your choice.
d) In the Connection Type field, enter G (HTTP connection to external server).
e) In the Description 1 field, enter a meaningful description.
f) Press the Enter key.
g) Click the Technical Settings tab.
h) In the Target Host field, enter the computer name or IP Address of the Spectrum™

Technology Platform server.
i) In the Service No field enter 8080.
j) Click the Special Options tab.
k) Select No Timeout.
l) Select HTTP 1.1.
m)After you save, click Connection Test.

Note:  If there is a pop-up window, check the Accept All Further Cookies box and
select YES.
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n) When the test is successful, go to the Response Body tab to view the Spectrum™

Technology Platform page.
6. Set up the Spectrum™ Technology Platform Logging Object

a) Enter transaction code SLG0.
b) Click New Entries.
c) In the Object column, enter /HSGRP1/DQC.
d) In the Object text column, enter DQC Logging.
e) Save the change.

7. Configure the BuildGlobalAddress web service in the SAP Visual Admin:
a) Go to <drive>:/usr./sap/<system id>/DVEBMGS01/ j2ee/admin and click go.bat and enter

J2EE_ADMIN password.
b) Go to Cluster > Server > Services > JCo RFC Provider and select the Bundles tab.
c) Enter all of the information needed by the application and click Set to save the changes.
d) Go to Cluster > Server > Services > Web Services Security.
e) Create a proxy in Web Services Client > sap.com > Dynamic WSProxies with the name

PBBIWebServiceConnectorBGA.
f) For the URL, enter:

http://<spectrumservername>:<port>/soap/BuildGlobalAddress?wsdl

For example,

http://MySpectrumServer:8080/soap/BuildGlobalAddress?wsdl
g) Restart the application server.

8. If you will be using French address validation, you must install the Data Normalization Module
table cdq-TableLookup-SAP.tba on the Spectrum™ Technology Platform server. For more
information, see the Spectrum™ Technology Platform Installation Guide.

9. To configure DPV and RDI options, open T-code/hsgrp1/options, and specify Y (to
enable) or N (to disable), as needed.

• PVPO: For PO Box address validation
• PVST: For street address validation
• PVQU: For batch address validation

Installing Support Files for Read from SAP

The Read from SAP stage reads data from an SAP database as input to a Spectrum™

Technology Platform dataflow. In order for the Read from SAP stage to access data in your SAP
system you must make the following changes on your SAP system:

• Install the SAP Java Connector
• Install the SAP Transport Requests that support Read from SAP

Note:  You will not be able to use the Read form SAP stage until you perform these steps.
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1. Install the SAP Java Connector (SAP JCo).
a) Go to service.sap.com/connectors and log in with your SAP Marketplace credentials.
b) Go to SAP JCo Connector > Tools & Services.
c) Download SAP JCo to your system.
d) Unzip the SAP JCo zip file to a temporary location.
e) Stop the Spectrum™ Technology Platform server.
f) Copy the .jar file to the following folder on the Spectrum™ Technology Platform server:

SpectrumFolder\server\app\lib
g) Copy the .dll file to the following folder on the Spectrum™ Technology Platform server:

SpectrumFolder\server\bin\wrapper
h) Start the Spectrum™ Technology Platform server.

2. Install the SAP Transport Requests that support Read from SAP.

Note:  The following steps should be performed by your SAP Basis administrator.

a) In the Spectrum™ Technology Platform installer, go to the folder AP Data Integration
Objects\Enterprise System Connectors.

b) Deploy the SAP Transport Requests contained in this folder. See your SAP documentation
for instructions on deploying SAP Transport Requests.

Compatibility Matrix

This tables give a list of SAP add-on versions and system kernel levels that are compatible with
the various releases of Spectrum™ Technology Platform for installation and upgrade of ECC 6.0
and CRM 7.0.

Table 2: Compatibility Matrix for New Installation

Spectrum Release SAP Add-on Version SAP System Kernel
Level

9.x 9.x 720 and above

10.x 10.x 741 and above

11.x 11.x 741 and above

Table 3: Compatibility Matrix for Upgrade

Spectrum
Release

SAP Add-on Version SAP System Kernel
Level

9.x Any to 9.3 720 and above
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Spectrum
Release

SAP Add-on Version SAP System Kernel
Level

10.x Any to 10.x 741 and above

11.x Any to 11.x 741 and above

Note:  It is recommended that you contact the Pitney Bowes representative or coordinator
assigned to you before starting the process.

Configuring Siebel

Integrating with Siebel Data Quality

To integrate Spectrum™ Technology Platform with Siebel Data Quality, you need to install
supporting databases and dataflows on the Spectrum™ Technology Platform server, and then
configure your Siebel system to communicate with Spectrum™ Technology Platform. Once
you do this, users of Siebel Data Quality will have access to address validation and geocoding
functionality from within Siebel Data Quality.

1. On the Spectrum™ Technology Platform server, install the databases required to perform
address validation, geocoding, and tax jurisdiction assignment and define database resources
for each database.

You must give the database resources the following names.

Database Required Name for Database Resource

Enterprise Geocoding Module - Canada Database IGEO_CAN

Enterprise Geocoding Module - U.S. Database EGM_US

Enterprise Tax Module Database ETM

Universal Addressing Module - Canada Database Canada

Universal Addressing Module - Loqate Database Loqate

Universal Addressing Module - U.S. Database UAM_US

2. When you install the Siebel module, several dataflow files are automatically installed. Other
dataflow files must be manually copied into the Spectrum™ Technology Platform server.
a) Browse to one of the following folders on your Spectrum™ Technology Platform server:

• For Siebel Business Applications, go to: <SpectrumPlatformLocation>\server
\modules\dataflows\siebel\sea
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• For Siebel Industry Applications, go to: <SpectrumPlatformLocation>\server
\modules\dataflows\siebel\sia

b) Review the following table then copy the applicable dataflow files to:

SpectrumLocation\server\app\import

Table 4: Dataflow Files To Import

If you are installing this set
of modules

Copy these dataflow files to the import folder

Address Now Module only SiebelGetGlobalCandidateAddresses.df
ValidateAddressWithCandidates.ADN.df

Address Now Module
Universal Addressing Module

SiebelGetGlobalCandidateAddresses.df
ValidateAddressWithCandidates.UAM_ADN.df

Address Now Module
Enterprise Geocoding Module

GeocodeUSAddressWithCandidates.df
SiebelGetGlobalCandidateAddresses.df
ValidateAddressWithCandidates.EGM_ADN.df

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

GeocodeUSAddressWithCandidates.df
SiebelGetGlobalCandidateAddresses.df
ValidateAddressWithCandidates.UAM_EGM_ADN.df

Universal Addressing Module
only

ValidateAddressWithCandidates_UAM.df

Universal Addressing Module
Enterprise Geocoding Module

GeocodeUSAddressWithCandidates.df
ValidateAddressWithCandidates_UAM_EGM.df

Universal Addressing Module
Enterprise Tax Module

GeocodeUSAddressWithCandidates.df
ValidateAssignGeoTAXInfo.df
ValidateAddressWithCandidates_UAM_ETM.df

Universal Address Module with
Loqate

ValidateAddressWithCandidates_UAM_Loqate.df

Universal Addressing Module
with Loqate
Enterprise Geocoding Module

ValidateAddressWithCandidates_Loqate_EGM.df

Universal Addressing Module,
Loqate only
Enterprise Geocoding Module

ValidateAddressWithCandidates_Loqate_EGM.df

Universal Addressing Module
with Loqate
Enterprise Tax Module

ValidateAddressWithCandidates_UAM_Loqate_ETM.df
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If you are installing this set
of modules

Copy these dataflow files to the import folder

Universal Addressing Module
with Loqate
Enterprise Geocoding Module
Enterprise Tax Module

ValidateAddressWithCandidates_UAM_Loqate_EGM_ETM.df

Universal Addressing Module,
Loqate only

ValidateAddressWithCandidates_Loqate.df

Enterprise Geocoding Module ValidateAddressWithCandidates_EGM.df

Enterprise Tax Module ValidateAssignGeoTAXInfo.df

Note:  If errors occur in Management Console or Enterprise Designer, delete the
client cache. To delete the client cache, go to Tools > Options in Management
Console or Enterprise Designer, click the Advanced tab, then click Clear Cache.
After you clear the cache, restart Management Console or Enterprise Designer.

3. Optional: If you are using the Enterprise Geocoding Module, configure the geocoding dataflow
to use the geocoding database resource name you have configured on your system:
a) In Enterprise Designer, open the dataflow GeocodeUSAddressWithCandidates.
b) In each dataflow, open the Geocode US Address stage.
c) In the Database field, select the name of the geocoding database as defined in the

Management Console. The default name is KGDDatasource but if the geocoding database
has a different name on your system, select the appropriate name.

Note:  For more information about database resources, see the Spectrum™

Technology Platform Administration Guide.
d) Save and close each dataflow.

4. Copy Siebel objects to your system:
a) Browse to the location where you downloaded the Spectrum™ Technology Platform

installer.
b) Browse to the appropriate folder for your version of Siebel as shown in the following table.

Siebel Version Folder

Siebel Business Applications 8.0 SDQ Siebel Objects\8.0\Business
\SDQ

Siebel Business Applications 8.1.1 SDQ Siebel Objects
\8.1.1\Business\SDQ

Siebel Industry Applications 8.0 SDQ Siebel Objects\8.0\Industry
\SDQ
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Siebel Version Folder

Siebel Industry Applications 8.1.1 SDQ Siebel Objects
\8.1.1\Industry\SDQ

c) Copy the contents of the folder to a temporary directory.

Note:  This temporary folder will be the referred to as <Spectrum Package> in the
following steps.

5. Create objects and allow object locking:
a) Log in to Siebel Tools as the user SADMIN. In the Connect to field select Server.
b) In the Object Explorer, click Project.
c) Create three new records using the following values in the Name column. To create a new

record, right-click in the Projects area and select New Record.

Group 1 Data Quality
Group 1 EAI Testing
Group 1 Workflow

d) Open the file <Spectrum Package>\tools\CDQP_Queries.txt.
e) Copy and paste the query contents to the Project list of your Object Manager. Cross-check

the query result with the table below and perform the action suggested. To toggle object
locking, go to Object Explorer and browse to the Project object. From the Project area,
right-click and select the project, and select Toggle Object Locking.

Table 5: Queries for Siebel SDQ

Siebel Business
Applications

Siebel Industry
Applications

Project Action

X Account Toggle Object Locking

X Account (SCW) Toggle Object Locking

X X Account (SSE) Toggle Object Locking

X X Contact Toggle Object Locking

Contact (SSE) Toggle Object Locking

CUT Account Toggle Object Locking

CUT Siebel
Communications

Toggle Object Locking

CUT Usage Toggle Object Locking

DNB Data Toggle Object Locking
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Siebel Business
Applications

Siebel Industry
Applications

Project Action

DeDuplication Toggle Object Locking

eAutomotive Toggle Object Locking

X X Employee Toggle Object Locking

FINS Contract Toggle Object Locking

FINS Contract Info Toggle Object Locking

FINS Deal Commercial Toggle Object Locking

FINS Financial
Services

Toggle Object Locking

FINS Opportunity Toggle Object Locking

X X Group 1 Data Quality Create and Toggle
Object Locking

X X Group 1 EAI Testing Create and Toggle
Object Locking

X X Group 1 Workflow Create and Toggle
Object Locking

List Mgmt (Import) Toggle Object Locking

X X List Mgmt (UI) Toggle Object Locking

Mvg Toggle Object Locking

Oppty Toggle Object Locking

Oppty (SSE) Toggle Object Locking

X Personal Contact Toggle Object Locking

X X Picklist Toggle Object Locking

Server Component
Requests

Toggle Object Locking

Siebel Sales
Enterprise

Toggle Object Locking

Siebel Universal Agent Toggle Object Locking

X VERT CUT Address Toggle Object Locking
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Siebel Business
Applications

Siebel Industry
Applications

Project Action

VERT Cut Common Toggle Object Locking

6. Check out the Siebel Projects:
a) Log in to Siebel Tools as the user SADMIN. In the Connect to field select Local.
b) Select Tools > Check Out.
c) Select the projects indicated in the following table and click Checkout.

Table 6: Siebel Projects for SDQ

Siebel Business
Applications

Siebel Industry
Applications

Project

X Account

X X Account (SCW)

X X Account (SSE)

X X Contact

Contact (SSE)

CUT Account

CUT Siebel Communications

CUT Usage

DNB Data

DeDuplication

eAutomotive

X X Employee

FINS Contract

FINS Contract Info

FINS Deal Commercial

FINS Financial Services

FINS Opportunity
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Siebel Business
Applications

Siebel Industry
Applications

Project

Group 1 Data Quality

X X Group 1 EAI Testing

X X Group 1 Workflow

List Mgmt (Import)

X X List Mgmt (UI)

Mvg

Oppty

Oppty (SSE)

X Personal Contact

X X Picklist

Server Component Requests

X Siebel Sales Enterprise

Siebel Universal Agent

X VERT CUT Address

VERT Cut Common

7. Import the Spectrum™ Technology Platform Siebel Objects.
a) Select Tools > Import from Archive.
b) Browse to the Spectrum™ Technology Platform installation package. In the Siebel

Objects folder, browse to the subfolder for your version of Siebel and select the SIF files.
c) Select Merge the object definition in the repository and click Next.

8. Check in all locked projects:
a) Select Tools > Check In.
b) Select all the Projects to check in and click Check in.

9. (Open UI Only) Import the Spectrum™ Technology Platform Siebel Objects for Open UI:
a) Select Tools > Import from Archive.
b) Browse to the Spectrum™ Technology Platform installation package. In the Siebel

Objects folder, browse to the OPEN_UI subfolder for your version of Siebel and select the
SIF files.

c) Select Merge the object definition in the repository and click Next.
10.Compile all Projects:
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a) Select Tools > Compile Projects.
b) Click All Projects.
c) In the Siebel Repository File field, enter the path of your Siebel Web Client SRF file.
d) Click Compile.

11.Deploy the Siebel objects in the client:

Note:  Keep a backup of the old SRF in case old binaries need to be re-implemented.

a) Copy the generated SRF to your web client objects folder.

For example, on Windows the web client object folder may be C:\Program Files
\Siebel\8.0\web client\OBJECTS\ENU. On Unix or Linux the folder may be /
disk2/sia78/webclient/OBJECTS/enu/.

b) Copy the contents of <Spectrum Package>\dll to your BIN folder.
c) Copy the contents of <Spectrum Package>\cfg to your BIN/ENU folder.

12.Deploy the Siebel objects to the server:
a) Stop the Siebel server.
b) Copy the generated SRF file to your web client objects folder.

For example, the folder for Siebel Business on Windows may be C:\sea80\siebsrvr
\OBJECTS\ENU. On Unix or Linux the folder may be /disk2/sea78/siebsrvr/
OBJECTS/enu/.

c) Copy the libraries to your server.

• For Windows, copy the contents of <Spectrum Package>\lib\win to your BIN folder.
• For Unix or Linux, copy the contents of <Spectrum Package>/lib/sol to your LIB

folder.
d) Copy the contents of <Spectrum Package>\cfg to your BIN\ENU folder.
e) Start the Siebel server.

13.Install the options file.
a) Click Site Map > Administration - Data > LOV Explorer.
b) Click New.
c) In the Type column, enter FILE_PATH.
d) Click Query.
e) In the Type column, enter FILE_PATH.
f) Browse to the Values folder.
g) In the Display Value column, enter the absolute path to the folder where you want to keep

the options file. You can specify any folder you want.
h) Browse to the Spectrum™ Technology Platform installation package.
i) In the Siebel Objects folder, browse to the cfg subfolder for your version of Siebel and

select the Group1Connector.opt file.
j) Copy this file to the folder you specified for FILE_PATH.

14.Activate the Spectrum™ Technology Platform workflows in the Siebel web client:
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a) Log in to the Siebel application, connecting to the server data source.
b) Select Site Map > Administration - Business Process > Workflow Deployment.
c) Query for all the GROUP 1* workflows.
d) Click Activate for each workflow.
e) Query for all the Promote* workflows.
f) Click Activate for the ff workflows Promote Prospect (Single) and Promote Prospect

(Many).
15.Verify the installation:

a) Log in to Siebel Application.
b) All applets should load properly without error.

16.Configure the Siebel instance configuration parameters:
a) Select Site Map > Administration - Server Configuration > Enterprises.
b) Verify/Change the ff Parameters:

• Data Cleansing Type—G1Cleansing
• DeDuplication Data Type—G1DataMatching

c) Click Component Definitions and select the ff components. For each component, verify
parameters and values.

Table 7: Siebel Business

Component Definitions Parameter Value/Value on Restart

Data Cleansing Type G1Cleansing

Data Cleansing Enable Flag True

DeDuplication Data Type G1DataMatching

*Data Quality Manager *Sales
Object Manager (ENU) *List
Import Service Manager

DeDuplication Enable Flag True

Table 8: Siebel Industry

Component Definitions Parameter Value/Value on Restart

Data Cleansing Type G1Cleansing

Data Cleansing Enable Flag True

DeDuplication Data Type G1DataMatching

*Data Quality Manager
*eAutomotive Object Manager
(ENU) *List Import Service
Manager

DeDuplication Enable Flag True

d) Select Site Map > Server Configuration > Servers. Repeat steps b through c for server
configuration parameters.
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e) Select Site Map > User Profile Preferences > Data Quality. Change the following
settings:

Parameter Value

Enable DeDuplication Yes

Enable Data Cleansing Yes

f) Browse to <Siebel Installation>\bin\ENU and open the appropriate file:

• Siebel Business: siebel.cfg and uagent.cfg
• Siebel Industry: auto.cfg

g) Under the area [DataCleansing] change the ff Parameters:

Enable = TRUE
Type = G1Cleansing

h) Under the area [DeDuplication] change the ff Parameters:

Enable = TRUE
Type = G1DataMatching

i) Select Site Map > Administration - Server Configuration. Click the Synchronize link and
select Synchronize after being redirected.

17.Configure data cleansing configuration parameters:
a) Select Site Map > Administration > Data Quality > Third Party Administration. On the

Vendor Applet, include the ff value

Name DLL Name

G1Cleansing Group1Connector

b) Add the ff BC Vendor Field Mapping:

Table 9: Siebel Business

Business Component Operation

Account Data Cleansing

Business Address Data Cleansing

Contact Data Cleansing

List Mgmt Prospective Contact Data Cleansing

Personal Address Data Cleansing
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Table 10: Siebel Industry

Business Component Operation

Account Data Cleansing

CUT Address Data Cleansing

Contact Data Cleansing

List Mgmt Prospective Contact Data Cleansing

Personal Address Data Cleansing

c) Under each BC operation, add the ff field mappings:

Table 11: Siebel Business

Business Component Field Mapped Field

Account

Name FirmName

Business Address

City City

Country CountryName

County USCountyName

Disable DataCleansing DisableDataCleansing

G1 Delivery Point Validation Indicator DPV

G1 Latitude Latitude

G1 Location Code LocationCode

G1 Longitude Longitude

G1 Match Code MatchCode

G1 Residential Delivery Indicator RDI

Postal Code PostalCode

State StateProvince
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Business Component Field Mapped Field

Street Address AddressLine1

Street Address 2 AddressLine2

Contact

First Name FirstName

Last Name LastName

M/M TitleOfRespect

Middle Name MiddleName

List Management Prospective Contact

City City

Country CountryName

County USCountyName

Disable DataCleansing DisableDataCleansing

First Name FirstName

G1 Delivery Point Validation Indicator DPV

G1 Latitude Latitude

G1 Location Code LocationCode

G1 Longitude Longitude

G1 Match Code MatchCode

G1 Residential Delivery Indicator RDI

Last Name LastName

Middle Name MiddleName

Postal Code PostalCode

State StateProvince

Street Address AddressLine1

Street Address 2 AddressLine2
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Business Component Field Mapped Field

Personal Address

City City

Country CountryName

County USCountyName

Disable DataCleansing DisableDataCleansing

G1 Delivery Point Validation Indicator DPV

G1 Latitude Latitude

G1 Longitude Longitude

G1 Residential Delivery Indicator RDI

Postal Code PostalCode

State StateProvince

Street Address AddressLine1

Street Address 2 AddressLine2

Table 12: Siebel Industry

Business Component Field Mapped Field

Account

Name FirmName

CUT Address

City City

Country CountryName

County USCountyName

Disable Data Cleansing DisableDataCleansing

G1 Delivery Point Validation Indicator DPV

G1 Latitude Latitude
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Business Component Field Mapped Field

G1 Location Code LocationCode

G1 Longitude Longitude

G1 Match Code MatchCode

G1 Residential Delivery Indicator RDI

Postal Code PostalCode

State StateProvince

Street Address AddressLine1

Street Address 2 AddressLine2

Contact

First Name FirstName

Last Name LastName

Middle Name MiddleName

M/M TitleOfRespect

List Management Prospective Contact

City City

Country CountryName

County USCountyName

Disable DataCleansing DisableDataCleansing

First Name FirstName

G1 Delivery Point Validation Indicator DPV

G1 Latitude Latitude

G1 Location Code LocationCode

G1 Longitude Longitude

G1 Match Code MatchCode

G1 Residential Delivery Indicator RDI
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Business Component Field Mapped Field

Last Name LastName

Middle Name MiddleName

Postal Code PostalCode

State StateProvince

Street Address AddressLine1

Street Address 2 AddressLine2

Personal Address

City City

Country CountryName

County USCountyName

Disable DataCleansing DisableDataCleansing

G1 Delivery Point Validation Indicator DPV

G1 Latitude Latitude

G1 Longitude Longitude

G1 Residential Delivery Indicator RDI

Postal Code PostalCode

State StateProvince

Street Address AddressLine1

Street Address 2 AddressLine2

d) Add the ff Vendor Parameters.

Table 13: Siebel Business

Name Value

Account DataCleanse Record Type Account

Business Address DataCleanse Record Type Business Address

Contact DataCleanse Record Type Contact
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Name Value

List Mgmt Prospective Contact DataCleanse
Record Type

List Mgmt Prospective Contact

Personal Address DataCleanse Record Type Personal Address

Table 14: Siebel Industry:

Name Value

Account DataCleanse Record Type Account

CUT Address DataCleanse Record Type CUT Address

Contact DataCleanse Record Type Contact

List Mgmt Prospective Contact DataCleanse
Record Type

List Mgmt Prospective Contact

Personal Address DataCleanse Record Type Personal Address

e) Select Site Map > Administration - Data Quality > Third Party Administration > Data
Quality Settings. Add the ff data for Data Quality Settings. These settings enable data
cleansing for your Siebel Application

Name Value

Enable DataCleansing Yes

18.Configure data matching configuration parameters:
a) Select Site Map > Administration > Data Quality > Third Party Administration. On the

Vendor Applet, include the ff value

Name DLL Name

G1DataMatching Group1Connector

b) Add the ff BC Vendor Field Mapping:

Table 15: Siebel Business Applications

Business Component Operation

Account DeDuplication

Business Address DeDuplication
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Business Component Operation

Contact DeDuplication

List Mgmt Prospective Contact DeDuplication

Table 16: Siebel Industry Applications

Business Component Operation

Account DeDuplication

CUT Address DeDuplication

Contact DeDuplication

List Mgmt Prospective Contact DeDuplication

c) Under each BC operation, add the ff Field Mappings.

Table 17: Siebel Business Applications

Business Component Field Mapped Field

Account

Dedup Token DedupToken

Id Id

Location Location

Name Name

Primary Account City City

Primary Account Country CountryName

Primary Account Postal Code PostalCode

Primary Account State StateProvince

Primary Account Street Address AddressLine1

Business Address

City City

Country CountryName
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Business Component Field Mapped Field

Id Id

Postal Code PostalCode

State StateProvince

Street Address AddressLine1

Street Address 2 AddressLine2

Contact

First Name FirstName

Id Id

Last Name LastName

Middle Name MiddleName

Primary Account Name AccountName

Primary City City

Primary Country CountryName

Primary Postal Code PostalCode

Primary State StateProvince

List Management Prospective Contact

Account Account

City City

Country CountryName

First Name FirstName

Id Id

Last Name LastName

Middle Name MiddleName

Postal Code PostalCode

State StateProvince
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Business Component Field Mapped Field

Street Address AddressLine1

Street Address 2 AddressLine2

Table 18: Siebel Industry Applications

Business Component Field Mapped Field

Account

Dedup Token DedupToken

Id Id

Location Location

Name Name

Primary Account City City

Primary Account Country Country

Primary Account Postal Code PostalCode

Primary Account State State

Primary Account Street Address AddressLine1

CUT Address

City City

Country Country

Id Id

Postal Code PostalCode

State State

Street Address AddressLine1

Street Address 2 AddressLine2

Contact

First Name FirstName

Spectrum™ Technology Platform 12.0 Installation Guide 132



SAP, Siebel, and Microsoft Dynamics

Business Component Field Mapped Field

Id Id

Last Name LastName

Middle Name MiddleName

Primary Account Name Name

Primary City City

Primary Country Country

Primary Postal Code Code

Primary State State

List Management Prospective Contact

Account Account

City City

Country CountryName

First Name FirstName

Id Id

Last Name LastName

Middle Name MiddleName

Postal Code PostalCode

State StateProvince

Street Address AddressLine1

Street Address 2 AddressLine2

d) Add the ff Vendor Parameters:

Note:  Token Expression and Query Expression are custom fields in their respective
Business Components.
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Table 19: Vendor Parameters

Name Value

Account DeDup Record Type Account

Account Query Expression "|" + [Query Expression 1] + [Query Expression
2] + [Query Expression 3]

Account Token Expression "|" + [Token Expression 1] + [Token Expression
2] + [Token Expression 3]

Batch Max Num of Records 200

(Siebel Business Only)

Business Address DeDup Record Type

Business Address

(Siebel Industry Only)

CUT Address DeDup Record Type

CUT Address

Contact DeDup Record Type Contact

Contact Query Expression "|" + [Query Expression 1] + [Query Expression
2] + [Query Expression 3]

Contact Token Expression "|" + [Token Expression 1] + [Token Expression
2] + [Token Expression 3]

List Mgmt Prospective Contact DeDup Record
Type

List Mgmt Prospective Contact

List Mgmt Prospective Contact Query
Expression

"|" + [Query Expression 1] + [Query Expression
2] + [Query Expression 3]

List Mgmt Prospective Contact Token
Expression

"|" + [Token Expression 1] + [Token Expression
2] + [Token Expression 3]

Realtime Max Num of Records 200

e) Select Site Map > Administration - Data Quality > Third Party Administration > Data
Quality Settings. Add the ff data for Data Quality Settings. These settings enable data
matching for your Siebel Application.

Name Value

Enable DeDuplication Yes

Force User DeDupe - Account Yes
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Name Value

Force User DeDupe - Contact Yes

Force User DeDupe - List Mgmt Yes

19.(Open UI Only) Grant the EAI File Transport business service access to the file system by
following these steps.
a) Click Navigate > Site Map.
b) Click Administration - Server Configuration.
c) In the Administration - Server Configuration section, under Enterprises, click

Parameters.
d) Click Query.
e) In the Name column, enter EAI File Transport Folder List.
f) Click Go.
g) In the Value column, enter the root of the drive where you have Siebel installed. For

example, C:\.
h) Click the Servers link:

i) Click the Parameters tab:

j) Click Query.
k) In the Name column, enter EAI File Transport Folder List.
l) Click Go.
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m)In the Value column, enter the root of the drive where you have Siebel installed. For
example, C:\.

n) Add the following values to the .cfg file appropriate for your system (for example,
auto.cfg, tools.cfg, and so on).

[EAIFileTransportConfigSubsys]
EAIFileTransportFolders=C:\

o) Restart the Siebel server and gateway.
20.Set the EditProfileAttr parameter:

a) Click Navigate > Site Map
b) Click Administration - Server Configuration.
c) In the Administration - Server Configuration section, under Servers, click Components.
d) On the Components tab, click Query.
e) In the Component column, enter the name of the Object Manager component. For

example, "eAutomotive Object Manager".
f) Click Go.
g) Click the Parameters tab at the bottom of the window.
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h) Scroll to the parameter EditProfileAttr.
i) Enter True in the Value, Value on Restart, and Default Value columns.

You have now configured Siebel SDQ to use Spectrum™ Technology Platform for data quality
processing.
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Integrating with Siebel Non-SDQ

To integrate Spectrum™ Technology Platform with Siebel Non-SDQ, you need to install
supporting databases and dataflows on the Spectrum™ Technology Platform server, and then
configure your Siebel system to communicate with Spectrum™ Technology Platform. Once
you do this, users of Siebel Non-SDQ will have access to address validation and geocoding
functionality from within Siebel Non-SDQ.

1. On the Spectrum™ Technology Platform server, install the databases required to perform
address validation, geocoding, and tax jurisdiction assignment and define database resources
for each database.

You must give the database resources the following names.

Database Required Name for Database Resource

Enterprise Geocoding Module - Canada Database IGEO_CAN

Enterprise Geocoding Module - U.S. Database EGM_US

Enterprise Tax Module Database ETM

Universal Addressing Module - Canada Database Canada

Universal Addressing Module - Loqate Database Loqate

Universal Addressing Module - U.S. Database UAM_US

2. When you install the Siebel module, several dataflow files are automatically installed. Other
dataflow files must be manually copied into the Spectrum™ Technology Platform server.
a) Browse to one of the following folders on your Spectrum™ Technology Platform server:

• For Siebel Business Applications, go to: <SpectrumPlatformLocation>\server
\modules\dataflows\siebel\sea

• For Siebel Industry Applications, go to: <SpectrumPlatformLocation>\server
\modules\dataflows\siebel\sia

b) Review the following table then copy the applicable dataflow files to:

SpectrumLocation\server\app\import
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Table 20: Dataflow Files To Import

If you are installing this set
of modules

Copy these dataflow files to the import folder

Address Now Module only SiebelGetGlobalCandidateAddresses.df
ValidateAddressWithCandidates.ADN.df

Address Now Module
Universal Addressing Module

SiebelGetGlobalCandidateAddresses.df
ValidateAddressWithCandidates.UAM_ADN.df

Address Now Module
Enterprise Geocoding Module

GeocodeUSAddressWithCandidates.df
SiebelGetGlobalCandidateAddresses.df
ValidateAddressWithCandidates.EGM_ADN.df

Address Now Module
Enterprise Geocoding Module
Universal Addressing Module

GeocodeUSAddressWithCandidates.df
SiebelGetGlobalCandidateAddresses.df
ValidateAddressWithCandidates.UAM_EGM_ADN.df

Universal Addressing Module
only

ValidateAddressWithCandidates_UAM.df

Universal Addressing Module
Enterprise Geocoding Module

GeocodeUSAddressWithCandidates.df
ValidateAddressWithCandidates_UAM_EGM.df

Universal Addressing Module
Enterprise Tax Module

GeocodeUSAddressWithCandidates.df
ValidateAssignGeoTAXInfo.df
ValidateAddressWithCandidates_UAM_ETM.df

Universal Address Module with
Loqate

ValidateAddressWithCandidates_UAM_Loqate.df

Universal Addressing Module
with Loqate
Enterprise Geocoding Module

ValidateAddressWithCandidates_Loqate_EGM.df

Universal Addressing Module,
Loqate only
Enterprise Geocoding Module

ValidateAddressWithCandidates_Loqate_EGM.df

Universal Addressing Module
with Loqate
Enterprise Tax Module

ValidateAddressWithCandidates_UAM_Loqate_ETM.df

Universal Addressing Module
with Loqate
Enterprise Geocoding Module
Enterprise Tax Module

ValidateAddressWithCandidates_UAM_Loqate_EGM_ETM.df
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If you are installing this set
of modules

Copy these dataflow files to the import folder

Universal Addressing Module,
Loqate only

ValidateAddressWithCandidates_Loqate.df

Enterprise Geocoding Module ValidateAddressWithCandidates_EGM.df

Enterprise Tax Module ValidateAssignGeoTAXInfo.df

Note:  If errors occur in Management Console or Enterprise Designer, delete the
client cache. To delete the client cache, go to Tools > Options in Management
Console or Enterprise Designer, click the Advanced tab, then click Clear Cache.
After you clear the cache, restart Management Console or Enterprise Designer.

3. Optional: If you are using the Enterprise Geocoding Module, configure the geocoding dataflow
to use the geocoding database resource name you have configured on your system:
a) In Enterprise Designer, open the dataflow GeocodeUSAddressWithCandidates.
b) In each dataflow, open the Geocode US Address stage.
c) In the Database field, select the name of the geocoding database as defined in the

Management Console. The default name is KGDDatasource but if the geocoding database
has a different name on your system, select the appropriate name.

Note:  For more information about database resources, see the Spectrum™

Technology Platform Administration Guide.
d) Save and close each dataflow.

4. Copy Siebel objects to your system:
a) Browse to the location where you downloaded the Spectrum™ Technology Platform

installer.
b) Browse to the appropriate folder for your version of Siebel as shown in the following table.

Siebel Version Folder

Siebel Business Applications 8.0 Non-SDQ Siebel Objects\8.0\Business
\non SDQ

Siebel Business Applications 8.1.1 Non-SDQ Siebel Objects
\8.1.1\Business\non SDQ

Siebel Industry Applications 8.0 Non-SDQ Siebel Objects\8.0\Industry
\non SDQ

Siebel Industry Applications 8.1.1 Non-SDQ Siebel Objects
\8.1.1\Industry\non SDQ

c) Copy the contents of the folder to a temporary directory.
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Note:  This temporary folder will be the referred to as <Spectrum Package> in the
following steps.

5. Create objects and allow object locking:
a) Log in to Siebel Tools as the user SADMIN, with the connection pointing to the server data

source.
b) Go to Object Explorer, drill down to the Project object. From the Project area, right-click

and select New Record. Create the following projects:

• Group 1 Data Quality
• Group 1 EAI Testing
• Group 1 Workflow

c) Open the file <Spectrum Package>\tools\CDQP_Queries.txt.
d) Copy and paste the query contents to the Project list of your Object Manager. Cross-check

the query result with the table below and perform the action suggested. To toggle object
locking, go to Object Explorer and browse to the Project object. From the Project area,
right-click and select the project, and select Toggle Object Locking.

Table 21: Queries for Siebel non-SDQ

Siebel
Business

Applications

Siebel Industry
Applications

Open UI Project Action

X X X Account Toggle Object
Locking

X X X Account (SCW) Toggle Object
Locking

X X X Account (SSE) Toggle Object
Locking

X X X Contact Toggle Object
Locking

X X X Contact (SSE) Toggle Object
Locking

X X CUT Account Toggle Object
Locking

X X CUT Siebel
Communications

Toggle Object
Locking

X X CUT Usage Toggle Object
Locking
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Siebel
Business

Applications

Siebel Industry
Applications

Open UI Project Action

X X X DNB Data Toggle Object
Locking

X X X DeDuplication Toggle Object
Locking

X X eAutomotive Toggle Object
Locking

X X X Employee Toggle Object
Locking

X X FINS Contract Toggle Object
Locking

X X FINS Contract
Info

Toggle Object
Locking

X X FINS Deal
Commercial

Toggle Object
Locking

X X FINS Financial
Services

Toggle Object
Locking

X X FINS Opportunity Toggle Object
Locking

X X X Group 1 Data
Quality

Create and
Toggle Object
Locking

X X X Group 1 EAI
Testing

Create and
Toggle Object
Locking

X X Group 1 Workflow Create and
Toggle Object
Locking

X List Mgmt
(Import)

Toggle Object
Locking

X X X List Mgmt (UI) Toggle Object
Locking

X Mvg Toggle Object
Locking
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Siebel
Business

Applications

Siebel Industry
Applications

Open UI Project Action

X X X Oppty Toggle Object
Locking

X X X Oppty (SSE) Toggle Object
Locking

X X X Personal Contact Toggle Object
Locking

X X X Picklist Toggle Object
Locking

X X X Server
Component
Requests

Toggle Object
Locking

X X Siebel Sales
Enterprise

Toggle Object
Locking

X Siebel Universal
Agent

Toggle Object
Locking

X X VERT CUT
Address

Toggle Object
Locking

X X VERT Cut
Common

Toggle Object
Locking

6. Check out the Siebel Projects:
a) Log in to Siebel Tools on Local Datasource.
b) Select Tools > Checkout.
c) Select the projects indicated in the following table and click Checkout.

Table 22: Siebel Projects for non-SDQ

Siebel Business
Applications

Siebel Industry
Applications

Project

X X Account

X X Account (SCW)

X X Account (SSE)

X X Contact
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Siebel Business
Applications

Siebel Industry
Applications

Project

X X Contact (SSE)

X CUT Account

X CUT Siebel Communications

X CUT Usage

X X DNB Data

X X DeDuplication

X eAutomotive

X X Employee

X FINS Contract

X FINS Contract Info

X FINS Deal Commercial

X FINS Financial Services

X FINS Opportunity

X X Group 1 Data Quality

X X Group 1 EAI Testing

X Group 1 Workflow

X List Mgmt (Import)

X X List Mgmt (UI)

X Mvg

X X Oppty

X X Oppty (SSE)

X X Personal Contact

X X Picklist

X X Server Component Requests

X Siebel Sales Enterprise
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Siebel Business
Applications

Siebel Industry
Applications

Project

X Siebel Universal Agent

X VERT CUT Address

X VERT Cut Common

7. Import the Spectrum™ Technology Platform Siebel objects:
a) Select Tools > Import from Archive.
b) Import the Siebel SIF files located in <Spectrum Package>\sif. Select Overwrite the

object definition in the repository and click Next to proceed until the import process has
been completed.

• G1_NEW.sif
• G1_APPLET.sif
• G1_BO.sif
• G1_LINK.sif
• G1_BC.sif
• G1_BC_SCRIPTS.sif
• G1_EAI_TESTING.sif
• G1_APPLICATION.sif
• G1_PICKLIST.sif
• G1_VIEW.sif
• G1_WORKFLOW.sif
• (8.1.1 only) Rebranding.sif
• PB_SecToken.sif

Note:  PB_SecToken.sif must be imported in the end.

c) (Open UI Only) Import the Siebel SIF files located in <Spectrum Package>\OPEN_UI.
Select Overwrite the object definition in the repository and click Next to proceed until
the import process has been completed.

• FINS Personal Address List Applet.sif
• G1 Common Browser Scripts Service.sif
• Siebel Sales Enterprise.sif

8. Check in all locked projects:
a) Select Tools > Check In.
b) Select all the Projects to check in and click Check in.

9. Compile all Projects:
a) Select Tools > Compile Projects.
b) Click All Projects.
c) In the Siebel Repository File field, enter the path of your Siebel Web Client SRF file.
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d) Click Compile.
10.Update the application .CFG flie:

a) Open the appropriate .cfg file in an editor:

For example, for Siebel Business:

• Siebel Call Center—uagent.cfg
• Siebel Sales—siebel.cfg

For example, for Siebel Industry:

• eAutomotive—auto.cfg
• Financial—fins.cfg
• eCommunication—ecomm.cfg

Siebel .cfg files are usually found in the following locations:

• Siebel thick client—Siebel\<version>\web client\bin\enu
• Siebel thin client—<Siebel Server>\bin\enu

b) Add the following lines under the [SWE] section:

ClientBusinessService0 = G1 Async Service
ClientBusinessService1 = G1 Business Name Standardization Service
ClientBusinessService2 = G1 Common Browser Scripts Service
ClientBusinessService3 = G1 Common Server Scripts Service
ClientBusinessService4 = G1 DNB VBC Service
ClientBusinessService5 = G1 Data Cleansing Service
ClientBusinessService6 = G1 DeDuplication Service
ClientBusinessService7 = G1 Generate HashKey Service
ClientBusinessService8 = G1 GeoCoding Service
ClientBusinessService9 = G1 Interactive Service
ClientBusinessService10 = G1 Merge Records Service
ClientBusinessService11 = G1 Name Casing Service
ClientBusinessService12 = G1WebService

11.Deploy the Siebel objects in the client:

Note:  Keep a backup of the old SRF in case old binaries need to be re-implemented.

a) Copy the generated SRF to your web client objects folder.

For example, on Windows this folder may be C:\Program Files\Siebel\8.0\web
client\OBJECTS\ENU. On Unix or Linux this folder may be /disk2/sia78/
webclient/OBJECTS/enu/.

b) Open a command prompt and go to the BIN folder of the web client.

For example, on Windows this folder may be C:\Program Files\Siebel\8.0\web
client\BIN. On Unix or Linux, this folder may be /disk2/sia80/webclient/BIN.

c) Generate browser scripts by issuing this command:

On Windows:
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genbscript "ENU\siebel.cfg" "[public\enu folder]"

On Unix or Linux:

genbscript [location of .cfg] [public/enu folder]

For example, on Windows:

C:\Program Files\Siebel\8.0\web client\BIN>genbscript "enu
\siebel.cfg" "C:\Program Files\Siebel\8.0\web client\PUBLIC\enu"

On Unix or Linux:

genbscript /disk2/sia80/webclient/BIN/enu/siebel.cfg sia80/
webclient/PUBLIC/enu

d) Copy g1_check.gif and g1_x.gif from the temporary folder to public\enu\images
in the Siebel web client.

e) Copy the contents of <Spectrum Package>\dll to your BIN folder.
f) Copy the contents of <Spectrum Package>\cfg to your BIN/ENU folder.

12.Deploy the Siebel objects to the server:
a) Stop the Siebel server.
b) Copy the generated SRF file to your web client objects folder.

For example, the folder for Siebel Business on Windows may be C:\sea80\siebsrvr
\OBJECTS\ENU. On Unix or Linux the folder may be /disk2/sea80/siebsrvr/
OBJECTS/enu/.

c) Open a command prompt and go to the BIN drive of the web client.

For example, on Windows this folder may be C:\sia80\siebsrvr\BIN. On Unix or Linux
this folder may be /disk2/sea80/siebsrvr/BIN.

d) Generate browser scripts by issuing this command:

On Windows:

genbscript "ENU\siebel.cfg" "[webmaster folder]"

On Unix or Linux:

genbscript [location of Siebel.cfg] [webmaster folder]

For example, on Windows:

C:\sia80\siebsrvr\BIN>genbscript "enu\siebel.cfg" "C:
\sia80\siebsrvr\WEBMASTER"

For example, on Unix or Linux:

genbscript /disk2/sea80/siebsrvr/BIN/enu/siebel.cfg /disk2/sea80/
siebsrvr/WEBMASTER/

e) Copy g1_check.gif and g1_x.gif from the temporary folder to the following folder on
the Siebel sever.

On Windows:
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public\enu\images

On Unix or Linux:

WEBMASTER/images/enu

Note:  For Siebel Thin Client, copy g1_check.gif and g1_x.gif from the
temporary directory to SWEApp/PUBLIC/enu/images.

f) Copy the generated browser scripts from /WEBMASTER to <SWEApp Location>/
public/ENU.

g) Start the Siebel server.
13.Activate the Spectrum™ Technology Platform workflows in the Siebel web client:

a) Log in to the Siebel application, connecting to the server data source.
b) Select Site Map > Administration - Business Process > Workflow Deployment.
c) Query for all the GROUP 1* workflows.
d) Click Activate for each workflow.
e) Query for all the Promote* workflows.
f) Click Activate for the ff workflows Promote Prospect (Single) and Promote Prospect

(Many).
g) Click Import Process in the Menu option in the Active Workflow Process screen. Specify

the file <Spectrum Package>\workflows\PB Token WS Workflow.xml.
14.Load the Group 1 configuration.

a) Log in to the Siebel application connecting to the server data source.
b) Go to Site Map > Administration - Business Service > Simulator.
c) In the top applet, create a new record and set the following fields:

Service Name Workflow Process Manager

Method Name Run Process

Iterations 1

d) In the Input Arguments applet, load:

<Spectrum Package>\tools\OptionsManagerLoadData.xml

Note:  Delete the entry if previous GROUP 1 options already exist in the database.
Run the following SQL Script: DELETE SIEBEL.S_LST_OF_VAL WHERE CODE =
'G1'

e) Click Run in the top applet of the Simulator view. Delete the record.
f) Repeat steps c. and d. for the ff files:

• ViewAccessLoadData.xml
• AdminAccessLoadData.xml

g) Go to Site Map > Administration - Application > Responsibilities:
h) Query for the responsibility Group 1 Responsibility.
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i) In the Users tab, add SADMIN or any Siebel administrator. This associates the Group 1
Administration Screen to the user.

Note:  In order to see the changes you must log-in again.

j) Go to Site Map > Administration - Group 1 Data Quality > Options Manager > General
Behavior.

k) Change the server and port number where the Spectrum™ Technology Platform server is
located.

15.Verify the installation:
a) Log in to Siebel Application.
b) All applets should load properly without error.

16.Modify and apply web services.
a) Go to Site Map > Administration - Web Services > Outbound Web Services.
b) Click Import on the Outbound Web Services area and then specify the file <Spectrum

Package>\webservices\G1WebService.xml.
c) Query on the Name field ValidateAddress, and modify its settings as follows:

On the Service Port applet, change the following fields:

• Transport: Local Business Service
• Address: G1 WebService Filter Service

On the Operations applet, change the following fields:

• Response Filter Service Display: G1 WebService Filter Service
• Response Filter Method Display: filter Response

d) Click Import on the Outbound Web Services area and then specify the file <Spectrum
Package>\webservices\TokenManagerServiceImplService.xml.

17.Encrypt and apply Spectrum™ Technology Platform user name and password.
a) Run the following command on the command prompt:

java -version

Java Runtime Environment (JRE) 1.4.x is required. If none is installed, you can download
from java.sun.com/j2se/1.4.2/download.html. Download the JRE of your target platform.

b) Acquire the file <Spectrum Package>\tools\Base64.class.
c) On the command prompt, type the following command:

java Base64 -encode -s "<username>:<password>"

where <username> and <password> is to the login information of Spectrum™ Technology
Platform server. Copy the generated value.

Note:  The default Spectrum™ Technology Platform password can be found in
<Spectrum Package>\tools\Default Password.txt.

d) Go to Site Map > Administration - Group 1 Data Quality > Password Manager. Paste
the value generated in step c. and click Save Changes.
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18.Configure Siebel server configuration events.

The Siebel server must be configured so that the records created in the local database can be
synchronized to the server.

a) Navigate to View > Administration - Server Configuration > Servers > Components >
Event.

b) Locate the Workflow Process Manager Server components.
c) Set the following Component Event Configuration for Workflow Process Manager:

Task Configuration 4

Component Tracing 3

SQL Parse and Execute 4

Workflow Definition Loading 4

Workflow Engine Invoked 4

Workflow Step Execution 4

Workflow Process Execution 4

Object Manager Business Service Operation
and SetErrorMsg Log

4

Object Manager Business Component
Operation and SetErrorMsg Log

4

Object Manager SQL Log 4

d) Locate the Transaction Merger server components.
e) Set the following Component Event Configuration for Transaction Merger:

General Events 4

Components Tracing 3

SQL Parse and Execute 4

19.Enable marketing server components.

The Marketing Server Components must be enabled to import a list from the List Management
business object.

a) Navigate to Administration - Server Configuration > Enterprises > Component Groups.
b) In the Spectrum™ Technology Platform Server list, select the appropriate server.
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c) In the Enterprise Component Groups list, locate each of the required component groups
using the following table. If the Enable State field does not contain the value Enabled,
select the component groups, click the menu button, and choose Enable Component
Group.

Group Name Components Description

MktgOM • Marketing Obj Mgr
• eMarketing Obj Mgr
• eEvents Obj Mjr

Marketing Object Manager.
Supports the user interface
and business objects for the
Marketing application.

Mktg Srv List Import Service Manager Marketing Server. Used for list
management list import.

d) Click the Synchronize view tab and click Synchronize.
e) Restart the Siebel server. The Siebel server must be restarted each time synchronization

occurs.
20.(Open UI Only) Grant the EAI File Transport business service access to the file system by

following these steps.
a) Click Navigate > Site Map.
b) Click Administration - Server Configuration.
c) In the Administration - Server Configuration section, under Enterprises, click

Parameters.
d) Click Query.
e) In the Name column, enter EAI File Transport Folder List.
f) Click Go.
g) In the Value column, enter the root of the drive where you have Siebel installed. For

example, C:\.
h) Click the Servers link:

i) Click the Parameters tab:
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j) Click Query.
k) In the Name column, enter EAI File Transport Folder List.
l) Click Go.
m) In the Value column, enter the root of the drive where you have Siebel installed. For

example, C:\.
n) Add the following values to the .cfg file appropriate for your system (for example,

auto.cfg, tools.cfg, and so on).

[EAIFileTransportConfigSubsys]
EAIFileTransportFolders=C:\

o) Restart the Siebel server and gateway.
21.Set the EditProfileAttr parameter:

a) Click Navigate > Site Map
b) Click Administration - Server Configuration.
c) In the Administration - Server Configuration section, under Servers, click Components.
d) On the Components tab, click Query.
e) In the Component column, enter the name of the Object Manager component. For

example, "eAutomotive Object Manager".
f) Click Go.
g) Click the Parameters tab at the bottom of the window.
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h) Scroll to the parameter EditProfileAttr.
i) Enter True in the Value, Value on Restart, and Default Value columns.

You have now configured Siebel non-SDQ to use Spectrum™ Technology Platform for data
quality processing.
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Configuring Microsoft Dynamics CRM

Integrating with Microsoft Dynamics CRM

To integrate Spectrum™ Technology Platform with Microsoft Dynamics CRM, you must install the
supporting databases and dataflows on the Spectrum™ Technology Platform server, and deploy
the Spectrum™ Technology Platform solution on your Microsoft Dynamics CRM. Once you do
this, users of Microsoft Dynamics CRM will have access to address validation, geocoding, and
duplicate detection functionality from within Microsoft Dynamics CRM.

Note:  End users who use Internet Explorer must use Internet Explorer 10 or 11. Older
versions of Internet Explorer are not supported. All versions of Chrome and Firefox are
supported.

Before you begin, confirm that you are using a compatible version of Microsoft Dynamics. These
versions are supported:

Microsoft Dynamics CRM 2013
Microsoft Dynamics CRM 2013 SP1
Microsoft Dynamics 2015

1. If you are using Spectrum™ Technology Platform for address validation or geocoding, install
the databases required to perform address validation and geocoding and define database
resources for each database.

Note:  If you are using Spectrum™ Technology Platform for duplicate detection only, you
can skip this step.

You must give the database resources these names:

Database Required Name for Database Resource

Enterprise Geocoding Module - Canada Database IGEO_CAN

Enterprise Geocoding Module - U.S. Database EGM_US

Universal Addressing Module - Canada Database Canada

Universal Addressing Module - Loqate Database Loqate

Universal Addressing Module - U.S. Database UAM_US

Note:  You must install the Delivery Point Validation (DPV) data and the Residential
Delivery Indicator (RDI) data in order to perform DPV and RDI processing on U.S.
addresses.
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2. Import the Microsoft Dynamics CRM Module dataflows into your Spectrum™ Technology
Platform server.
a) On the Spectrum™ Technology Platform server, open this folder:

SpectrumFolder\server\modules\dataflows\mscrm

Note:  This folder is only available if you have installed the Microsoft Dynamics CRM
Module.

b) As mentioned in the table below, copy the applicable dataflow files to the import folder:

SpectrumFolder\server\app\import

If you have installed this
set of modules

Copy these dataflow files to the import folder

Advanced Matching Module GenerateMatchKey.df
GenerateMatchScore.df
GenerateSearchKey.Consonant.df
GenerateSearchKey.df
GenerateSearchKey.Metaphone.df
GenerateSearchKey.Substring.df

Universal Addressing Module
without Loqate

ValidateAddresswithCandidates_UAM.df

Universal Addressing Module
without Loqate
Enterprise Geocoding Module

ValidateAddressWithCandidates_UAM_EGM.df

Universal Addressing Module
with Loqate

ValidateAddressWithCandidates_UAM_Loqate.df

Universal Addressing Module
with Loqate
Enterprise Geocoding Module

BatchAddressValidate.df
ValidateAddressAndGenerateMatchKey.df
ValidateAddressWithCandidates_UAM_Loqate_EGM.df

Universal Addressing Module,
Loqate only

ValidateAddressWithCandidates_Loqate.df

Universal Addressing Module,
Loqate only
Enterprise Geocoding Module

ValidateAddressWithCandidates_Loqate_EGM.df

Enterprise Geocoding Module GeocodeUSAddressWithCandidates.df

3. Import the Microsoft Dynamics CRM Module into your Microsoft Dynamics CRM system.
a) In the Spectrum™ Technology Platform installation package, browse to this folder:

MS CRM Objects\Proxy
b) Copy the file netProxy.aspx to this folder on your Microsoft Dynamics CRM server:
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MicrosoftDynamicsCRMInstallation\CRMWeb
c) Copy the file netProxy.dll to this folder on your Microsoft Dynamics CRM server:

MicrosoftDynamicsCRMInstallation\CRMWeb\Bin
d) Log in to Microsoft Dynamics CRM as an administrator.
e) Click Microsoft Dynamics CRM then click Settings.
f) Click Solutions.
g) Click Import.
h) Browse to the Spectrum™ Technology Platform installation package and select the file:

MS CRM Objects\mscrm\PBMSDynamicsCRMConnector_4_0_0_managed.zip
i) Click Next then Publish All Customizations.
j) Restart the Microsoft Dynamics CRM server.

4. Define the connection between Microsoft Dynamics CRM and the Spectrum™ Technology
Platform server.
a) Log in to Microsoft Dynamics CRM as an administrator.
b) Click Microsoft Dynamics CRM > Settings.
c) Click Settings > Pitney Bowes. You will have to scroll to the right to find the Pitney Bowes

link.
d) Click Administration.
e) Click New.
f) In the Name field, enter PB.
g) In the Server Name field, enter the server name or IP address of the Spectrum™

Technology Platform server.
h) In the Port field, enter the port used by the Spectrum™ Technology Platform server for

HTTP communication. By default the port is 8080.
i) In the Account ID field, enter the Spectrum™ Technology Platform user name.
j) In the Password field, enter the password for the Spectrum™ Technology Platform user.
k) Click Save

The Microsoft Dynamics CRM system now has access to address validation and, optionally,
geocoding services on the Spectrum™ Technology Platform server.
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Support

Technical Support

If you run into an issue, Pitney Bowes Technical Support can help guide you to a solution. When
you contact Pitney Bowes Technical Support, please provide the following information:

• A description of the task you were performing
• The level or version of your operating system
• The patch level or service pack
• The log file located in your install directory at: <SpectrumInstallationLocation>
\server\app\repository\logs\wrapper.log

Contact information for Technical Support can be found at:

support.pb.com/spectrum

Note:  If you purchased Spectrum™ Technology Platform through a third-party partner,
please contact the partner for technical support.

Documentation

Product documentation can be found at:

support.pb.com/spectrum

Digital Insights

Digital Insights is an online resource for Pitney Bowes leadership to share innovations, goals, and
product news, as well as exchange ideas with visitors. You can access Digital Insights at:

blogs.pb.com/digital-insights/
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Copyright

© 2017 Pitney Bowes Software Inc. All rights reserved. MapInfo and Group 1 Software are
trademarks of Pitney Bowes Software Inc. All other marks and trademarks are property of their
respective holders.

USPS® Notices

Pitney Bowes Inc. holds a non-exclusive license to publish and sell ZIP + 4® databases on optical
and magnetic media. The following trademarks are owned by the United States Postal Service:
CASS, CASS Certified, DPV, eLOT, FASTforward, First-Class Mail, Intelligent Mail, LACSLink,
NCOALink, PAVE, PLANET Code, Postal Service, POSTNET, Post Office, RDI, SuiteLink , United
States Postal Service, Standard Mail, United States Post Office, USPS, ZIP Code, and ZIP + 4.
This list is not exhaustive of the trademarks belonging to the Postal Service.

Pitney Bowes Inc. is a non-exclusive licensee of USPS® for NCOALink® processing.

Prices for Pitney Bowes Software's products, options, and services are not established,
controlled, or approved by USPS® or United States Government. When utilizing RDI™ data to
determine parcel-shipping costs, the business decision on which parcel delivery company to use
is not made by the USPS® or United States Government.

Data Provider and Related Notices

Data Products contained on this media and used within Pitney Bowes Software applications are
protected by various trademarks and by one or more of the following copyrights:
© Copyright United States Postal Service. All rights reserved.
© 2014 TomTom. All rights reserved. TomTom and the TomTom logo are registered trademarks of
TomTom N.V.
© 2016 HERE

Fuente: INEGI (Instituto Nacional de Estadística y Geografía)

Based upon electronic data © National Land Survey Sweden.
© Copyright United States Census Bureau
© Copyright Nova Marketing Group, Inc.

Portions of this program are © Copyright 1993-2007 by Nova Marketing Group Inc. All Rights
Reserved
© Copyright Second Decimal, LLC
© Copyright Canada Post Corporation

This CD-ROM contains data from a compilation in which Canada Post Corporation is the
copyright owner.
© 2007 Claritas, Inc.

The Geocode Address World data set contains data licensed from the GeoNames Project
(www.geonames.org) provided under the Creative Commons Attribution License ("Attribution
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License") located at http://creativecommons.org/licenses/by/3.0/legalcode. Your use of the
GeoNames data (described in the Spectrum™ Technology Platform User Manual) is governed by
the terms of the Attribution License, and any conflict between your agreement with Pitney Bowes
Software, Inc. and the Attribution License will be resolved in favor of the Attribution License solely
as it relates to your use of the GeoNames data.
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